Preface

Fundamental safety instructions

Introduction

Requirements for commissioning

Licensing

PLC commissioning

Commissioning NC-controlled drives

Communication between the NC and the drive

NC commissioning

Configuring PLC-controlled drives

Drive tuning

Saving and managing data

New installation / upgrading

Appendix
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**
indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

SINUMERIK documentation

The SINUMERIK documentation is organized into the following categories:

- General documentation/catalogs
- User documentation
- Manufacturer/Service Documentation

Further information

You can find information on the topics at the following address (https://support.industry.siemens.com/cs/de/en/view/108464614):

- Order documentation / documentation overview
- Additional links for downloading documents
- Using documentation online (find and search in manuals/information)

If there are any questions regarding the technical documentation (e.g. suggestions, corrections), please send an email to the following address (mailto:docu.motioncontrol@siemens.com).

mySupport/Documentation

At the following address (https://support.industry.siemens.com/My/ww/en/documentation), you can find information on how to create your own individual documentation based on Siemens' content, and adapt it for your own machine documentation.

Training

At the following address (http://www.siemens.com/sitrain), you can find information about SITRAIN (Siemens training on products, systems and solutions for automation and drives).

FAQs


SINUMERIK

You can find information about SINUMERIK at the following address (http://www.siemens.com/sinumerik).
Target group

This document is intended for commissioning personnel.

The plant or system is installed, connected, and ready to start. The Commissioning Manual contains all the necessary information or at least references for the following steps, e.g. configuring the individual components.

Standard scope

This documentation only describes the functionality of the standard version. Additions or revisions made by the machine manufacturer are documented by the machine manufacturer.

Other functions not described in this documentation might be executable in the control. This does not, however, represent an obligation to supply such functions with a new delivery or when servicing.

For the sake of simplicity, this documentation does not contain all detailed information about all types of the product, and cannot cover every conceivable case of installation, operation, or maintenance.

Note regarding the General Data Protection Regulation

Siemens observes standard data protection principles, in particular the principle of privacy by design. For this product, this means: this product does not process / store any personal data, only technical functional data (e.g. time stamps). If a user links this data with other data (e.g. shift schedules) or stores personal data on the same storage medium (e.g. hard disk), and thus establishes a link to a person or persons, then the user is responsible for ensuring compliance with the relevant data protection regulations.

Technical Support

Country-specific telephone numbers for technical support are provided on the Internet at the following address in the Contact (https://support.industry.siemens.com/sc/ww/en/sc/2090) area.

EC Declaration of Conformity

The EC Declaration of Conformity for the EMC Directive can be found on the Internet at the following address (https://support.industry.siemens.com/cs/ww/en/ps/14604/cert).
# Table of contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>3</td>
</tr>
<tr>
<td>1 Fundamental safety instructions</td>
<td>11</td>
</tr>
<tr>
<td>1.1 General safety instructions</td>
<td>11</td>
</tr>
<tr>
<td>1.2 Equipment damage due to electric fields or electrostatic discharge</td>
<td>15</td>
</tr>
<tr>
<td>1.3 Warranty and liability for application examples</td>
<td>16</td>
</tr>
<tr>
<td>1.4 Industrial security</td>
<td>17</td>
</tr>
<tr>
<td>1.5 Residual risks of power drive systems</td>
<td>19</td>
</tr>
<tr>
<td>2 Introduction</td>
<td>21</td>
</tr>
<tr>
<td>2.1 Overview of the manuals for SINUMERIK 840D sl</td>
<td>21</td>
</tr>
<tr>
<td>2.2 Industry Online Support</td>
<td>22</td>
</tr>
<tr>
<td>2.3 SINUMERIK 840D sl configuration</td>
<td>24</td>
</tr>
<tr>
<td>2.4 Procedure for the initial commissioning</td>
<td>26</td>
</tr>
<tr>
<td>2.5 Procedure when tuning axes and drives</td>
<td>28</td>
</tr>
<tr>
<td>3 Requirements for commissioning</td>
<td>31</td>
</tr>
<tr>
<td>3.1 General prerequisites</td>
<td>31</td>
</tr>
<tr>
<td>3.2 Software and hardware preconditions</td>
<td>32</td>
</tr>
<tr>
<td>3.3 Position of the interfaces</td>
<td>33</td>
</tr>
<tr>
<td>3.4 Power-On and boot-up</td>
<td>34</td>
</tr>
<tr>
<td>3.4.1 NC and PLC memory reset</td>
<td>34</td>
</tr>
<tr>
<td>3.4.2 A general reset is separately performed for the NC and PLC</td>
<td>36</td>
</tr>
<tr>
<td>3.4.3 Boot completed</td>
<td>38</td>
</tr>
<tr>
<td>3.5 Access levels</td>
<td>39</td>
</tr>
<tr>
<td>4 Licensing</td>
<td>43</td>
</tr>
<tr>
<td>4.1 SINUMERIK License Key</td>
<td>43</td>
</tr>
<tr>
<td>4.2 Web License Manager</td>
<td>45</td>
</tr>
<tr>
<td>4.3 License database</td>
<td>46</td>
</tr>
<tr>
<td>4.4 How to perform the assignment</td>
<td>47</td>
</tr>
<tr>
<td>4.5 Important licensing terms</td>
<td>48</td>
</tr>
<tr>
<td>5 PLC commissioning</td>
<td>51</td>
</tr>
<tr>
<td>5.1 Connect PG/PC with the PLC</td>
<td>51</td>
</tr>
<tr>
<td>5.2 Creating a SIMATIC S7 project (PROFIBUS)</td>
<td>52</td>
</tr>
<tr>
<td>5.2.1 SIMATIC S7 project overview</td>
<td>52</td>
</tr>
<tr>
<td>5.2.2 Inserting SINUMERIK NCU to the HW Config</td>
<td>53</td>
</tr>
</tbody>
</table>
## Table of contents

6 Commissioning NC-controlled drives ................................................................. 103

6.1 Configuration examples ................................................................................. 103
6.1.1 Example: Configuration of the drive components .................................... 103
6.1.2 Example: Parallel connection with TM120 ............................................. 105

6.2 Terminal assignment ....................................................................................... 107
6.2.1 NCU terminal assignment ......................................................................... 107
6.2.2 X122 terminal assignment ......................................................................... 107
6.2.3 X132 terminal assignment ......................................................................... 108
6.2.4 X142 terminal assignment ......................................................................... 109
6.2.5 Terminal assignment NX1x.3 .................................................................... 109
6.2.6 Support for the terminal assignment .......................................................... 110
6.2.7 BICO interconnections ............................................................................. 111

6.3 Guided commissioning of SINAMICS drives ................................................. 113
6.3.1 Initializing the system ................................................................................ 113
6.3.2 Device configuration of the drive system ................................................. 115
6.3.3 Configuring the infeed .............................................................................. 117
6.3.4 Configuration of two infeeds connected in parallel .................................. 124
6.3.5 Configuring drive components ................................................................. 127
6.3.6 Commissioning catalog motors with encoder using SMC ...................... 129
6.3.7 Commissioning a third-party motor with encoder via SMC ..................... 135
6.3.8 First commissioning of SINAMICS drive ended ...................................... 142

6.4 Manual commissioning of SINAMICS drives ............................................ 143
6.4.1 Introduction to commissioning of SINAMICS drives ............................... 143

5.4 Creating a PLC program .............................................................................. 85
5.4.1 Preconditions for creating the PLC program .......................................... 87
5.4.2 Insert PLC basic program ........................................................................ 87
5.4.3 Modifying machine control panel in OB100 ............................................ 89

5.5 Download the project to the PLC ............................................................... 91
5.6 Loading PLC symbols to the controller .................................................... 93
5.7 First commissioning of the PLC completed .............................................. 94

5.8 Configuring a network (NetPro) for PG/PC ............................................... 95
5.8.1 Integrating PG/PC into NetPro ............................................................... 95
5.8.2 Configuration of the PG/PC interface .................................................... 96
5.8.3 Assigning interfaces ............................................................................... 99
5.8.4 Loading the HW config to NCU ............................................................... 100

5 Commissioning Manual, 12/2019, A5E48312804B AA
6.4.2 Activate the factory settings ................................................................. 145
6.4.3 Firmware update of the drive components ......................................... 147
6.4.4 Automatic device configuration ......................................................... 149
6.4.5 Commissioning using a drive wizard ................................................ 153
6.5 Configuring data sets ........................................................................... 154
6.5.1 Data sets - overview ........................................................................ 154
6.5.2 Adding a data set ................................................................................ 155
6.5.3 Remove data set ................................................................................ 159
6.5.4 Modify data set .................................................................................. 162
6.6 Diagnostics → Trace ........................................................................... 163
6.6.1 Selecting variables for tracing .......................................................... 163
6.6.2 Example: Trace session with servo variables .................................... 164
6.6.3 Example: Zooming in/zooming out .................................................... 167
6.6.4 Example: Changing the scale ............................................................. 171
6.6.5 Example: Positioning the cursor ......................................................... 172
6.6.6 Example: Trace session with PLC variables ...................................... 172
6.6.7 Example: Trace session with drive variables ..................................... 174
6.6.8 Key combinations to use the trace ..................................................... 175
6.7 Diagnostics → drive system ................................................................. 177
6.8 Modular machine .................................................................................. 179
6.8.1 What does "modular machine" mean? ............................................... 179
6.8.2 Example: Topology display (graphic) ............................................... 183
6.8.3 Modify configuration ......................................................................... 186
6.8.4 Check topology ................................................................................ 188
6.8.5 Changing topology .......................................................................... 189
6.8.6 Activating or deactivating a drive object .......................................... 191
6.8.7 Deleting a drive object ..................................................................... 193
6.8.8 Delete the component ...................................................................... 195
6.8.9 Adding components ......................................................................... 197
6.8.10 Replacing a SINAMICS S120 component ...................................... 199
6.8.11 Example: Subsequently installing a component .............................. 201
6.9 Tips for commissioning the SINAMICS drives .................................... 204
6.9.1 Displaying the firmware version of the drive components ............. 204
6.9.2 Check the line data of the infeed ....................................................... 205
6.9.3 Mains and DC link identification of the infeed module .................... 206
6.9.4 Rules for wiring the DRIVE-CLiQ interface .................................... 207
6.9.5 Drive-object assignment for PROFIBUS connection ...................... 209
6.9.6 Adjusting speed and brake behavior ............................................... 213
7 Communication between the NC and the drive ................................... 215
7.1 Overview of NC and drive communication ......................................... 215
7.2 Configuring the communication to the drive ....................................... 216
7.3 Configuring the I/O address and telegram .......................................... 218
7.4 Process data transfer between the NC and drive ............................... 220
7.5 Drives: Assign axis ............................................................................ 222
7.6 Configuring machine axes .................................................................. 225
7.6.1 Axis assignment .............................................................................. 225
Table of contents

8 NC commissioning ................................................................. 231
  8.1 Machine and setting data .................................................. 231
  8.2 Procedure when commissioning the NC ......................... 233
  8.3 Memory configuration ...................................................... 235
  8.4 Friction compensation with adaptive characteristics .......... 236
    8.4.1 Axis selection and status display ................................. 237
    8.4.2 Friction compensation - automatic tuning .................... 238
    8.4.3 Friction compensation - manual tuning ......................... 239
    8.4.4 Data list ...................................................................... 242
    8.4.5 Example for a linear axis (automatic tuning) ............... 242
    8.4.6 Friction compensation with torque injection pulse ......... 244
  8.5 Nodding compensation .................................................... 246
    8.5.1 Measuring technique and machine data ....................... 246
    8.5.2 Nodding compensation - overview ............................... 248
    8.5.3 Determining compliance from the best milling path ........ 249
    8.5.4 Nodding compensation - manually enter ....................... 250
    8.5.5 Determining compliance using a probe ......................... 251
    8.5.6 Example: Traveling column machine ............................ 253
  8.6 Adaptations ..................................................................... 255
    8.6.1 Intelligent load adjustment – function ......................... 255
    8.6.2 Intelligent dynamic response adjustment – function ......... 257
    8.6.3 Commissioning the function ......................................... 259
    8.6.4 Example: Enter an adaptation for acceleration ............ 261
  8.7 Jerk filter ........................................................................ 263
    8.7.1 Putting a jerk filter into operation ............................... 263
    8.7.2 Entering new jerk filter ................................................ 264
  8.8 Diagnosis → System utilization ......................................... 267

9 Configuring PLC-controlled drives ......................................... 269
  9.1 Introduction ...................................................................... 269
  9.2 Configuration via PROFIBUS ............................................ 270
    9.2.1 Supplementary conditions for PLC-controlled drives ....... 270
    9.2.2 Example: Configuration of the drive components .......... 272
    9.2.3 Commissioning the PLC .............................................. 273
  9.3 Creating a PLC program ................................................... 279
  9.4 Commissioning PLC drives .............................................. 281
  9.5 Checking the communication to the drive ......................... 283
  9.6 Safety functions for PLC drives ........................................ 284
    9.6.1 Configuring PROFINET ............................................... 284
    9.6.2 Example: EMBending in safe programmable logic (SPL)... 287

10 Drive tuning ....................................................................... 291
  10.1 Tuning procedure .......................................................... 291
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.2</td>
<td>Function overview for the tuning</td>
<td>292</td>
</tr>
<tr>
<td>10.3</td>
<td>Automatic servo tuning</td>
<td>293</td>
</tr>
<tr>
<td>10.3.1</td>
<td>Setting the options for the measurement procedure</td>
<td>296</td>
</tr>
<tr>
<td>10.3.2</td>
<td>Selecting the tuning strategy</td>
<td>296</td>
</tr>
<tr>
<td>10.3.3</td>
<td>Example: This is how you tune the X axis</td>
<td>300</td>
</tr>
<tr>
<td>10.3.4</td>
<td>Example: This is how you tune the Y axis</td>
<td>304</td>
</tr>
<tr>
<td>10.3.5</td>
<td>Example: This is how you start to tune the path interpolation</td>
<td>307</td>
</tr>
<tr>
<td>10.3.6</td>
<td>Example for experts: Axis tuning</td>
<td>310</td>
</tr>
<tr>
<td>10.4</td>
<td>Spindle optimization (automatic)</td>
<td>313</td>
</tr>
<tr>
<td>10.5</td>
<td>Measuring functions (manual tuning)</td>
<td>316</td>
</tr>
<tr>
<td>10.5.1</td>
<td>Measurement of current control loop</td>
<td>318</td>
</tr>
<tr>
<td>10.5.2</td>
<td>Speed control loop measurement</td>
<td>320</td>
</tr>
<tr>
<td>10.5.3</td>
<td>Example: Setting the filter for the following error (speed control loop)</td>
<td>324</td>
</tr>
<tr>
<td>10.5.4</td>
<td>Position control loop measurement</td>
<td>324</td>
</tr>
<tr>
<td>10.5.5</td>
<td>Examples for the measuring methods (position control loop)</td>
<td>327</td>
</tr>
<tr>
<td>10.5.6</td>
<td>Function generator</td>
<td>329</td>
</tr>
<tr>
<td>10.5.7</td>
<td>Example, function generator: Speed setpoint after the filter</td>
<td>331</td>
</tr>
<tr>
<td>10.6</td>
<td>Define filter</td>
<td>333</td>
</tr>
<tr>
<td>10.7</td>
<td>Circularity test</td>
<td>334</td>
</tr>
<tr>
<td>10.7.1</td>
<td>Circularity test: Function</td>
<td>334</td>
</tr>
<tr>
<td>10.7.2</td>
<td>Circularity test: Performing the measurement</td>
<td>335</td>
</tr>
<tr>
<td>10.7.3</td>
<td>Circularity test: Examples</td>
<td>337</td>
</tr>
<tr>
<td>10.7.4</td>
<td>Circularity test: Saving data</td>
<td>340</td>
</tr>
<tr>
<td>10.8</td>
<td>Decision-making support for APC and APC ECO</td>
<td>342</td>
</tr>
<tr>
<td>10</td>
<td>Saving and managing data</td>
<td>345</td>
</tr>
<tr>
<td>11.1</td>
<td>Saving data</td>
<td>345</td>
</tr>
<tr>
<td>11.1.1</td>
<td>Backup of PLC data</td>
<td>347</td>
</tr>
<tr>
<td>11.1.2</td>
<td>Creating a commissioning archive</td>
<td>348</td>
</tr>
<tr>
<td>11.2</td>
<td>Managing data</td>
<td>350</td>
</tr>
<tr>
<td>11.2.1</td>
<td>How to transfer data within the controller</td>
<td>351</td>
</tr>
<tr>
<td>11.2.2</td>
<td>To save and load data</td>
<td>351</td>
</tr>
<tr>
<td>11.2.3</td>
<td>How to compare data</td>
<td>352</td>
</tr>
<tr>
<td>11.2.4</td>
<td>Example: Importing/exporting SINAMICS lists</td>
<td>353</td>
</tr>
<tr>
<td>12</td>
<td>New installation / upgrading</td>
<td>355</td>
</tr>
<tr>
<td>12.1</td>
<td>With the help of an NCU service system</td>
<td>355</td>
</tr>
<tr>
<td>12.1.1</td>
<td>New installation</td>
<td>355</td>
</tr>
<tr>
<td>12.1.1.1</td>
<td>Automatic installation of the CNC software using USB-FlashDrive</td>
<td>356</td>
</tr>
<tr>
<td>12.1.1.2</td>
<td>Installation of the CNC software using USB-FlashDrive</td>
<td>357</td>
</tr>
<tr>
<td>12.1.1.3</td>
<td>Installation of the CNC software using WinSCP on PC/PG</td>
<td>360</td>
</tr>
<tr>
<td>12.1.1.4</td>
<td>Installation of the CNC software using VNC Viewer on PC/PG</td>
<td>361</td>
</tr>
<tr>
<td>12.1.2</td>
<td>Upgrading</td>
<td>362</td>
</tr>
<tr>
<td>12.1.2.1</td>
<td>Backup/Restore</td>
<td>363</td>
</tr>
<tr>
<td>12.1.2.2</td>
<td>Automatic upgrade of the CNC software using USB-FlashDrive</td>
<td>366</td>
</tr>
<tr>
<td>12.1.2.3</td>
<td>Upgrading the CNC software using USB-FlashDrive</td>
<td>367</td>
</tr>
<tr>
<td>12.1.2.4</td>
<td>Upgrading the CNC software using WinSCP on PC/PG</td>
<td>370</td>
</tr>
<tr>
<td>12.1.2.5</td>
<td>Upgrading the CNC software using VNC Viewer on PC/PG</td>
<td>371</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>------</td>
</tr>
<tr>
<td>12.2</td>
<td>With the help of the &quot;Create MyConfig&quot; software</td>
<td>372</td>
</tr>
<tr>
<td>12.2.1</td>
<td>Reinstallation with Create MyConfig</td>
<td>372</td>
</tr>
<tr>
<td>12.2.2</td>
<td>Upgrade with Create MyConfig</td>
<td>376</td>
</tr>
</tbody>
</table>

**Appendix**

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.1</td>
<td>Abbreviations</td>
<td>381</td>
</tr>
<tr>
<td>A.2</td>
<td>Information about third-party software used</td>
<td>383</td>
</tr>
</tbody>
</table>

**Index** | 385  |
1.1 General safety instructions

**WARNING**

**Electric shock and danger to life due to other energy sources**

Touching live components can result in death or severe injury.
- Only work on electrical devices when you are qualified for this job.
- Always observe the country-specific safety rules.

Generally, the following six steps apply when establishing safety:
1. Prepare for disconnection. Notify all those who will be affected by the procedure.
2. Isolate the drive system from the power supply and take measures to prevent it being switched back on again.
3. Wait until the discharge time specified on the warning labels has elapsed.
4. Check that there is no voltage between any of the power connections, and between any of the power connections and the protective conductor connection.
5. Check whether the existing auxiliary supply circuits are de-energized.
6. Ensure that the motors cannot move.
7. Identify all other dangerous energy sources, e.g. compressed air, hydraulic systems, or water. Switch the energy sources to a safe state.
8. Check that the correct drive system is completely locked.

After you have completed the work, restore the operational readiness in the inverse sequence.

**WARNING**

**Electric shock due to connection to an unsuitable power supply**

When equipment is connected to an unsuitable power supply, exposed components may carry a hazardous voltage. Contact with hazardous voltage can result in severe injury or death.
- Only use power supplies that provide SELV (Safety Extra Low Voltage) or PELV-(Protective Extra Low Voltage) output voltages for all connections and terminals of the electronics modules.
**WARNING**

**Electric shock due to equipment damage**

Improper handling may cause damage to equipment. For damaged devices, hazardous voltages can be present at the enclosure or at exposed components; if touched, this can result in death or severe injury.

- Ensure compliance with the limit values specified in the technical data during transport, storage and operation.
- Do not use any damaged devices.

**WARNING**

**Electric shock due to unconnected cable shields**

Hazardous touch voltages can occur through capacitive cross-coupling due to unconnected cable shields.

- As a minimum, connect cable shields and the cores of cables that are not used at one end at the grounded housing potential.

**WARNING**

**Electric shock if there is no ground connection**

For missing or incorrectly implemented protective conductor connection for devices with protection class I, high voltages can be present at open, exposed parts, which when touched, can result in death or severe injury.

- Ground the device in compliance with the applicable regulations.

**WARNING**

**Spread of fire from built-in devices**

In the event of fire outbreak, the enclosures of built-in devices cannot prevent the escape of fire and smoke. This can result in serious personal injury or property damage.

- Install built-in units in a suitable metal cabinet in such a way that personnel are protected against fire and smoke, or take other appropriate measures to protect personnel.
- Ensure that smoke can only escape via controlled and monitored paths.
WARNING

Unexpected movement of machines caused by radio devices or mobile phones

When radio devices or mobile phones with a transmission power > 1 W are used in the immediate vicinity of components, they may cause the equipment to malfunction. Malfunctions may impair the functional safety of machines and can therefore put people in danger or lead to property damage.

- If you come closer than around 2 m to such components, switch off any radios or mobile phones.
- Use the "SIEMENS Industry Online Support app" only on equipment that has already been switched off.

WARNING

Fire due to inadequate ventilation clearances

Inadequate ventilation clearances can cause overheating of components with subsequent fire and smoke. This can cause severe injury or even death. This can also result in increased downtime and reduced service lives for devices/systems.

- Ensure compliance with the specified minimum clearance as ventilation clearance for the respective component.

NOTICE

Overheating due to inadmissible mounting position

The device may overheat and therefore be damaged if mounted in an inadmissible position.

- Only operate the device in admissible mounting positions.

WARNING

Unexpected movement of machines caused by inactive safety functions

Inactive or non-adapted safety functions can trigger unexpected machine movements that may result in serious injury or death.

- Observe the information in the appropriate product documentation before commissioning.
- Carry out a safety inspection for functions relevant to safety on the entire system, including all safety-related components.
- Ensure that the safety functions used in your drives and automation tasks are adjusted and activated through appropriate parameterizing.
- Perform a function test.
- Only put your plant into live operation once you have guaranteed that the functions relevant to safety are running correctly.
Note
Important safety notices for Safety Integrated functions
If you want to use Safety Integrated functions, you must observe the safety notices in the Safety Integrated manuals.

⚠️ WARNING ⚠️
Malfunctions of the machine as a result of incorrect or changed parameter settings
As a result of incorrect or changed parameterization, machines can malfunction, which in turn can lead to injuries or death.
- Protect the parameterization against unauthorized access.
- Handle possible malfunctions by taking suitable measures, e.g. emergency stop or emergency off.
1.2 **Equipment damage due to electric fields or electrostatic discharge**

Electrostatic sensitive devices (ESD) are individual components, integrated circuits, modules or devices that may be damaged by either electric fields or electrostatic discharge.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Equipment damage due to electric fields or electrostatic discharge</strong></td>
</tr>
<tr>
<td>Electric fields or electrostatic discharge can cause malfunctions through damaged individual components, integrated circuits, modules or devices.</td>
</tr>
<tr>
<td>• Only pack, store, transport and send electronic components, modules or devices in their original packaging or in other suitable materials, e.g conductive foam rubber or aluminum foil.</td>
</tr>
<tr>
<td>• Only touch components, modules and devices when you are grounded by one of the following methods:</td>
</tr>
<tr>
<td>• Wearing an ESD wrist strap</td>
</tr>
<tr>
<td>• Wearing ESD shoes or ESD grounding straps in ESD areas with conductive flooring</td>
</tr>
<tr>
<td>• Only place electronic components, modules or devices on conductive surfaces (table with ESD surface, conductive ESD foam, ESD packaging, ESD transport container).</td>
</tr>
</tbody>
</table>
1.3 Warranty and liability for application examples

Application examples are not binding and do not claim to be complete regarding configuration, equipment or any eventuality which may arise. Application examples do not represent specific customer solutions, but are only intended to provide support for typical tasks.

As the user you yourself are responsible for ensuring that the products described are operated correctly. Application examples do not relieve you of your responsibility for safe handling when using, installing, operating and maintaining the equipment.
1.4 Industrial security

Note

Industrial security

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. Products and solutions from Siemens constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems, machines and networks. Such systems, machines and components should only be connected to an enterprise network or the Internet if and to the extent such a connection is necessary and only when appropriate security measures (e.g. using firewalls and/or network segmentation) are in place.

For additional information on industrial security measures that can be implemented, please visit:

Industrial security ([https://www.siemens.com/industrialsecurity](https://www.siemens.com/industrialsecurity))

Siemens’ products and solutions undergo continuous development to make them more secure. Siemens strongly recommends that product updates are applied as soon as they become available, and that only the latest product versions are used. Use of product versions that are no longer supported, and failure to apply the latest updates may increase customer’s exposure to cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed at:

Industrial security ([https://www.siemens.com/industrialsecurity](https://www.siemens.com/industrialsecurity))

Further information is provided on the Internet:

### WARNING

**Unsafe operating states resulting from software manipulation**

Software manipulations, e.g. viruses, Trojans, or worms, can cause unsafe operating states in your system that may lead to death, serious injury, and property damage.

- Keep the software up to date.
- Incorporate the automation and drive components into a holistic, state-of-the-art industrial security concept for the installation or machine.
- Make sure that you include all installed products into the holistic industrial security concept.
- Protect files stored on exchangeable storage media from malicious software by with suitable protection measures, e.g. virus scanners.
- On completion of commissioning, check all security-related settings.
- Protect the drive against unauthorized changes by activating the "Know-how protection" converter function.
1.5 Residual risks of power drive systems

When assessing the machine- or system-related risk in accordance with the respective local regulations (e.g., EC Machinery Directive), the machine manufacturer or system installer must take into account the following residual risks emanating from the control and drive components of a drive system:

1. Unintentional movements of driven machine or system components during commissioning, operation, maintenance, and repairs caused by, for example,
   - Hardware and/or software errors in the sensors, control system, actuators, and cables and connections
   - Response times of the control system and of the drive
   - Operation and/or environmental conditions outside the specification
   - Condensation/conductive contamination
   - Parameterization, programming, cabling, and installation errors
   - Use of wireless devices/mobile phones in the immediate vicinity of electronic components
   - External influences/damage
   - X-ray, ionizing radiation and cosmic radiation

2. Unusually high temperatures, including open flames, as well as emissions of light, noise, particles, gases, etc., can occur inside and outside the components under fault conditions caused by, for example:
   - Component failure
   - Software errors
   - Operation and/or environmental conditions outside the specification
   - External influences/damage

3. Hazardous shock voltages caused by, for example:
   - Component failure
   - Influence during electrostatic charging
   - Induction of voltages in moving motors
   - Operation and/or environmental conditions outside the specification
   - Condensation/conductive contamination
   - External influences/damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to people with a pacemaker, implants or metal replacement joints, etc., if they are too close

5. Release of environmental pollutants or emissions as a result of improper operation of the system and/or failure to dispose of components safely and correctly

6. Influence of network-connected communication systems, e.g. ripple-control transmitters or data communication via the network

For more information about the residual risks of the drive system components, see the relevant sections in the technical user documentation.
Fundamental safety instructions

1.5 Residual risks of power drive systems
2.1 Overview of the manuals for SINUMERIK 840D sl

Commissioning steps

Commissioning is split up into two steps:

1. Configure PLC, load basic program
   - Configure drives
   - NC: Configure the machine

2. Creating a PLC program
   - General machine data
   - Channel-specific machine data
   - Axis machine data
   - NC functions
     - Display machine data
     - Cycles
     - GUD, macros

Figure 2-1  Commissioning procedure

Section 1:
- Commissioning Manual: CNC commissioning: NC, PLC, drive
- Function Manual: PLC (Part 1), Basic Functions, Axes and Spindles, Technologies
- Function Manual: Safety Integrated

Section 2:
- Function Manual: PLC (Part 2), synchronized actions, transformations, monitoring and compensating, tools, tool management
- List manuals: Machine data, system variables, NC/PLC variables
2.2 Industry Online Support

**SINUMERIK**

**SINAMICS S120**

**Functions**

**SINUMERIK**
2.2 Industry Online Support


SINAMICS S120

You can find other documents under Siemens Industry Online Support SIOS (https://support.industry.siemens.com/cs).
2.3 SINUMERIK 840D sl configuration

SINUMERIK 840D sl configuration with SINAMICS S120 Booksize

Figure 2-2  Example: Configuration with SINAMICS S120 Booksize
**2.3 SINUMERIK 840D sl configuration**

**SINUMERIK 840D sl configuration with SINAMICS S120 Combi**

**Note**

**SINAMICS S120 Combi**

The configuration with SINAMICS S120 Combi is permissible only on an NCU 710.3B PN.
2.4 Procedure for the initial commissioning

Checking the system

The mechanical and electrical installation of the system must be completed.

The following is important when starting commissioning:

- The control system with its components boots error-free.
- The EMC guidelines were carefully maintained when configuring the system.

Variants for the commissioning process

When commissioning the system for the first time, the following dependencies to the CNC software on the CompactFlash card are considered:

- CompactFlash card with current CNC software
- CompactFlash card without CNC software ⇒ new installation
- CompactFlash card with older CNC software ⇒ upgrade

Commissioning with current CNC software

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Reference to Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>① Powering up the control system with NC/PLC general reset</td>
<td>→ NC/PLC general reset (Page 34)</td>
</tr>
<tr>
<td>② Make a communication connection to the PLC</td>
<td>→ Establishing a communication connection (Page 51)</td>
</tr>
<tr>
<td>③ Commission the PLC</td>
<td>→ PLC commissioning (Page 51)</td>
</tr>
<tr>
<td>④ Commission the SINAMICS drive system</td>
<td>→ Commissioning NC-controlled drives (Page 103)</td>
</tr>
<tr>
<td>⑤ NC ↔ drive communication</td>
<td>→ Communication between the NC and the drive (Page 215)</td>
</tr>
<tr>
<td>⑥ Commission the NC:</td>
<td>→ NC commissioning (Page 231)</td>
</tr>
<tr>
<td>• Assign the NC machine data for the communication</td>
<td>→ Procedure when commissioning the NC (Page 233)</td>
</tr>
<tr>
<td>• Scale the machine data</td>
<td></td>
</tr>
<tr>
<td>• Parameterize the axis data</td>
<td></td>
</tr>
<tr>
<td>• Parameterize the spindle data</td>
<td></td>
</tr>
<tr>
<td>• Parameterize the measuring systems</td>
<td></td>
</tr>
<tr>
<td>⑦ Drive tuning</td>
<td>→ Drive tuning (Page 291)</td>
</tr>
</tbody>
</table>
## Reinstallation of the CNC software

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Reference to Chapter</th>
</tr>
</thead>
</table>
| ① Install the CNC software on the CompactFlash card using one of the following media:  
  - Bootable USB FlashDrive  
  - WinSCP on PC/PG  
  - VNC viewer on PC/PG | → New installation / upgrade (Page 355) |
| ② Powering up the control system with NC/PLC general reset | → NC/PLC general reset (Page 34) |
| ③ Establish a communication connection to the PLC | → Establishing a communication connection (Page 51) |
| ④ Commission the PLC | → PLC commissioning (Page 51) |
| ⑤ Commission the SINAMICS drive system | → Commissioning NC-controlled drives (Page 103) |
| ⑥ NC ↔ drive communication | → Communication between the NC and the drive (Page 215) |
| ⑦ Commission the NC:  
  - Assign the NC machine data for the communication  
  - Scale the machine data  
  - Parameterize the axis data  
  - Parameterize the spindle data  
  - Parameterize the measuring systems | → NC commissioning (Page 231) → Procedure when commissioning the NC (Page 233) |
| ⑧ Drive tuning | → Drive tuning (Page 291) |

## Upgrading the CNC software

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Reference to Chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>① Archive the NC, PLC, HMI and drive data</td>
<td>→ Save data (Page 345)</td>
</tr>
</tbody>
</table>
| ② Upgrade CNC software using:  
  - Access MyMachine /P2P  
  - WinSCP and VNC Viewer | → New installation / upgrade (Page 355) |
| ③ Load the archived NC, PLC, HMI and drive data | → Load data (Page 345) |
2.5 Procedure when tuning axes and drives

Precondition

Once the drives have been commissioned and the axes assigned, you must start tuning the particular machine or a machine type.
- The drives have been commissioned: the axes move.
- The topology has been checked and is OK.

Recommended tuning sequence

<table>
<thead>
<tr>
<th>Procedure:</th>
<th>Reference to the corresponding chapter:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic servo tuning</td>
<td>Automatic servo tuning (Page 293)</td>
</tr>
<tr>
<td>⇒ including following error compensation</td>
<td>Chapter &quot;Compensations&quot;: Dynamic feedforward control (following error compensation)</td>
</tr>
<tr>
<td>Automatic Servo Tuning: Path interpolation</td>
<td>Example for path interpolation (Page 307)</td>
</tr>
<tr>
<td>Optional: Manual calibration of the controller using measuring functions</td>
<td>Measuring functions (manual tuning) (Page 316)</td>
</tr>
<tr>
<td>Intelligent load adaptation</td>
<td>Adaptations (Page 255)</td>
</tr>
<tr>
<td>Intelligent dynamic response adaptation</td>
<td></td>
</tr>
<tr>
<td>Jerk adaptation</td>
<td>Jerk filter (Page 263)</td>
</tr>
<tr>
<td>Circularity test</td>
<td>Circularity test (Page 334)</td>
</tr>
<tr>
<td>• Motor encoder</td>
<td></td>
</tr>
<tr>
<td>• Measuring system (encoder 1, encoder 2)</td>
<td></td>
</tr>
<tr>
<td>1-axis compensations:</td>
<td></td>
</tr>
<tr>
<td>Interpolatory compensation</td>
<td>Chapter &quot;Compensations&quot;: Leadscrew error and measuring system error compensation</td>
</tr>
<tr>
<td>• Lead screw error compensation</td>
<td></td>
</tr>
<tr>
<td>• Measuring system error compensation</td>
<td></td>
</tr>
<tr>
<td>Temperature compensation</td>
<td>Chapter &quot;Compensations&quot;: Temperature compensation</td>
</tr>
<tr>
<td>Backlash compensation:</td>
<td>Chapter &quot;Compensations&quot;: Backlash compensation</td>
</tr>
<tr>
<td>• Mechanical</td>
<td></td>
</tr>
<tr>
<td>• Dynamic</td>
<td></td>
</tr>
<tr>
<td>• Dual position feedback</td>
<td></td>
</tr>
<tr>
<td>Friction compensation</td>
<td>(K3) Compensations: Friction compensation with a constant compensation value</td>
</tr>
<tr>
<td>Friction compensation with adaptive characteristics</td>
<td>Friction compensation with adaptive characteristics (Page 236)</td>
</tr>
<tr>
<td>Nodding compensation</td>
<td>Nodding compensation (Page 246)</td>
</tr>
<tr>
<td>Multi-axis compensations:</td>
<td></td>
</tr>
<tr>
<td>Cylinder error compensation (only for cylindrical grinding)</td>
<td>Chapter &quot;Compensations&quot;: Cylinder error compensation</td>
</tr>
<tr>
<td>Sag compensation</td>
<td>Chapter &quot;Compensations&quot;: Sag and angularity error compensation</td>
</tr>
</tbody>
</table>
### 2.5 Procedure when tuning axes and drives

<table>
<thead>
<tr>
<th>Procedure:</th>
<th>Reference to the corresponding chapter:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compensation in space (option)</td>
<td>---</td>
</tr>
<tr>
<td>Volumetric Compensation System (RMCC/VCS)</td>
<td>---</td>
</tr>
<tr>
<td>Volumetric compensation interface (option)</td>
<td>---</td>
</tr>
<tr>
<td>Volumetric compensation interface (RMCCI/VCI)</td>
<td>---</td>
</tr>
</tbody>
</table>

Introduction

2.5 Procedure when tuning axes and drives
Requirements for commissioning

3.1 General prerequisites

Preconditions for components involved

The complete system is connected mechanically and electrically, and has been verified in the following points:

- All ESD measures are observed for the design of the components.
- All screws are tightened with their prescribed torque.
- All connectors are plugged correctly and locked/screwed.
- All components are grounded and connected to shields.
- The load capacity of the central power supply is taken into account.

Limit values

All components are dimensioned for defined mechanical, climatic and electrical environmental conditions. No limit value may be exceeded, neither during operation, nor during transportation. Special attention must be paid to the limit values:

- Power supply conditions
- Pollution burden
- Function-impairing gases
- Ambient environmental conditions
- Storage/transport
- Shock stressing
- Vibration stressing
- Ambient temperature

You can find further details in the following manuals:

- Interfaces at the control system: SINUMERIK 840D sl Equipment Manual NCU 7x0.3B PN (https://support.industry.siemens.com/cs/de/en/view/99922219)
3.2 Software and hardware preconditions

Requirements for commissioning

For the commissioning of SINUMERIK 840D sl, the following points are required:

- **Hardware requirements**
  - NCU with TCU
  - CompactFlash card
  - Dual fan/battery module for NCU
  - Optional: PCU 50.5 with Windows 7 and operator panel

  **Note**
  For the operation of SINUMERIK Operate on the PCU without TCU, the "HMI" subsystem for SINUMERIK Operate on the NCU must be switched off.

- **Connection to NCU**
  - Network switch to X120
  - Ethernet machine control panel to socket X120
  - Ethernet connection from PG/PC to X120 or X127 for commissioning the PLC
  - Ethernet connection from the TCU to the Ethernet machine control panel
  - Optional: Ethernet connection from the PCU to the Ethernet machine control panel

- **Software requirements**
  - CNC software with SINUMERIK Operate
  - Optional: SINUMERIK Operate for operation on the PCU
  - SIMATIC STEP 7 on PG/PC (engineering system)
  - SINUMERIK 840D sl Toolbox for STEP 7 package
  - GSD files (Toolbox)

  **Note**
  The part numbers of the SINAMICS drives, encoders and motors should be available for parameterization.
3.3 Position of the interfaces

Interfaces on the NCU

The NCU has the following interfaces:

- X100 ... X105: DRIVE-CLIQ for SINAMICS drive components
- X124: +24 V DC external power supply
- X125, X135: USB only for commissioning and servicing
- X120: Industrial Ethernet for connection to a system network (TCU and/or PCU)
- X130: Industrial Ethernet for connection to a company network
- X127: Industrial Ethernet service interface for PG/PC
- X136: PROFIBUS DP / MPI
- X126: PROFIBUS DP PROFIBUS DP (for example for PLC axes)
- X150-1, X150-2: PROFINET IO for PROFINET components
- X122, X132, X142: Based on PROFINET Digital inputs/outputs for I/O devices

Figure 3-1 Position of the interfaces
3.4 Power-On and boot-up

3.4.1 NC and PLC memory reset

**SVC/NCK and PLC rotary switches**

The NCU has two rotary switches in the lower section of the front panel.

Meaning of the settings at the rotary switch SVC/NCK:

<table>
<thead>
<tr>
<th>Switch position</th>
<th>NC operating mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Normal power-up of the NC</td>
</tr>
<tr>
<td>1</td>
<td>Power-up of the NC with preset values (= general reset)</td>
</tr>
<tr>
<td>2</td>
<td>Power-up of the NC with preset values; after powering up, the PLC is in RUN.</td>
</tr>
<tr>
<td>7</td>
<td>Debug mode (NC is not started)</td>
</tr>
<tr>
<td>8</td>
<td>IP address of the NCU is displayed on the seven-segment display</td>
</tr>
<tr>
<td>All others</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>

The settings on the PLC switch have the same meaning as for a SIMATIC S7-CPU:

<table>
<thead>
<tr>
<th>Switch position</th>
<th>Operating mode of the PLC</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>RUN</td>
</tr>
<tr>
<td>1</td>
<td>RUN (protected mode)</td>
</tr>
<tr>
<td>2</td>
<td>STOP</td>
</tr>
<tr>
<td>3</td>
<td>Memory reset (MRES)</td>
</tr>
<tr>
<td>All others</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>
Initial commissioning

In order to achieve a defined state of the complete system, for the initial commissioning of the NCU, a general reset of the NC and the PLC must be performed.

Note

In the following cases, a general PLC reset must always be performed:
- Initial commissioning
- Module replacement
- General reset request by the PLC
- Upgrading the PLC

Procedure:

1. Set the rotary switch of the NCU to the following settings:
   - NCK commissioning switch: Switch position "1"
   - PLC mode selector: Switch position "3"

2. Initiate a power-on reset by switching-off the control and switching-on again – or by pressing the Reset button on the front of the NCU. The NC is shut down and is restarted with the request for a general reset.
   Effect:
   - The "STOP" LED flashes.
   - The "SF" LED illuminates continuously.

3. Within approx. three seconds, turn the PLC mode selector switch to the positions "2" → "3" → "2".
   Effect:
   - The "STOP" LED first flashes with about 2 Hz and then illuminates continuously.

4. Turn the PLC mode selector switch back to the "0" position.
   Effect:
   - The "STOP" LED extinguishes.
   - The "RUN" LED flashes initially and then illuminates green continuously.

5. Turn the NCK commissioning selector switch back to the "0" position.
Result

The NC has now been generally reset and is in the following state:

- **NC**
  - The user data is deleted.
  - The system data is initialized.
  - The standard machine data is loaded.

- **PLC**
  The general reset places the PLC in a defined initial state:
  - The user data has been deleted (data and program blocks).
  - The system data blocks (SDB) have been deleted.
  - The diagnostics buffer and the MPI parameters have been reset.

The "RUN" LED illuminates. NC and PLC are in cyclic operation.

**Note**

**PLC general reset**

If a general PLC reset is performed using a power-on reset, then the user data must again be transferred to the PLC, e.g. via a programming device (PG).

After the PLC general reset, no PLC start is performed and at least the following alarm issued:

- **Alarm**: "2001 PLC not booted"

The alarms have no influence on the next steps.

### 3.4.2 A general reset is separately performed for the NC and PLC

**General reset of the NC**

Carry out the following actions to perform an NC general reset:

1. Turn the NCK commissioning switch on the front of the NCU to position "1".
2. Initiate a power on reset by switching-off the control system and switching-on again – or by pressing the reset button on the front of the NCU (labeled "RESET"). The system is shut down and is restarted with the request for a general reset of the NC.
3. After the system has booted, turn the NCK commissioning switch back to position "0".

**Effect:**

- The number "6" and a flashing point are output on the 7-segment display on the front of the NCU.
- LED "RUN" lights up.
The NCU is in the following state after an error-free boot-up:

- The NC is in cyclic operation.
- The static memory of the NC is deleted.
- The machine data is preassigned standard values.

**Alternatives**

A PLC general reset can be performed with or without power-on reset. Depending on this, various states are obtained for the PLC program.

**General PLC reset without a power-on reset**

Carry out the following actions to execute a general PLC reset **without** a power-on reset:

1. Turn the PLC mode selector switch on the front of the NCU to position "2" (STOP).
   
   Effect:
   - The PLC goes into the "STOP" mode.
   - The "STOP" LED illuminates.

2. Turn the PLC mode selector switch to position "3" (MRES)
   
   Effect:
   - The "STOP" LED goes dark and after approx. three seconds illuminates again.

3. Within approx. three seconds, turn the PLC mode selector switch to the positions "2" → "3" → "2"
   
   Effect:
   - The "STOP" LED first flashes with about 2 Hz and then illuminates continuously.

4. Turn the PLC mode selector switch back to the "0" position.
   
   Effect:
   - The "STOP" LED extinguishes.
   - The "RUN" LED illuminates.

The general reset places the PLC in a defined state:

- The PLC is in cyclic operation.
- The time of day and the operating hours counter have not been reset.
- The diagnostics buffer and the MPI parameters have not been reset.

**Note**

For the general reset without power-on reset, the most recently loaded blocks from the PLC program are reimported.
General PLC reset with power-on reset

Carry out the following actions to execute a general PLC reset with a power-on reset:

1. Turn the PLC mode selector on the front of the NCU to position "3" (MRES).

2. Initiate a power-on reset by switching-off the control and switching-on again – or by pressing the Reset button on the front of the NCU. The NCU is terminated and with the request for a general reset is restarted.
   Effect:
   – The "STOP" LED flashes.
   – The "SF" LED illuminates continuously.

3. Within approx. three seconds, turn the PLC mode selector switch to the positions "2" → "3" → "2".
   Effect:
   – The "STOP" LED first flashes with about 2 Hz and then illuminates continuously.

4. Turn the PLC mode selector switch back to the "0" position.
   Effect:
   – The "STOP" LED extinguishes.
   – The "RUN" LED flashes initially and then illuminates green continuously.

The general reset places the PLC in a defined state:
- The user data has been deleted (data and program blocks).
- The system data blocks (SDB) have been deleted.
- The diagnostics buffer and the MPI parameters have been reset.

3.4.3 Boot completed

Boot completed without error

After an error-free boot of the NCU, the following status is displayed:
- The number "6" and a flashing point
- The "RUN" LED illuminates green continuously.

In the following step, commissioning of the PLC is done with the SIMATIC Manager.
3.5 Access levels

Access to functions and machine data

The access concept controls access to functions and data areas. Access levels 0 to 7 are available, where 0 represents the highest level and 7 the lowest level. Access levels 0 to 3 are locked using a password and 4 to 7 using the appropriate key-operated switch.

<table>
<thead>
<tr>
<th>Access level</th>
<th>Locked by</th>
<th>Area</th>
<th>Data class</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Password: SUNRISE</td>
<td>Manufacturer</td>
<td>Manufacturer (M)</td>
</tr>
<tr>
<td>2</td>
<td>Password: EVENING</td>
<td>Service</td>
<td>Individual (I)</td>
</tr>
<tr>
<td>3</td>
<td>Password: CUSTOMER</td>
<td>User</td>
<td>User (U)</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>Programmer, machine setter</td>
<td>User (U)</td>
</tr>
<tr>
<td>5</td>
<td>Key-operated switch setting 3</td>
<td>Qualified operator</td>
<td>User (U)</td>
</tr>
<tr>
<td>6</td>
<td>Key-operated switch setting 1</td>
<td>Trained operator</td>
<td>User (U)</td>
</tr>
<tr>
<td>7</td>
<td>Key-operated switch setting 0</td>
<td>Semi-skilled operator</td>
<td>User (U)</td>
</tr>
</tbody>
</table>

The password remains valid until it is reset with the "Delete Password" softkey. The passwords can be changed after activation.

If, for example, the passwords are no longer known, reinitialization (boot-up with "NCK default data") must be carried out. This resets all passwords to the default (see table). A power-on reset does not reset the password.

Key-operated switch

Access levels 4 to 7 require a corresponding key-operated switch setting on the machine control panel. Three keys of different colors are provided for this purpose. Each of these keys only provides access to certain areas.

<table>
<thead>
<tr>
<th>Access level</th>
<th>Switch position</th>
<th>Key color</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-7</td>
<td>0 to 3</td>
<td>Red</td>
</tr>
<tr>
<td>5-7</td>
<td>0 to 2</td>
<td>Green</td>
</tr>
<tr>
<td>6-7</td>
<td>0 and 1</td>
<td>Black</td>
</tr>
<tr>
<td>7</td>
<td>0 = Key removal position</td>
<td>No key inserted</td>
</tr>
</tbody>
</table>
Set password

Procedure:

1. Select the "Commissioning" operating area and press the "Password" softkey.
2. Press the "Set password" softkey. The current key-operated switch setting is displayed first:

![Set password screen](image)

3. Enter the password for the desired access level and confirm this input with "OK" or with the `<INPUT>` button.
   A valid password is acknowledged as set and the access level is set. Invalid passwords will be rejected.

Pressing the "Delete password" softkey deletes the last valid password and displays the current key-operated switch setting again.

Note
Delete password

The password can also be deleted via the PLC → PI service: LOGOUT → Function Manual "PLC (https://support.industry.siemens.com/cs/ww/en/view/109767449)".

Rules relating to the password structure

The following rules must be observed when assigning a new password:

- The password has a length of between 8 and 32 characters.
- A password must contain at least one number, at least one uppercase letter, and at least one lowercase letter.
- A password may contain the following characters:
  - Special characters (ASCII 0x20 to 0x7E)
  - Uppercase characters
  - Lowercase characters
  - Numbers
- A new password must not have any similarity to the following data:
  - User name
  - Computer name
  - Additional user data (GECOS data that can be additionally saved under Linux.)
This information can also be found in the online help of SINUMERIK Operate.

Change password

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Change password</strong></td>
</tr>
<tr>
<td>Observe the following &quot;Rules relating to the password structure&quot; for the selection of the new password.</td>
</tr>
<tr>
<td>Note the following changes in the handling of passwords:</td>
</tr>
<tr>
<td>• A password that has been changed cannot be reset to a default password.</td>
</tr>
<tr>
<td>• After a software upgrade to version 4.8 SP3, the passwords valid under Linux apply <strong>immediately</strong> in the NC.</td>
</tr>
<tr>
<td>• In the following cases, the default passwords in the delivery condition are no longer valid in the NC and have been replaced by the currently valid passwords under Linux:</td>
</tr>
<tr>
<td>– After importing a startup archive</td>
</tr>
<tr>
<td>– After a memory reset of the NC</td>
</tr>
</tbody>
</table>

Procedure:

1. To change the default password from the delivery condition, press the "Change password" softkey.

2. The previous password must first be confirmed. After successful authentication, you are forwarded automatically to the following dialog:

   ![Change password dialog]

3. Enter the new password and the repetition, and then confirm with the "OK" softkey. If both passwords match, the new password becomes valid and is adopted by the system.
### Password forgotten?

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Password forgotten?</strong></td>
</tr>
</tbody>
</table>

Assigning a new password to replace a forgotten password is a very time-consuming process, in particular, an unavailable password hinders a service job.

Therefore, please take appropriate actions to ensure that the assigned passwords are available for a service job.

If the password is no longer available, please contact the supplier.
4.1 SINUMERIK License Key

Basic information on license keys

If a license is required for a product, then with the purchase of the license the purchaser receives a CoL as proof for the rights to use this product and a corresponding license key as to the "technical representative" of this license. In conjunction with software products, the license key usually must be available on the hardware on which the software product is executed.

---

**Note**

**Trial license**

A trial license supports "short-term use" of the software in a non-productive context, e.g. use for testing and evaluation purposes; it can be transitioned into another license.

---

**SINUMERIK license keys**

Depending on the software product, there are license keys with different technical properties. The essential properties of a SINUMERIK license key are:

- **Hardware serial number**
  
  Via the hardware serial number contained in the SINUMERIK License Key, there is a direct relationship between the License Key and the hardware on which it may be used. That means a License Key that was generated for the hardware serial number of a certain CompactFlash card is also only valid on this CompactFlash card and rejected as invalid on another CompactFlash card.

- **Total number of assigned licenses**
  
  A SINUMERIK license key not only refers to a single license, instead it is the "technical representative" of all licenses that are assigned to the hardware at the time of its generation.

**Content of the CompactFlash card**

The CompactFlash card contains the system and user software, the retentive system and user data, along with the data relevant for the license management of SINUMERIK software products of a control system:

- **Hardware serial number**

- **License information including the license key**

The CompactFlash card thus represents the identity of a SINUMERIK controller. For this reason, assigning licenses to a controller always occurs using the hardware serial number.

This has the advantage that the CompactFlash card can be inserted into a replacement NCU in the event of failure and all data is retained.
CompactFlash card as a spare part

If the CompactFlash card of a SINUMERIK controller is replaced, for example, because of defective hardware, the license key loses its validity and the system is no longer operational.

In case of defective hardware of the CompactFlash card, contact the "Technical Support". They will then send you a new license key without delay. The following data is required:

- Hardware serial number of the defective CompactFlash card
- Hardware serial number of the new CompactFlash card

Note

Only CompactFlash cards can be used that were released as spare part, as only these are known to the license database.

Determining the hardware serial number

The hardware serial number is a permanent part of the CompactFlash card. It is used to identify a control system uniquely. The hardware serial number can be determined by:

- Certificate of License (CoL)
- SINUMERIK user interface
- Label on the CompactFlash card

Note

Hardware serial number and CoL

The hardware serial number is located only on a CoL of the system software or if the license was ordered bundled, in other words the system software came together with options.
4.2 Web License Manager

Overview

The use of the installed system software and the options activated on a SINUMERIK control system require that the licenses purchased for this purpose are assigned to the hardware. In the course of this assignment, a license key is generated from the license numbers of the system software, the options, as well as the hardware serial number. Here, a license database administered by Siemens is accessed via the Internet. Finally, the license information including the license key is transferred to the hardware.

The license database can be accessed using the Web License Manager.

Web License Manager

By using the Web License Manager, you can assign licenses to the hardware in a standard Web browser. To conclude the assignment, the license key must be entered at the controller via the user interface.

Internet links

Web License Manager  (http://www.siemens.com/automation/license)
Siemens Industry Mall (http://mall.automation.siemens.com)
4.3 License database

License database access
The license database contains all relevant license information required for the license management of SINUMERIK software products. The central management of the license information in the license database ensures that the existing license information regarding a piece of hardware is always up to date.

Direct access
The direct access in the Web License Manager is made with:
- License number
- Delivery note number
The direct access enables the direct assignment of licenses for which the license numbers are available, e.g. in the form of a CoL.

Direct access with barcode scanner
The direct access in the Web License Manager is made with:
- Hardware serial number
- Product selection
The direct access enables the assignment of licenses with a barcode scanner for which the license numbers are available as a barcode, for example in the form of a CoL.

Customer login
The customer login in the Web License Manager is made with:
- User name
- Password
The customer login enables the assignment of all the licenses available to the machine manufacturer that are delivered at the time of the login and have not yet been assigned to any machine. Here, the license numbers of licenses that can still be assigned need not be directly at hand, instead these are displayed from within the license database.

Note
Obtaining access data
You can obtain the address data for the customer login from the Siemens Industry Mall under the associated selected region with: “> Register” (top).
4.4 How to perform the assignment

Assigning a license to a piece of hardware

1. Determine the hardware serial number and the product name ("type of hardware") on the user interface via the licensing dialog:
   
   Commissioning > menu forward key > Licenses > Overview operating area

   Note
   
   Ensure that the hardware serial number displayed is also really the one you want to make the assignment for. The assignment of a license to a piece of hardware cannot be reversed via the Web License Manager.

2. Go to the Internet page of the Web License Manager.

3. Click the appropriate access to the license database:
   
   – Direct access
   – Direct access (barcode scanner)
   – Customer login

4. Follow the instructions in the Web License Manager.
   
   A progress bar shows you the individual steps:

   ![Progress bar]

5. Check the details of the selected licenses before confirmation of the assignment process.

   Note
   
   After confirmation, the generated license key irrevocably links the selected licenses with the specified hardware.

6. Confirm the assignment process.

7. After completing the assignment process, enter the license key displayed on the Web License Manager into the license dialog of the user interface.

   Commissioning > menu forward key > Licenses > Overview operating area

8. Press the <INPUT> button to confirm the input of the new license key.

Displaying the license key and sending via e-mail

For archiving or for documentation of the associated machine, you can also send a license report with the grouping of all assigned licenses. Follow the instructions in the Web License Manager under "Display License Key".
4.5 Important licensing terms

Certificate of License (CoL)

The CoL is the proof of the → license. The product may only be used by the holder of the → license or authorized persons. The CoL includes the following data relevant for the license management:

- Product name
- License number
- Delivery note number
- Hardware serial number

CompactFlash card

As the carrier of all non-volatile data in a SINUMERIK solution line control system, the CompactFlash card represents the identity of this control system. The CompactFlash card is a memory card that can be plugged into the → Control Unit from outside. The CompactFlash card also contains the following data relevant for the license management:

- Hardware serial number
- License information including the → license key

Hardware

In the context of license management of SINUMERIK → software products, hardware refers to the component of a SINUMERIK control system to which → licenses are assigned on the basis of its unique identifier. The license information is also saved to non-volatile memory on this component, e.g. on a → CompactFlash card.

Hardware serial number

The hardware serial number is a permanent part of the → CompactFlash card. It is used to identify a control system uniquely. The hardware serial number can be determined by:

- → Certificate of License
- User interface
- Label on the CompactFlash card

License

A license gives the user the legal right to use a → software product. Evidence of this right is provided by the following:

- → Certificate of License (CoL)
- → License key
License key

The License Key is the "technical representative" of the sum of all the → licenses that are assigned to one particular piece of → hardware, which is uniquely identified by its → hardware serial number.

License number

The license number is the feature of a → license used for its unique identification.

Option

An option is a SINUMERIK → software product that is not contained in the basic version and which requires the purchase of a → license for its use.

Product

A product is marked by the data below within the license management of SINUMERIK → software products:

- Product designation
- Article number
- License number

Software product

The term software product is generally used to describe a product that is installed on a piece of → hardware to process data. Within the license management of SINUMERIK software products, a corresponding → license is required to use each software product.
Licensing

4.5 Important licensing terms
5.1 Connect PG/PC with the PLC

Introduction
SIMATIC Manager is a GUI for online/offline editing of S7 objects (projects, user programs, blocks, hardware stations and tools).

You can perform the following actions with the SIMATIC Manager:

- Manage projects and libraries
- Call STEP 7 tools
- Establish an online connection to the PLC

A corresponding editing tool is started up when you open the relevant objects. The program editor starts by double-clicking a program block. The block can be processed.

Starting SIMATIC Manager
After installation, the SIMATIC Manager icon appears on the Windows desktop, and in the Start menu a "SIMATIC Manager" program item appears under "SIMATIC".

- Start the SIMATIC Manager by double-clicking the link on the Windows desktop or from the Start menu.
- The online help for the active window is always called by pressing the <F1> function key.

Establishing communication with the PLC
To load the configuration into the PLC, the connection (Ethernet) from the PG/PC to the PLC required for the loading must be ensured.

Procedure:
1. Select menu command: "Extras" > "Set PG/PC interface..."
2. Under the "Access mode" tab, look for the interface used in the "Interface parameterization used" selection field, for instance: "TCP/IP → Realtek RTL8139/810x F..."
3. Confirm the parameterization with "OK".

Note
Parameterization of the PG/PC interface can be performed or changed from the SIMATIC Manager at any time.
5.2 Creating a SIMATIC S7 project (PROFIBUS)

5.2.1 SIMATIC S7 project overview

Steps to be taken

A SIMATIC S7 project must be created for the basic commissioning of the PLC, the Ethernet and PROFIBUS communication as well as the input/output data areas of the NC. To do this, perform the following steps:

- Create a project
- Insert a SIMATIC station 300
- Insert an NCU to the hardware configuration
- Configuring interfaces
- Insert the machine control panel and handwheel

What do you need to be aware of?

Loading the PLC via interface X130 is also possible if the IP address of the Ethernet interface is known. Loading an archive may always be performed if the communication HMI↔NC is available.


Operating sequence

You have started the SIMATIC Manager.

1. To create a new project, select the "File" → "New" menu command in the SIMATIC Manager.
2. Enter the project data:
   - Name (for example: SINU_840Dsl)
   - Storage location (path)
   - Type
3. Confirm the dialog with "OK".
   The project window is displayed showing an empty S7 project structure.
5.2.2 Inserting SINUMERIK NCU to the HW Config

Overview

Insert the necessary hardware in the following order in the S7 project:

- Insert a SIMATIC station 300
- Start the hardware configuration
- Insert a SINUMERIK NCU

Operating sequence

Procedure:

1. Select via the context menu (right-click) "Insert new object" > "SIMATIC 300 station".

2. Double-click the <SIMATIC 300> symbol.
3. Double-click the <Hardware> symbol. The HW Config for introducing required hardware is started.

4. In the menu, select "View" > "Catalog". The catalog with the modules is displayed.

The user interface of the "HW Config" hardware configuration shows the following details:

- Station window:
The station window is split. The upper part displays the structure of the station graphically, and the lower part provides a detailed view of the selected module.

- Hardware catalog
This catalog also contains the SINUMERIK NCU that you need for configuring the hardware.
Inserting a SINUMERIK NCU

With the operating sequence described below, you insert the NCU 720.3 PN as example:

1. Select "View" > "Catalog".
2. Search for the module in the catalog under "SIMATIC 300" → "SINUMERIK" → "840D sl" > "NCU 720.3 PN".
3. Select “NCU 720.3 PN” with the left mouse button and drag it to the “Station design” station window while keeping the mouse button pressed.

After you release the mouse button, into the dialog, configure the properties of the interfaces of the communication processor CP provided on the NCU.
5.2.3 Configuring interfaces

Introduction

Configure the following interfaces in the STEP 7 project via which you want to access the NCU:

- Integrated PROFIBUS
- PROFIBUS DP, only with machine control panel for PROFIBUS (Page 64)
- Industrial Ethernet

When creating a new project using the catalog, the configuration of the PROFIBUS interface is called automatically.

PROFIBUS DP operating sequence

1. Left-click to select an NCU and while holding down the mouse button drag it to the "Station design" station window.

2. After you release the mouse button, configure the properties of the PROFIBUS DP interface for socket X126 (machine control panel) in the dialog box.

3. No configuration is necessary for an Ethernet machine control panel: Select "Cancel".
4. The NCU module with SINAMICS S120 is inserted into the HW Config.

![Image of HW Config with NCU module inserted]

**Note**
With the <F4> key and confirmation of the prompt regarding "Reorganization", you can reorganize the display in the station window.

5. Confirm with "OK".

Next, specify the properties for the Ethernet interface.

**Operating sequence for Ethernet interface**

**Note**
Use service interface X127 when commissioning the PLC. The Ethernet interface does not have to be configured. This interface is already initialized with the IP address 192.168.215.1
For the initial commissioning with a PG/PC, it is necessary to configure an Ethernet interface. In our example, this involves the interface to socket X120.

1. Double-click "CP 840D sl" in the basic rack of the NCU. The "Properties - CP 840D sl" dialog opens.

2. After clicking the "Properties" button, a new Ethernet interface can be created.

3. For socket X120, enter the IP address "192.168.214.1" and the Subnet screen form "255.255.255.0".

4. Create the Ethernet interface using "New" and then "OK".

5. Click "OK" twice.
Setting the isochronous mode on the PROFIBUS DP

Procedure for configuring the PROFIBUS DP interface in the STEP 7 project:

1. Left-click to select an NCU, and while holding down the mouse button drag it to the "Station design" station window.

2. After you release the mouse button, configure the properties of the PROFIBUS DP interface for socket X126 (machine control panel) in the dialog box.

3. Click "New…" and then the "Net settings" tab in the "New PROFIBUS subnet properties" dialog.

4. Select the transmission rate of "12 Mbit/s" for the "DP" profile.
5. Click "Options" and then the "Isochronous mode" tab.

6. To enable reproducible access to peripherals (for handwheel mode), the PROFIBUS DP must have a constant bus cycle time. The following entries are necessary under Isochronous mode:

- Click the "Activate isochronous bus cycle" field.
- Enter the cycle, e.g. "2 ms" for the "Equidistant DP cycle" for the integrated PROFIBUS (also see: MD10050 $MN_SYSCLOCK_CYCLE_TIME).
- Click the "Times Ti and To equal for all slaves" field.
- The fields "Time Ti" and "Time To" must contain a value "< 2 ms".
7. Click "OK" three times.
8. The NCU module with SINAMICS S120 is inserted in the HW Config.

Note

With the <F4> key and confirmation of the prompt regarding "Reorganization", you can reorganize the display in the station window.

As the next step configure a machine control panel with handwheel.
5.2.4 Augmenting the machine control panel and handwheel in the HW configuration

Sequence and requirements

Configuring sequence for a PROFIBUS machine control panel:
1. Configuring the properties of the PROFIBUS DP interface.
2. Augment the machine control panel and handwheel in HW Config.
3. Modify the machine control panel in the OB100.

If a handwheel has been configured, isochronous mode on the PROFIBUS is required. The PROFIBUS address for the machine control panel is "6". To expand the machine control panel, you need the device master data (GSD file) with the SINUMERIK machine controlled panel. This file is part of the STEP 7 package in the toolbox and contains information that a DP master system requires to link the MCP as DP slave in its PROFIBUS configuration.

Procedure for the installation:
1. Search in the HW Config under "Tools" > "Install GSD file..." in the installation directory of the toolbox for the corresponding GSD directory under:
   ..\8x0d\GSD\MCP_310_483
2. Choose the corresponding language you want to install.
3. Select "Install".
4. Exit with "Close".

Augmenting the machine control panel in HW Config

You have created an NCU and an NX in the HW Config and installed the GSD file for the MCP.

Procedure:
1. Search under "PROFIBUS DP" → "Further field devices" → "NC/RC" → "MOTION CONTROL" in the hardware catalog for the "SINUMERIK MCP" module.
2. Left-click to select the "SINUMERIK MCP" module and drag it to the chain for the "PROFIBUS DP master system" in the "Station design" station window.
3. After releasing the mouse key, you have inserted the machine control panel.
4. Select the "MCP" and enter the PROFIBUS address 6 under "Object properties" → "PROFIBUS..." button → "Parameter" tab → "Address" input field.
5. Click "OK" twice. You can now assign the slots of the machine control panel with e.g. "Standard + handwheel".

6. In the hardware catalog, select "SINUMERIK MCP" → "Standard+Handwheel" and drag it to slot 1.

In the next step, configure the Web browser. Then save, compile and load the configuration to the PLC.
5.2.5 Modifying PROFIBUS machine control panel in OB100

Configuring the machine control panel

The PLC base program transfers the signals from the machine control panel. To ensure that the signals are transferred correctly to and from the machine control panel, enter the following parameters in the OB100 on the FB1. Under "Blocks", double-click OB100 to open the editor to configure the machine control panel.

**Example**: MCP1 is connected via PROFIBUS DP.

```plaintext
OB100

CALL "RUN_UP", "gp_par" FB1 / DB7 -- Startup Baseprogram/ Parameters for Base-program

MCPNum :=1 // An MCP is present
MCP1In :=P#E 0.0
MCP1Out :=P#A 0.0
MCP1StatSend :=P#A 8.0
MCP1StatRec :=
MCP1BusAdr :=6 // PROFIBUS DP address: 6
MCP1Timeout :=
MCP1Cycl :=
MCP2In :=
MCP2Out :=
MCP2StatSend :=
MCP2StatRec :=
MCP2BusAdr :=
MCP2Timeout :=
MCP2Cycl :=
MCPMPI :=FALSE
MCP1Stop :=FALSE
MCP2Stop :=
MCP1NotSend :=FALSE
MCP2NotSend :=
MCPSDB210 :=
MCPCopyDB77 :=
MCPBusType :=B#16#03 // Parameter [3] := PROFIBUS DP
```
OB100

BNG :=
BHGIn :=
BHGOut :=

UDInt :=
UDHex :=
UDReal :=
IdentMcpType :=
IdentMcpLengthIn :=
IdentMcpLengthOut:=

//Insert User program from here

An example for the connection via Industrial Ethernet (IE) can be found at: Modifying machine control panel in OB100 (Page 89)


5.2.6 Configuring the Web server

Operating sequence

1. Click the SINUMERIK module in the hardware configuration to open the following dialog.

2. Select the "Web" tab.
3. Activate the option: "Activate the Web server on this module". After loading the configuration data, the Web server of the CPU is started to read information from the PLC.

4. Select the language for language-dependent texts to be loaded into the CPU. The number of available languages is CPU-dependent. Examples of language-dependent texts are diagnostics buffer entries or messages.

**Note**

**Available languages**

The languages you select here must be installed in the S7 project. You can install the languages for the project in the SIMATIC Manager from "Extras" → "Language for display devices ..."

If the languages you select in the SIMATIC Manager have not been installed previously, the Web server can only display texts in the set default language.

5. Activate the "Automatic update" if you want the Web pages to be updated automatically. The "Identification" Web page is excluded from the automatic update.

**Telegram lengths and I/O addresses**

The telegram lengths and I/O addresses for communication between the PLC and the drive (can be viewed via the object properties of the integrated SINAMICS) have already been pre-assigned correctly and do not need to be configured.

### 5.2.7 Inserting an NX to the hardware configuration

**Introduction**

The NX must be wired to the NCU via the DRIVE-CLiQ. A DRIVE-CLiQ socket is permanently preassigned for each address. The following table shows the wiring:

<table>
<thead>
<tr>
<th>DRIVE-CLiQ interface of the NCU</th>
<th>Address on the integrated PROFIBUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>X100</td>
<td>10</td>
</tr>
<tr>
<td>X101</td>
<td>11</td>
</tr>
<tr>
<td>X102</td>
<td>12</td>
</tr>
<tr>
<td>X103</td>
<td>13</td>
</tr>
<tr>
<td>X104 *)</td>
<td>14</td>
</tr>
<tr>
<td>X105 *)</td>
<td>15</td>
</tr>
</tbody>
</table>

*) Not available on the NCU 710.3B PN.
Operating sequence

An NX component is contained in the example configuration, for the axis to control the spindle. This component must be integrated in the hardware configuration also when creating the STEP 7 project:

1. Search for the NX module NX15.3 in the hardware catalog under “PROFIBUS DP” > “SINAMICS” > “SINUMERIK NX…”.

2. Left-click to select the "SINUMERIK NX ..." module and drag it to the "PROFIBUS Integrated DP master system" bus in the "Station design" station window.

3. The "DP Slave Properties" dialog box opens.

Enter the address for the integrated PROFIBUS in this dialog. “15” is proposed for the first NX in a configuration.

4. Enter the address and click "OK".
5. Confirm the wiring notification with "OK".

6. After releasing the mouse key, you have inserted the NX module:

When deleting and reinserting NX modules, while configuring, a new address area is assigned each time. We recommend that addresses are assigned as follows in order to create a transparent configuration:

<table>
<thead>
<tr>
<th>DRIVE-CLiQ interface</th>
<th>Address on the integrated PROFIBUS</th>
<th>Start address of the first slot</th>
<th>Start address of the last slot</th>
</tr>
</thead>
<tbody>
<tr>
<td>X100</td>
<td>10</td>
<td>5540</td>
<td>5740</td>
</tr>
<tr>
<td>X101</td>
<td>11</td>
<td>5300</td>
<td>5500</td>
</tr>
<tr>
<td>X102</td>
<td>12</td>
<td>5060</td>
<td>5260</td>
</tr>
<tr>
<td>X103</td>
<td>13</td>
<td>4820</td>
<td>5020</td>
</tr>
<tr>
<td>X104</td>
<td>14</td>
<td>4580</td>
<td>4780</td>
</tr>
<tr>
<td>X105</td>
<td>15</td>
<td>4340</td>
<td>4540</td>
</tr>
</tbody>
</table>
5.2.8 End the hardware configuration and load it to the PLC

End the hardware configuration and load the to the PLC

The project must be saved and compiled to exit the overall configuration and generate the system data for the PLC:

1. Select the "Station" → "Save and compile" menu.

2. Click the "Load in module" button to load the configuration to the PLC. The "Select target module" dialog automatically displays both configured communication partners.

3. Confirm with OK to load into these two modules.

4. Confirm the dialog boxes displayed subsequently with "OK" or "No" for the query "Should the module be started now (restart)?".

   **Note**
   
   Check the communication interface under "Target system" → "Diagnostics" → "Operating state".

5. Close the "HW Config" window.

The next step is to create the PLC program.
5.3 Extending the SIMATIC S7 project (PROFINET)

5.3.1 Requirements when configuring PROFINET

PROFINET IO IRT (Isochronous Real Time)

I/O modules and drives can use the isochronous PROFINET IO IRT. In addition to IRT, an RT communication is also possible by default.

PROFINET IO IRT can be used by the PLC as PLC I/O and also by the NC. Drives are typically, but not exclusively, configured as isochronous devices for use by the NC. The PROFINET IO IRT devices operated isochronously by the PLC are typically I/O stations.

The concurrent operation of IRT “high performance” and CBA on the same PROFINET bus interface is not supported. This means either NC drives via PROFINET IO with IRT or system coupling via PROFINET CBA can be operated on an NCU.

The combination of isochronous PROFINET NC peripherals (drives, inputs/outputs) and NCU-LINK is not supported.
Settings for isochronous operation

NC-controlled drives connected via PROFINET must be operated isochronously with the same cycle clocks (Tdp, Ti and To) as the drives, which are connected via the integrated PROFIBUS. The cycle clock settings are made in STEP 7 (HW Config). For a SINUMERIK, times Ti and To must match in the complete system.

Isochronous alarm “NCK” of the PLC 317-3PN/DP:

Clock cycle setting of the SINAMICS integrated of the NCU:
5.3 Extending the SIMATIC S7 project (PROFINET)

5.3.2 Sample configuration

Configuration via PROFINET

The SINAMICS S120 drives communicate via PROFINET interfaces X150 P1 and X150 P2 with the NCU. The drives assigned to the SINAMICS CU3x0-2 can be operated NC-controlled or PLC-controlled. Mixed operation is also permitted. Requirement is that the drives are connected via PROFINET, with an additional switch between X120 and X150 of the NCU.

- CU310-2 PN
- CU320-2 PN (also with Communication Board CBE20)
- CU320-2 DP with Communication Board CBE20
- Scalance X208 (recommended)

Setting of the isochronous PROFINET IO device:

Only "NCK" has to be selected in the I/O device, values Ti and To are automatically taken from the synchronous master.
Sample configuration

Communication with the drive

For instance, to establish a network connection from the plant/system network (X120) to the drive network (X150), we recommend that an alias IP address is allocated. In the operating area, select "Commissioning" → "Network" → "Overview". Press the "Change" softkey, and enter an alias address for X120 of the following type:

<table>
<thead>
<tr>
<th>NCU</th>
<th>IP address</th>
<th>Subnet mask</th>
<th>MAC address</th>
</tr>
</thead>
<tbody>
<tr>
<td>X120 system requested</td>
<td>192.168.214.1</td>
<td>255.255.255.0</td>
<td>00:1F:F8:04:81:3E</td>
</tr>
<tr>
<td>alias address</td>
<td>192.168.8.101</td>
<td>255.255.255.0</td>
<td></td>
</tr>
<tr>
<td>X138 company [ICP client]</td>
<td>10.113.10.10</td>
<td>255.255.255.0</td>
<td>00:1F:F8:04:81:3F</td>
</tr>
<tr>
<td>X127 service</td>
<td>192.168.215.1</td>
<td>255.255.255.254</td>
<td>00:1F:F8:04:81:3E</td>
</tr>
</tbody>
</table>

The SINUMERIK Operate Online Help provides more detailed, context-related information on the network settings.
5.3.3 Commissioning the PLC

Basic procedure

Perform the following steps:

- Insert the SINAMICS Control Unit in HW Config.
- Set the sync master and sync slaves.
- Configure the PROFINET interface.
- Configure the isochronous alarms.
- Save the configuration, compile and then download to the PLC.
- Establish the online connection to the target system and assign a device name to the SINAMICS Control Unit.

Configuring a PROFINET connection

Procedure:

1. At the SINUMERIK NCU, select X150 and insert a PROFINET line via the "Insert" → "PROFINET IO system" menu. Click the "New" button to insert a new subnet "Ethernet(1)"

2. Navigate in the catalog to "PROFINET IO" → "Drives" → "SINAMICS" → "SINAMICS S120" → "SINAMICS S120 CU320-2 PN"
3. Keeping the left mouse key pressed, drag the object under "S120 CU320-2 PN" in the station window to the PROFINET IO system.

4. By double-clicking on the SINAMICS Control Unit, you open the "Properties" dialog box to enter a device name.

**Note**

**Device name for SINAMICS S120**

Ensure that you use a meaningful name as device name for the SINAMICS Control Unit.

5. In this dialog box, you also activate the topology-based device initialization by selecting the option "Assign IP address by I/O controller". See also: Complete the PLC project (Page 82)

6. Confirm with "OK".

7. In the next step, you configure the required number of axes, the same as in the configuration example in the previous chapter:

   Three servo DOs, a Control Unit and an infeed with the telegrams recommended for SINUMERIK.
8. Drag the drive objects and drop them into the SINAMICS Control Unit.

The following sequence must be observed:
1. Number of SERVO DO for the axes
2. SINAMICS Control Unit
3. Infeed (optional)

To do this, the following telegrams are recommended:
- SIEMENS telegram 136, PZD-15/19 for a servo DO for an NC-controlled axis.
- SIEMENS telegram 390, PZD-2/2 for the Control Unit:
  Telegram 390 is required for the time synchronization between the drive and the control system. The time stamps of the drive alarms can then be compared to those of the control system.
- SIEMENS telegram 370, PZD-1/1 for the infeed (ALM), if available.

9. In the SINUMERIK NCU, select "Port 1" at the X150 P1 interface and open the "Properties" dialog with a double-click.
10. Select the "Topology" tab to assign the "partner port" to X150 P1 and click "OK" to confirm.

![Topology tab screenshot]

Note for the selection of the cable length that a longer cable length also increases the signal runtime.

11. Select interface X150 in the SINUMERIK NCU and from the shortcut menu "PROFINET IO Domain Management...".

12. In the list under "Station/device name", select the SINUMERIK NCU and with a double-click, open the synchronization dialog in order to define the NCU as "Sync master".

![Synchronization dialog screenshot]
13. In the list under "Station/device name", select the SINAMICS Control Unit and with a double-click, open the synchronization dialog in order to define the SINAMICS Control Unit as "Sync slave".

14. The "Send clock [ms]" text box can then be edited. Here, select the same time as has been set for SINAMICS Integrated of the NCU (DP cycle), for example 2 ms. Confirm with "OK".

15. Select the PLC in the SINUMERIK NCU and open the "Properties" dialog with a double-click.
16. Select the "Clock synchronous alarms" tab and assign the PROFINET IO system number to the "NCK" line to which you have added the SINAMICS Control Unit.

![Image of the NCK Configuration Window]

17. Double-click the "Details" button to open the "NCK" dialog:
Here, enter "2" for the subprocess image and confirm with "OK". For the "Ti/To mode", select the option "Fixed". The project is then saved and compiled.

**Configuring SINAMICS CU320**

**Procedure:**

1. Select interface X150 in the SINAMICS Control Unit.
2. Open the "Properties" dialog and select the "IO cycle" tab.
3. Under "Isochronous Mode", for the option "Assign IO device ...", select "NCK".

![Image of the IO Cycle Configuration Window]
4. Confirm with "OK".

5. The following message is output regarding isochronous mode, which you must confirm with "Yes":

![Image of Object Properties dialog box with isochronous mode setting activation message]

5.3.4 Configuring PROFIsafe

Requirement

In order to configure PROFIsafe, it is necessary that the "S7 configurations pack" option is installed.
Configuring PROFIsafe

Procedure:

1. In the hardware catalog, under "DO SERVO", select PROFIsafe telegram 30, and insert it in the project for the axis for which you wish to configure PROFIsafe.

2. Open properties with a double-click, and enter the start address:

PROFIsafe telegrams must be in the process image with their I/O addresses and must not be assigned to the isochronous process image partition PIP (1 for PLC, 2 for NC).

Result of the PROFIsafe configuring:

Figure 5-2 Configuring with PROFIsafe (excerpt)
Note
Telegram 701

If further Safety Integrated functions are to be configured for an axis, telegram 701 is also required. The configuration procedure is the same as for telegram 30.

The functions available for SINUMERIK are described in the Safety Integrated Function Manual.

5.3.5 Complete the PLC project

Complete the PLC project

Procedure:

1. Select the "Station" → "Save and compile" menu.

2. Click the "Load to module" button to load the configuration to the PLC: End the hardware configuration and load it to the PLC (Page 91).

Topology-based device initialization

The topology-based device initialization is activated by selecting the option "Assign IP address by I/O controller".

![Image of topology-based device initialization](image-url)
Note

Topology-based device initialization

If a topology was defined in HW Config of the S7 project for the complete PROFINET IO system, then it is no longer necessary to assign the device name ("initialization") by STEP 7. As a result of the defined topology, the PLC-CPU automatically identifies and "initializes" the devices, the so-called topology-based device initialization.

Displaying the device name in SINUMERIK Operate

The assigned name is output in the "PROFINET diagnostics" window as device name in SINUMERIK Operate.

PROFINET naming conventions

Device names are assigned to the PROFINET IO devices during the commissioning phase.

In order to communicate with PROFINET devices, they must be initialized (assigned a name). This name is the device name within the hardware configuration. This name must comply with the PROFINET naming conventions. The rules of the naming conventions are checked by the hardware configuration and, if required, corrected. Invalid characters are replaced by "X". The following supplementary conditions must be maintained:

- Maximum length of 127 characters (letters "a" to "z", numbers "0" to "9", hyphen or period).
- A name component within the device name, e.g. a string between two periods, must not exceed 63 characters.
- No special characters such as umlauts, parentheses, underscores, slashes, blanks, etc. are permitted.
- The hyphen is the only special character permitted.
- Upper-case letters must not be used in device names.
- The device name must not begin or end with the "-" or "." character.
- The device name must not begin with numbers.
- The device name must not take the form n.n.n.n (n = 0...999).
- The device name must not start with the character string "port-xyz-" (x,y,z = 0...9).

Specifying device names for SINAMICS CU

Alternative procedure:

To permit the SINAMICS CU to be recognized by the SINUMERIK NCU and the communication via X150 to be established, a device name must be assigned in the PLC configuring of the SINAMICS Control Unit.

1. Establish an online connection to the target system via X150 with the PG/PC.
2. Select the SINAMICS Control Unit in HW Config.
3. Select the "Target system" → "Ethernet >" → "Assign device name" menu.
4. Select the desired SINAMICS Control Unit from the list of the accessible nodes (participants) and enter a name. Select LED flashing in order to identify the drive object.

5. To assign the name, confirm with "OK".

See also

The further procedure matches the configuring process via PROFIBUS:

- Creating a PLC program (Page 85)
- Checking the communication to the drive (Page 215)
5.4 Creating a PLC program

Introduction

The PLC program is constructed modularly. It comprises the following parts:

- PLC basic program
  The PLC basic program organizes the exchange of signals and data between the PLC program and the NC, HMI, and machine control panel components. The PLC basic program is part of the SINUMERIK 840D sl Toolbox.

- PLC program (extension by the machine manufacturer)
  The PLC program is the machine-specific part of the machine manufacturer by which the PLC basic program is extended.
  For example, the FB1 (boot block of the PLC basic program) must be supplied with variables.


Cyclic operation (OB1)

From a chronological viewpoint, the basic program runs before the PLC program. The NC/PLC interface is completely processed in cyclic operation. Cyclic monitoring is activated between PLC and NC once booting and the first OB1 cycle have been completed. A PLC failure produces alarm "2000 Sign-of-life monitoring PLC".

PLC program

The entry points for machine-specific components of the PLC program are located in the following PLC basic program blocks:

- OB100 (restart)
- OB1 (cyclic processing)
- OB40 (process alarm)
PLC status

The PLC always starts up in RESTART mode, i.e. the PLC operating system runs OB100 after initialization and starts cyclic operation at the beginning of OB1. No return is made to the interruption point (for example, in the event of a power failure).

Start-up behavior of the PLC

There are both retentive and non-retentive areas for the markers, timers and counters. The areas are continuous and are divided by a parameterizable limit, where the area with the higher-value address range is defined as the non-retentive area. Data blocks are always retentive.

RESTART startup type (OB100)

If the retentive area is not buffered (the buffer battery is empty) start-up is prevented. The following operations are performed during a restart:

- Delete the UStack, BStack and non-retentive flags, timers and counters
- Delete the process output image (POI)
- Cancel the process and diagnostics alarms
5.4 Creating a PLC program

5.4.1 Preconditions for creating the PLC program

Software and hardware requirements

The following preconditions apply when processing the PLC program:

- SIMATIC STEP 7 V5.5 SP4
- SIMATIC STEP 7 is installed on the PG/PC
- Installation of the SINUMERIK toolbox (PLC base program, slave OEM, GSD files)
- Edit the blocks in the PLC base program
- Installation of the PLC base program library
  To be able to use the blocks of the PLC base program (OBs, FBs, DBs) in a SIMATIC S7 project, the library must first be installed in the SIMATIC Manager.

Editing the blocks in the PLC base program

The SIMATIC STEP 7 documentation describes how to modify and expand the PLC basic program. The individual blocks in the basic PLC program can be processed in the SIMATIC Manager:

- Select the appropriate block, e.g. OB100, in the blocks folder of the corresponding module
- Use the menu command "Edit" → "Open object" to open the block or double-click the block with the left mouse button
- Processing modules in the LAD/STL/FBD editor
- Switching the block view using menu command - "View" → "LAD" or STL, FBD.

5.4.2 Insert PLC basic program

Introduction

You have performed the hardware configuration, have saved and compiled the project and have created the system data for the PLC. You have installed the Toolbox software that also contains the libraries for the PLC basic program of an NCU.
Operating sequence to open the library and copy sources, symbols and blocks

You are on the main screen of the SIMATIC Manager:

1. Select the "File" → "Open" menu and then click the "Libraries" tab.

2. Select the library of the PLC basic program, e.g. "bp7x0_45" and confirm the dialog with "OK".

You have inserted the library and selected the PLC program from "SINU_840Dsl" > "SINUMERIK" → "PLC 317 2DP" → "S7 program".

3. Copy the sources, modules and symbols to the PLC program.

Overwrite OB1

Inserting blocks overwrites the existing organization block OB1. Confirm the query as to whether you want to overwrite the block with "Yes".

You have now created the PLC basic program.

In the next section you will modify some of the data for the machine control panel in OB100.
5.4.3 Modifying machine control panel in OB100

Introduction

The PLC base program transfers the signals from the machine control panel. To ensure that the signals are transferred correctly to and from the machine control panel, enter the following parameters in the OB100 on the FB1. Under "Blocks", double-click OB100 to open the editor to configure the machine control panel.

Example: MCP1 is connected via Industrial Ethernet (IE).

Configuring the machine control panel

```
OB100
CALL "RUN_UP", "gp_par" FB1 / DB7 -- Startup Baseprogram/ Parameters for Base-program

MCPNum := 1 // An MCP is present
MCP1In := P#E 0.0
MCP1Out := P#A 0.0
MCP1StatSend := P#A 8.0
MCP1StatRec :=
MCP1BusAdr := 192 // IP address: 192.168.214.192 - this address must also be set on the DIPFIX switch of the MCP.
MCP1Timeout :=
MCP1Cycl :=
MCP2In :=
MCP2Out :=
MCP2StatSend :=
MCP2StatRec :=
MCP2BusAdr :=
MCP2Timeout :=
MCP2Cycl :=
MCPMPI := FALSE
MCP1Stop := FALSE
MCP2Stop :=
MCP1NotSend := FALSE
MCP2NotSend :=
MCPSDB210 :=
MCPCopyDB77 :=
MCPBusType := B#16#05 // Parameter [5] := ETHERNET
```
OB100

BHG :=
BHGIn :=
BHGOut :=

...

UDInt :=
UDHex :=
UDReal :=
IdentMcpType :=
IdentMcpLengthIn :=
IdentMcpLengthOut:=
//Insert User program from here
...

Result

You have completed the configuration of the PLC base program. In the next step, you will load the project to the PLC.

An example for the connection via PROFIBUS DP can be found at: Modifying PROFIBUS machine control panel in OB100 (Page 64)

Machine control panel with handwheel

If you have an Ethernet machine control panel with Ethernet handwheel, you must set the following machine data for the handwheel:

MD11350[0] $MN_HANDWHEEL_SEGMENT = 7Ethernet

The following are true for a PROFINET machine control panel with handwheel:

MD11350[0] = 5 PROFIBUS/PROFINET
5.5 Download the project to the PLC

Introduction

For loading the configured PLC project, the following prerequisites must be fulfilled:

Precondition

- An Ethernet network connection exists between STEP7 and the PLC.
- The configuration to be loaded corresponds to the actual station configuration.
- The NCU is active:
  - NC is in cyclic mode.
  - PLC in RUN or STOP mode.

Supplementary condition

The following supplementary conditions regarding the system data blocks must be observed when the configuration is loaded:

- HW Config
  When loading the configuration via HW Config, only the system modules and their associated system data blocks selected in HW Config are loaded into the module. However, global data defined in SDB 210 is not loaded from the HW Config, for example. You have loaded the HW Config to the module in the previous "End the hardware configuration and load to the PLC" chapter.

- SIMATIC Manager
  When loading the configuration via the SIMATIC Manager all the system data blocks are loaded into the module.

Note

When the PLC program is loaded in the "RUN" mode, each block loaded becomes active immediately. This can result in inconsistencies when executing the active PLC program. It is therefore advised to place the PLC in the "STOP" mode before loading the configuration, if this has not already been done.
Operating sequence for loading system blocks into the module

1. To load the configuration of the system blocks change to the SIMATIC Manager.

2. In the SIMATIC Manager in the PLC directory, select the directory "Blocks" > right mouse button > "Target system" > "Load" (see figure below), or the "Load" symbol.

3. If there is no connection to the target system, you must confirm in sequence the following dialog requests with:
   - "OK" for "Check the required sequence of blocks for correct functioning"
   - "Yes" for "Do you want to load system data?"
   - "Yes" for "Must system data be deleted on the module and replaced by off-line system data?"
   - "No" for "The module is in STOP mode. Do you want to start the module (cold restart)?"

You have loaded the PLC program to the PLC; the PLC is in "STOP" mode.

Note

If the PLC is stopped via the SIMATIC Manager, then it also has to be started via the SIMATIC Manager. Starting via the PLC mode selector is also possible.
5.6 Loading PLC symbols to the controller

Requirements

You require the SIMATIC STEP 7 software and the "PLC Symbols Generator" program that is provided in the toolbox.

For blocks that already have a symbolic name, these symbols cannot be overwritten by other user-defined designations. Only those symbols are transferred from the blocks to the control without preassigned symbols.

Generating PLC symbols

To edit PLC blocks via symbolic names, you can generate the symbols of the STEP 7 project for SINUMERIK Operate and store them on the CompactFlash card on the control.

Procedure:

1. Open the "PLC Symbols Generator" program and navigate to the corresponding PLC project.
2. To start the generation, first select the required language.
3. Save the "PlcSym.snh" and "PlcSym_xx.snt" files. xx is the language code specified when creating the file. The generation is then started.
4. Create the following directory on the CompactFlash card and store the generated files (PlcSym_xx.snt, PlcSym.snh) under the following path: /oem/sinumerik/plc/symbols
   This path also applies for SINUMERIK Operate on the PCU 50.
5. After restarting SINUMERIK Operate, the symbol tables are loaded when booting. Select the "Insert variables" softkey to display the imported symbols in the table of the "NC/PLC variables".

Note

The notation (upper/lower case) of the file name that the program created is mandatory and must not be changed.

Transmission log

For the generation and transmission of the symbols, a transmission log is created and stored under the following path: ../log/symbolimport.log

Example:

...  
   Error importing PLC symbols: skip vdi on 840d: Symbol number 16956  
   ...

5.7 First commissioning of the PLC completed

First commissioning of the PLC completed

To synchronize the PLC and NC, an NC reset (po) is required.

The PLC and NC are in the following state after a reset (po):

- RUN LED is continuously lit green.
- Status display shows a "6" with a flashing dot.
  ⇒ PLC and NC are in cyclic operation.

You have completed the first commissioning of the PLC.

Continue with the steps for "Guided commissioning (Page 113)" of the SINAMICS drives.

You start with a reset (po) for the NC and drive system.

---

Note

Response of the PLC in the case of an NC stop

For a stop of the NC, the PLC normally continues to run and the type of stop response is the user's responsibility depending on the machine situation. In this special case, the NC can no longer switch the outputs to zero and the current status is retained because the PLC is still running.

In order to switch off the outputs or to force a PLC stop, for example, the "NC READY" signal is evaluated in the PLC program.
5.8 Configuring a network (NetPro) for PG/PC

5.8.1 Integrating PG/PC into NetPro

Requirements

The following requirements for integrating a PG/PC must be met:

- The NCU is integrated in the S7 project using HW Config (see: Inserting SINUMERIK NCU to the HW Config (Page 53)).
- The properties of the interfaces are configured (see: Configuring interfaces (Page 56)).
- The machine control panel is inserted (see: Modifying machine control panel in OB100 (Page 89)).
- The configuration has been saved and compiled (see: End the hardware configuration and load it to the PLC (Page 69)).
- A PLC program has been created.

Inserting PG/PC in the S7 project

To perform routing functions and permit the communication between PG/PC ↔ HMI via Ethernet, a PG/PC must be included in the SIMATIC Manager under NetPro and the interfaces configured.
Procedure:
1. To add a PG/PC, open the S7 project in the SIMATIC Manager.
2. In the menu, select "Extras" → "Configure net" or click the button.
3. Insert the PG/PC with drag&drop under "Stations" from the catalog into the network configuration.

The inserted "PG/PC" station does not yet contain any interfaces. These are configured in the next step.

5.8.2 Configuration of the PG/PC interface

Introduction
Under NetPro, configure the interfaces required for commissioning on the PG/PC:
- PROFIBUS
- Industrial Ethernet
- PROFINET
- MPI
Configuring interfaces on the PG/PC

Procedure:
1. Mark the symbol "PG/PC" under NetPro.
2. Select "Object properties" <right-click>.
3. In the displayed "Properties - PG/PC" dialog, select the "Interfaces" tab to configure the required interfaces.

Example: Configuring Industrial Ethernet

Procedure:
1. Click "New…" to first configure the Ethernet interface.
2. In the selection field, select "Industrial Ethernet".
3. Click "OK".

CNC Commissioning: NC, PLC, Drive
Commissioning Manual, 12/2019, A5E48312804B AA
4. Select the subnet "Ethernet(1)" and enter the following IP address and subnet mask for the PG/PC:
   - IP address 192.168.215.2
   - Subnet mask 255.255.255.224

5. Deactivate the option "Set MAC address/Use ISO protocol" and confirm with "OK".

6. You can configure additional interfaces via "New".
   All configured interfaces can then be viewed under the "Interface" tab:

The configured interfaces must be assigned in a device-specific manner to the available hardware interfaces on the PG/PC. The sequence steps are laid out in the following section.
5.8.3 Assigning interfaces

Introduction

The interfaces configured in the previous chapter must now be assigned in a device-specific manner to the available hardware interfaces on the PG/PC.

Operating sequence for assigning an Ethernet interface

1. Select the "Assign" tab.
2. Select "Ethernet interface(1)" in the selection field "Configured interfaces".
3. Select in the "Interface parameter assignments in the PG/PC" selection field, the "TCP/IP - Realtek RTL8139/810xF..." network card installed on the PG/PC.
4. To transfer the interfaces from the "Not assigned" area to the "Assigned" area and activate them, click "Assign" and confirm the subsequent prompt on editing the object properties with "OK".
5. Now assign the remaining configured PROFIBUS interfaces. From those interfaces assigned, one must be marked as "active".

6. Select "Ethernet interface" in the "Assigned" field and mark the field next to it as "active".

7. Click "OK" to end the "Properties - PG/PC" dialog. In NetPro, the PG/PC interface declared as "active" has a yellow background.

8. Select "Save and compile → Save and check all" and confirm the process with "OK".

The next described operating sequence explains how to load this hardware configuration to the NCU.

5.8.4 Loading the HW config to NCU

Introduction

The newly created network configuration PG/PC must be introduced to the NCU.

You have established a connection to the Ethernet interface (X120 or X127) and you now load this configuration from the PG/PC to the NCU.
Operating sequence for loading HW config to the NCU

1. Change from "NetPro" to "HW Config".
2. Click the "Download to module" button.
   The two communication partners are automatically marked in the "Select target module" dialog
3. Confirm the load into the module with "OK".
4. Confirm the following dialog boxes initially with "OK" and then "No" for the query "… Should the module be started now (restart)?".

Note

Loading the HW config to the NCU is only possible via the Ethernet interface.
5.8 Configuring a network (NetPro) for PG/PC
6.1 Configuration examples

6.1.1 Example: Configuration of the drive components

Configuration overview

The commissioning described in this manual is orientated on the following example configuration of the SINAMICS drive line-up.

- Infeed (Active Line Module)
- NCU 720.3 PN with:
  - A Double Motor Module for two motors each with an SMC20 (Sensor Module Cabinet).
  - A Single Motor Module for a motor with two SMC20s for the encoders.
- NX 15.3 with:
  - A Single Motor Module for a motor with SMI (Sensor Module Integrated)
Additional information about DRIVE-CLiQ components of the SINAMICS drive line-up is provided in:

6.1.2 Example: Parallel connection with TM120

Topology

Application: Four motors connected in parallel

M1 ... M4 Motor 1 ... motor 4
One KTY and three PTC in series are connected for each motor.

SMx Sensor Module (motor encoder)
ALM Active Line Module
DMM Double Motor Module
SMM Single Motor Module
TM120 Terminal Module

The shown topology requires four KTY sensors and four PTC sensors:

- Each primary section has one KTY sensor (Temp-F) and three series-connected PTC sensors (Temp-S).

Two TM120s are required:

- A TM120 is interconnected automatically in series between the Motor Module and the SMx Sensor Module.
- A TM120 is directly inserted into a Line Module: This requires a manual interconnection by the commissioning engineer.
Actions

Depending on the topology, the following actions must be performed on the TM120:

1. **TM120 between the Motor Module and the SMx Sensor Module**
   This TM120 evaluates four KTYs => sensor types must be selected by Servo-p4610/TM-p4100. The associated temperature is output by servo-r4620/TM120-r4105.

2. **TM120 directly on the Line Module**
   This TM120 evaluates four PTCs => sensor types must be selected by TM-p4100. The associated temperature is output by servo-r4105.
   Setting the threshold values in the PTC context:
   - TM120-p4102[x]=251 => evaluation Off
   - TM120-p4102[x]=120 => evaluation On
   Assignment of the TM120 response using fault propagation on the drive => setting of the propagation by servo-p0609=BICO:<object number>TM120:4105.0

Assignment of the alarms to the motor

The occurring error messages are assigned to the motors as follows:

- Temperature channel on the TM120 in series connection with Motor Modules and encoders:
  - **Alarm 207015** <location>drive: Motor temperature sensor warning
  - **Alarm 207016** <location>drive: Motor temperature sensor fault
  - **Alarm 235920** <location>TM: Temperature sensor channel 0 error
  In this case, the output message with reference to the motor and to the temperature component shows the relevant motor.

- Temperature channel on the TM120 directly to the Line Module:
  - **Alarm 235207** <location>TM: Temperature fault/alarm threshold channel 0 exceeded
  Special feature with PTC:
    - TM120-r4105 = -50 temperature is below the nominal response temperature
    - TM120-r4105 = 250 temperature is above the nominal response temperature
  In this case, a message is output only with reference to the temperature component.
  The affected motor can be determined from the information concerning the TM120.
6.2 Terminal assignment

6.2.1 NCU terminal assignment

With the drive device configuration, the following terminals are pre-assigned on the NCU:

- X122
- X132
- X142

The terminal assignments for terminal strips X122, X132, X142 are listed in the following tables.

6.2.2 X122 terminal assignment

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal name</th>
<th>Function</th>
<th>Pre-assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X122.1</td>
<td>DI 0</td>
<td>Input ON/OFF 1 infeed (if one infeed with a DRIVE-CLiQ connection is operated at the NCU)</td>
<td>x</td>
</tr>
</tbody>
</table>
| X122.2   | DI 1        | Input 2. Operating condition OFF3 drives "OFF3 rapid stop"
Braking with a configurable OFF3 ramp (p1135, p1136, p1137); thereafter, pulse suppression and switching on inhibited. The drive stops controlled. The braking response can be set separately for each SERVO. | x               |
| X122.3   | DI 2        | Selection safe standstill group 1
SH/SBC - Group 1 SINAMICS Safety Integrated (SH = p9601 release) | ---             |
| X122.4   | DI 3        | Selection safe standstill group 2
SH/SBC - Group 2 SINAMICS Safety Integrated (SH = p9601 release) | ---             |
### 6.2 Terminal assignment

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal name</th>
<th>Function</th>
<th>Pre-assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X122.5</td>
<td>DI16</td>
<td>Freely available</td>
<td>---</td>
</tr>
<tr>
<td>X122.6</td>
<td>DI17</td>
<td>Freely available</td>
<td>---</td>
</tr>
<tr>
<td>X122.7</td>
<td></td>
<td>Ground for terminals 1...6</td>
<td>---</td>
</tr>
<tr>
<td>X122.8</td>
<td></td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td>---</td>
</tr>
<tr>
<td>X122.9</td>
<td>DI/DO 8</td>
<td>Status safe standstill group 1 SH/SBC - Group 1 SINAMICS Safety Integrated</td>
<td>---</td>
</tr>
<tr>
<td>X122.10</td>
<td>DI/DO 9</td>
<td>Status safe standstill group 2 SH/SBC - Group 2 SINAMICS Safety Integrated</td>
<td>---</td>
</tr>
<tr>
<td>X122.11</td>
<td></td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td>---</td>
</tr>
<tr>
<td>X122.12</td>
<td>DI/DO 10</td>
<td>Input, external zero mark - BERO 1</td>
<td>---</td>
</tr>
<tr>
<td>X122.13</td>
<td>DI/DO 11</td>
<td>Input probe 1 - central measurement (Check that MD13210 = 0)</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input probe 1 - distributed measurement (Check that MD13210 = 1)</td>
<td>---</td>
</tr>
<tr>
<td>X122.14</td>
<td></td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td>---</td>
</tr>
</tbody>
</table>

In the "pre-assignment" column, the signals for which the associated SINAMICS parameters are set when configuring a SINAMICS device are marked with "x".

### 6.2.3 X132 terminal assignment

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal name</th>
<th>Function</th>
<th>Pre-assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X132.1</td>
<td>DI 4</td>
<td>Freely available</td>
<td>---</td>
</tr>
<tr>
<td>X132.2</td>
<td>DI 5</td>
<td>Freely available</td>
<td>---</td>
</tr>
<tr>
<td>X132.3</td>
<td>DI 6</td>
<td>Freely available</td>
<td>---</td>
</tr>
<tr>
<td>X132.4</td>
<td>DI 7</td>
<td>Infeed line contactor feedback signal (if one infeed is operated with a DRIVE-CLiQ connection at the NCU)</td>
<td>---</td>
</tr>
<tr>
<td>X132.5</td>
<td>DI20</td>
<td>Freely available</td>
<td>---</td>
</tr>
<tr>
<td>X132.6</td>
<td>DI21</td>
<td>Freely available</td>
<td>---</td>
</tr>
<tr>
<td>X132.7</td>
<td></td>
<td>Ground for terminals 1...6</td>
<td>---</td>
</tr>
<tr>
<td>X132.8</td>
<td></td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td>---</td>
</tr>
<tr>
<td>X132.9</td>
<td>DI/DO 12</td>
<td>Output: Infeed operation (if one infeed is operated with a DRIVE-CLiQ connection at the NCU)</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input 2. Operating condition OFF2 drives</td>
<td>---</td>
</tr>
<tr>
<td>X132.10</td>
<td>DI/DO 13</td>
<td>Output: Status. infeed ready to start (if one infeed is operated at the NCU with a DRIVE-CLiQ connection)</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input 2. Operating condition OFF2 drives</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input, external zero mark 2</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input probe 2 - central measurement</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input probe 2 - distributed measurement</td>
<td>---</td>
</tr>
</tbody>
</table>
### 6.2 Terminal assignment

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal name</th>
<th>Function</th>
<th>Pre-assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X132.11</td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X132.12</td>
<td>DI/DO 14</td>
<td>Input 2. Operating condition OFF2 drives</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input, external zero mark 3</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input probe 2 - central measurement</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input probe 2 - distributed measurement</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Infeed, control line contactor</td>
<td>---</td>
</tr>
<tr>
<td>X132.13</td>
<td>DI/DO 15</td>
<td>Input 2. Operating condition OFF2 drives</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input, external zero mark 4</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input probe 2 - central measurement</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input probe 2 - distributed measurement</td>
<td>---</td>
</tr>
<tr>
<td>X132.14</td>
<td>Ground for terminals 9, 10, 12, 13</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the "pre-assigned" column, the signals for which the associated SINAMICS parameters are set when configuring a SINAMICS device are marked with "x".

#### 6.2.4 X142 terminal assignment

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Signal name</th>
<th>Function</th>
<th>Pre-assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X142.1</td>
<td>---</td>
<td>Reserved</td>
<td>---</td>
</tr>
<tr>
<td>X142.2</td>
<td>---</td>
<td>Reserved</td>
<td>---</td>
</tr>
<tr>
<td>X142.3</td>
<td>DI0</td>
<td>NC input</td>
<td>$A_IN[1]$</td>
</tr>
<tr>
<td>X142.4</td>
<td>DI1</td>
<td>NC input</td>
<td>$A_IN[2]$</td>
</tr>
<tr>
<td>X142.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X142.6</td>
<td>DI2</td>
<td>NC input</td>
<td>$A_IN[3]$</td>
</tr>
<tr>
<td>X142.7</td>
<td>DI3</td>
<td>NC input</td>
<td>$A_IN[4]$</td>
</tr>
<tr>
<td>X142.8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X142.9</td>
<td>DO4</td>
<td>NC output</td>
<td>$A_OUT[1]$</td>
</tr>
<tr>
<td>X142.10</td>
<td>DO5</td>
<td>NC output</td>
<td>$A_OUT[2]$</td>
</tr>
<tr>
<td>X142.11</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>X142.12</td>
<td>DO6</td>
<td>NC output</td>
<td>$A_OUT[3]$</td>
</tr>
<tr>
<td>X142.13</td>
<td>DO7</td>
<td>NC output</td>
<td>$A_OUT[4]$</td>
</tr>
<tr>
<td>X142.14</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### 6.2.5 Terminal assignment NX1x.3

The table lists the assignments of the terminals on an NX1x.3 for the X122 terminal strip.
The SINAMICS device configuration sets the following preassignment:

<table>
<thead>
<tr>
<th>Number</th>
<th>Function</th>
<th>Signal</th>
<th>Pre-assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X122.1</td>
<td>DI 0</td>
<td>Input ON/OFF 1 infeed (if one infeed with a DRIVE-CLiQ connection is operated at the NX)</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input infeed operation - &quot;infeed ready signal&quot; (if no infeed with DRIVE-CLiQ connection is operated at the NX)</td>
<td>x</td>
</tr>
<tr>
<td>X122.2</td>
<td>DI 1</td>
<td>Input 2. Operating condition OFF3 drives</td>
<td>x</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Freely available</td>
<td>--</td>
</tr>
<tr>
<td>X122.3</td>
<td>DI 2</td>
<td>Selection safe standstill group 1</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SH/SBC - Group 1 SINAMICS Safety Integrated (SH = p9601 release)</td>
<td>--</td>
</tr>
<tr>
<td>X122.4</td>
<td>DI 3</td>
<td>Selection safe standstill group 2</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SH/SBC - Group 2 SINAMICS Safety Integrated (SH = p9601 release)</td>
<td>--</td>
</tr>
<tr>
<td>X122.5</td>
<td>DI 16</td>
<td>Freely available</td>
<td>--</td>
</tr>
<tr>
<td>X122.6</td>
<td>DI 17</td>
<td>Freely available</td>
<td>--</td>
</tr>
<tr>
<td>X122.7</td>
<td></td>
<td>Reference potential for terminals 1…6</td>
<td></td>
</tr>
<tr>
<td>X122.8</td>
<td></td>
<td>Mass</td>
<td></td>
</tr>
<tr>
<td>X122.9</td>
<td>DI/DO 8</td>
<td>Status safe standstill group 1</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SH/SBC - Group 1 SINAMICS Safety Integrated</td>
<td></td>
</tr>
<tr>
<td>X122.10</td>
<td>DI/DO 9</td>
<td>Status safe standstill group 2</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SH/SBC - Group 2 SINAMICS Safety Integrated</td>
<td></td>
</tr>
<tr>
<td>X122.11</td>
<td></td>
<td>Mass</td>
<td></td>
</tr>
<tr>
<td>X122.12</td>
<td>DI/DO 10</td>
<td>Input, external zero mark - BERO 1</td>
<td>--</td>
</tr>
<tr>
<td>X122.13</td>
<td>DI/DO 11</td>
<td>Input, external zero mark 2/1</td>
<td>--</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Input 2. Operating condition OFF2 drives</td>
<td>--</td>
</tr>
</tbody>
</table>

Those signals for which the associated SINAMICS parameters are set for the SINAMICS device configuration are marked with "x" in the "Pre-assigned" column.

### 6.2.6 Support for the terminal assignment

**Support for terminal assignment**

The following overview shows the terminal assignment of those drive units (NCU, NX) involved in the SINAMICS drive line-up.

"Commissioning" → "Drive system" → "Drive units" → "Inputs/outputs" operating area:
6.2.7 BICO interconnections

**Introduction**

Each drive unit contains a large number of input and output variables as well as internal control variables. BICO technology (binector connector technology) allows the drive to be adapted to a wide variety of conditions.

Digital and analog signals, which can be interconnected as required by means of BICO parameters, are identified by the prefix BI, BO, CI, or CO in their parameter name. These parameters are identified accordingly in the parameter list or in the function diagrams:

- Binectors (digital): BI: Binector input, BO: Binector output
- Connectors (analog): CI: Connector input, CO: Connector output

To interconnect two signals, a BICO input parameter (signal sink) must be assigned to the required BICO output parameter (signal source).
Representation on the control

The following dialog provides support for the BICO interconnection of the components on the SINAMICS drive line-up:

```
<table>
<thead>
<tr>
<th>Source</th>
<th>0/1</th>
<th>Source input (signal sink)</th>
</tr>
</thead>
<tbody>
<tr>
<td>r2898: B: IF1 PROFIdrive P2D1 receive bit-serial, bit 0</td>
<td>0</td>
<td>p791: B: Control measuring probe synchronizing signal...</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p738: B: CU signal source for terminal DI/DO 8</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p739: B: CU signal source for terminal DI/DO 9</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p748: B: CU signal source for terminal DI/DO 10</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p741: B: CU signal source for terminal DI/DO 11</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p742: B: CU signal source for terminal DI/DO 12</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p743: B: CU signal source for terminal DI/DO 13</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p744: B: CU signal source for terminal DI/DO 14</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p745: B: CU signal source for terminal DI/DO 15</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p2608: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p2609: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p2610: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>r722: 11: CU digital inputs status, DI/DO 11 (X122.13/X121.11)</td>
<td>0</td>
<td>p2602: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>p2603: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>r2898: B: IF1 PROFIdrive P2D1 receive bit-serial, bit 7</td>
<td>0</td>
<td>p2604: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>r2898: B: IF1 PROFIdrive P2D1 receive bit-serial, bit 7</td>
<td>0</td>
<td>p2605: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>r505: B: Status word sequence control in, Ready for switching on</td>
<td>0</td>
<td>p2611: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>r505: B: Status word sequence control in, Ready for switching on</td>
<td>0</td>
<td>p2612: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>r505: B: Status word sequence control in, Ready for switching on</td>
<td>0</td>
<td>p2613: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>r505: B: Status word sequence control in, Ready for switching on</td>
<td>0</td>
<td>p2614: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
<tr>
<td>r505: B: Status word sequence control in, Ready for switching on</td>
<td>0</td>
<td>p2615: B: IF1 b Hein cos cer combertor estatus ...</td>
</tr>
</tbody>
</table>

Figure 6-3  Example: Interconnections

Additional information is provided in Chapter "Function diagrams" in the SINAMICS S120/S150 List Manual (https://support.industry.siemens.com/cs/ww/en/view/109763271)
6.3 Guided commissioning of SINAMICS drives

6.3.1 Initializing the system

System run-up

After the system has powered up, the "Machine" operating area is displayed:

![Machine operating area]

Alarm response

When loading the project, the PLC is brought into the STOP state. The NC interprets this STOP state, with a corresponding alarm response, as failure of the PLC. A “Reset (po)” is required for PLC-NC synchronization. The system responds with alarms. To output all alarms, switch to the "Diagnostics → Alarms" operating area. Additional support for the diagnostics of the drive system is provided in Chapter Diagnostics → drive system (Page 177).

Initializing the system

Procedure:

1. Press the <MENU SELECT> key to switch to the "Commissioning" operating area:

![Commissioning operating area]

The Commissioning operating area is displayed without password:

2. Press the "Password >" softkey and then the "Set password" softkey.
3. Enter the password for the "Manufacturer" access level and confirm this with "OK".

4. Press the "Reset (po)" softkey and confirm with "Yes".

The PLC then goes into the RUN state, and the commissioning of the SINAMICS drives is started with the device configuration.
6.3.2 Device configuration of the drive system

Automatic initial commissioning

Procedure:

1. After the complete drive system has run-up, a dialog box for automatic device configuration is displayed: "A device configuration must be performed for the drive system (all drive units)."

2. Select "OK" to start the automatic device configuration. The system topology is then automatically read-out. This operation can take several minutes.
   Alternative: Select "Cancel" to carry out manual commissioning (see: Manual commissioning of SINAMICS drives (Page 143)).

2. Select "OK" to start the automatic device configuration. The system topology is then automatically read-out. This operation can take several minutes.

Alternative: Select “Cancel” to carry out manual commissioning (see: Manual commissioning of SINAMICS drives (Page 143)).
3. The system then requests a Power-On Reset. Confirm with "Yes". This operation can take several minutes.

4. After the Power-On Reset, switch to the commissioning wizard for the infeed.

5. Confirm with "OK", the "Configuration" dialog box then appears.

**Note**

**Establish a defined initial state**

If the device configuration does not start automatically, device configuration has already been performed:

Load the "Factory settings" to create a defined state or restart. This restores a defined output state.
Configuration after initial commissioning

The "Configuration" dialog contains a list of the connected components of the selected drive unit:

Assignment of the components to the drive objects: For example the assignments of the Motor Modules, motors and encoders to the drive objects and their assignments to the NC machine axes (only after axis assignment).

6.3.3 Configuring the infeed

Configuring the infeed

The configuration is described using the example of a SINAMICS S120 Booksize Active Line Module (ALM).
Procedure:

1. Select "Change >" to configure the infeed:

   ![Image of infeed configuration](image1)

   - The characteristic data of the infeed detected by the automatic device configuration is displayed:

   - If you activate the "LED to flash for recognition" option, then the selected infeed will flash alternately red-green.

   - Select the filter type which is connected in front of the infeed from the list under "Line filter". If it is a filter with temperature monitoring (AIM = Active Interface Module), then this is automatically activated with the selection (default setting). This option must be activated if you have inserted a Basic Line Filter in front of the AIM to dampen the interference emission and RFI suppression.

2. The characteristic data of the infeed detected by the automatic device configuration is displayed:

   ![Image of infeed configuration](image2)

   - The following functions can also be activated:
     - If you activate the "LED to flash for recognition" option, then the selected infeed will flash alternately red-green.
     - Select the filter type which is connected in front of the infeed from the list under "Line filter". If it is a filter with temperature monitoring (AIM = Active Interface Module), then this is automatically activated with the selection (default setting). This option must be activated if you have inserted a Basic Line Filter in front of the AIM to dampen the interference emission and RFI suppression.
– This option is selected if a Voltage Sensing Module has been detected.

– If you activate the external brake control module option, the monitoring of the brake control module is activated. This requires the appropriate terminal wiring (parameter p3866 to terminal X21.4 for S120 Booksize,) to have been established, otherwise alarm 206900 is output.

– If you set the option “Activate external brake control module”, the function module for the brake control module is activated. This can be used to monitor the module. To do so, set the corresponding terminal wiring (e.g. parameter p3866 to terminal X21.4 for S120 Booksize), otherwise alarm 206900 is output. In addition, make a BICO interconnection from the infeed to the free terminals on the NCU. The parameters that must be connected for this purpose can be found in the function diagram for the brake control module in the SINAMICS S120 List Manual.
3. Select "Next step >".

The power data of the infeed is configured here:

- When the checkbox is selected, the line/DC link identification is activated once the infeed pulse enable has been activated (p3410). The infeed then switches to operational mode.

**Note**

**DC link identification**

If the line supply environment changes or the components on the DC link change (e.g. after setting up the equipment at the customer site or after expanding the drive group), the checkbox must be set again: Hence the "Power data" softkey in the overview in order to restart the line/DC link circuit identification.

If p3410 = 5 is saved in the commissioning archive, then the line/DC link identification starts automatically once the drive data is input into the archive.

Only then can it be guaranteed that the infeed operates with the optimum controller settings.

- Enter the device connection voltage: This is the basis for monitoring the line voltage (p0281 - p0283), whereby an alarm is triggered in the case of an overshoot or undershoot. (Alarm threshold and shutdown threshold). The actual line voltage is determined automatically and the adjustment is made based on this value.

- The actual line frequency for the infeed is determined automatically.

- In parameters p0284, p0285, set a threshold above which an alarm is triggered (default setting of the monitoring: 45 Hz to 65 Hz).
4. Select “Next step >”.

Use a line contactor to ensure galvanic isolation of the drive line-up and the DC link from the line supply.

The checkbox for the infeed is selected by default. This means that the BICO interconnection (ON/OFF, both directions) is set with the initial commissioning in accordance with the default setting. Activate the checkbox in order to restore the default setting for the terminal wiring.

If you use an external line contactor in front of the infeed, you can control it automatically via SINAMICS. To do this, set the checkbox to activate the "SINAMICS internal line contactor control" function.

Control via the PLC is also possible as an alternative. The connection is made via the reserved terminals displayed.

- **X132.12**: Output terminal infeed for line contactor control
- **X132.4**: Input terminal infeed checkback line contactor

It is not possible to internally control the line contactor using a drive object on the NCU, as the line contactor must be controlled from an external PLC or hardware control.
5. Select "Next step >". All data with which the infeed has been configured is displayed in the summary:

Select the option save "Text in the ../A_INF_02.txt file".

6. Select "Finish >" to complete the infeed configuration.
7. Confirm with "OK ✓" to save the configuration data to a non-volatile memory.

8. Then the following overview (multiple pages) is displayed:
6.3.4 Configuration of two infeeds connected in parallel

Condition

The SINAMICS S120 supports the parallel connection of Line Modules under the following conditions:

- Same type
- Same type rating:
  Available for following Active Line Modules: 55, 80 and 120 kW
- Same rated voltage
- Same firmware version

The parallel connection of two Active Line Modules in booksize format must be supplied by a shared line connection and controlled synchronously by a shared Control Unit. The modules must not be connected to galvanically isolated lines.

Benefits

For space reasons, some applications require the use of Line Modules in booksize format, but the available performance range with a single booksize Line Module is insufficient for the application.

The parallel connection of booksize Active Line Modules offers the following advantages:

- Extension of the power range by higher S1 and maximum powers for S120 in booksize format
- Higher maximum prechargeable DC-link capacity up to 38 mF
- Only a shared DC link with energy exchange between all connected drives is required.
- Usable in Active Mode, Smart Mode and Extended Smart Mode of the infeed
- Commissioning is simple because no additional parameter assignment is required.
  - The commissioning engineer sees only a larger Active Line Module.
  - No additional effort is required for commissioning and data backup.
Topology

Select the "Commissioning" → softkey "Drive system" → softkey "Topology" operating area: The two Line Modules are represented in the topology view:

Infeeds connected in parallel

The system detects that the infeed has not yet been commissioned and that initial commissioning is required:

1. Press the "Change >" softkey to start the commissioning.

2. The data of the Line Module project data is read out and displayed. The two Active Line Modules connected in parallel can be recognized by the doubled rated power minus the derating factor of 5%.

Example for 2 x 55 kW: Rated power = 104.50 kW
3. Accept the default setting of the line data or adjust the data to the power supply conditions at the operating site.

4. Accept the default setting for the terminal wiring.

5. Check the configuration in the summary. Press the "Finish >" softkey to complete the commissioning.

You can also save the configuration data in a text file.

6. Confirm the prompt with "Yes" to save the data to non-volatile memory.

7. Select "Cancel" to display the overview of the infeed: The two infeeds connected in parallel are now commissioned.
Checking infeed parameters

You can check the setting of the following parameters with the "Machine data" → softkey "Infeed parameters":

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>p0108.15 = 1</td>
<td>Parallel connection of function module activated</td>
</tr>
<tr>
<td>r0200[0]</td>
<td>Current power unit code number of the first ALM</td>
</tr>
<tr>
<td>r0200[1]</td>
<td>Current power unit code number of the second ALM</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>r0204[0]</td>
<td>Power unit hardware properties of the first ALM</td>
</tr>
<tr>
<td>r0204[1]</td>
<td>Power unit hardware properties of the second ALM</td>
</tr>
<tr>
<td>r7000 = 2</td>
<td>Parallel connection, number of active power units</td>
</tr>
<tr>
<td>p7001[0] = 1</td>
<td>Parallel connection, enabling of power units</td>
</tr>
<tr>
<td>p7001[1] = 1</td>
<td>Parallel connection, enabling of power units</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
</tbody>
</table>

Further information can be found in:

- SINAMICS S120 Application example (https://support.industry.siemens.com/cs/ww/en/view/109759667) "Parallel connection Active Line Modules in booksize format"

6.3.5 Configuring drive components

Introduction

The following components are parameterize/configured with the drive wizard:

- Motor
- Encoder
- Interface signals

Parameterizing/configuring

Guided commissioning navigates you through the commissioning of SINAMICS drives with motors without SMI (Sensor Module Integrated).
For motors without SMI, when parameterizing/configuring, a distinction is made between the following motor types:

- Catalog motors (standard motors, listed with associated motor data) (Page 129)
- Third-party motors (Page 135)

Note

Motors with SMI (DRIVE-CLiQ) are automatically configured by the drive unit during the device configuration with a drive data set (DDS), but only with the motor measuring system; i.e. motors with SMI only have to be configured with the drive wizard when more than one drive/motor data set (DDS/MDS) or a second (direct) measuring system is required.
6.3.6 Commissioning catalog motors with encoder using SMC

Operating sequence

In our example a power section is to be configured with a listed motor and encoder. You are in the "Commissioning" → "Drive system" → "Drives" menu:

1. The system detects that the drive object has not been commissioned and that an initial commissioning is required:

   - The drive object has not been started up. You can commission the drive with 'Change'.

   | Drive object name (no.): | SERVO_3.3.3 (3) |
   | Drive object type:       | SERVO          |
   | Motor Data Set (MDS):    | 0              |
   | Drive data set (DDS):    | 0              |

2. Press the "Change" vertical softkey. The Motor Module type is detected and output. Activate the available function modules.

   - Switch the Motor Module LED to make it flash for recognition

   - Function modules:
     - DSC with spline
     - Advanced Positioning Control (APC)
     - Extended Stopping and Retraction
     - Moment of inertia estimator

<table>
<thead>
<tr>
<th>Type (order no.)</th>
<th>Rated output</th>
<th>Rated current</th>
<th>Code number</th>
</tr>
</thead>
<tbody>
<tr>
<td>6SL3120-1TE23-6ør</td>
<td>16.10 kW</td>
<td>39.00 A</td>
<td>10005</td>
</tr>
</tbody>
</table>

CNC Commissioning: NC, PLC, Drive
Commissioning Manual, 12/2019, A5E48312804B AA 129
3. Select the "Select standard motor from list" option.

4. Select the motor with the "Cursor up / Cursor down" keys.

5. Press "Next step >" to enter additional motor data in the "Configuring - Motor data" dialog:

If a connected brake is detected when the unit is being configured, the system will automatically activate the brake control and display the default setting "Motor holding brake acc. to sequence control".

"Brake control diagnostics evaluation": For an AC drive with "Safe Brake Relay," the "Safe Brake Control" function requires that the type of the brake control be set in parameter p1278, to "Brake control with diagnostic evaluation" (p1278 = 0). This parameter is automatically set for booksize components.

Information about the motor temperature sensor is provided in the FAQ (https://support.industry.siemens.com/cs/document/109736364).
6. Press "Next step >". An identification of the selected encoder is triggered (encoder 1).

The drive unit can identify encoders with EnDat protocol. These encoders are selected in the encoder list in the following dialogs ("Configuration - Encoder 1" menu).

The entry "No encoder" is selected in the encoder list for encoders that the drive unit cannot identify. The connected encoder must be configured.
7. Select the motor encoder from the list: Select the encoder with the "Cursor up / Cursor down" keys. Alternatively, the encoder system can be parameterized manually using the "Enter data" softkey.

8. Press "Enter data".

Check the encoder data of the connected encoder and confirm with "OK".

- Encoder type
- Incremental tracks
- Zero marks
- Synchronization
9. Press "Next step >".

10. Set the number of required drive data sets (DDS). The default setting is one drive data set.

11. You can change the settings for the control mode and the PROFIBUS telegram type. The control mode and the PROFIBUS telegram (Page 220) are generally correctly preassigned by the drive wizards.

12. Press "Next step >".

13. You can select the 2nd operating condition Input 2. OFF2 (external input for pulse cancellation).
14. Press "Next step >".

15. The configuration of a drive with listed motor has completed. You can check the configuration in the summary.

16. Press the "Finish >" softkey.

17. Confirm the query with "Yes".

18. The next section describes how you can configure a drive with a third-party motor and a second encoder.
6.3.7 Commissioning a third-party motor with encoder via SMC

Operating sequence

In our example a power section is to be configured with third-party motor and encoder. You are in the "Commissioning" → "Drive system" → "Drives" menu:

1. The system detects that the drive object has not been commissioned and that an initial commissioning is required:

   The drive object has not been started up.
   You can commission the drive with 'Change'.

   The drive object is identified:
   - Drive object name (ns.): SERUO_3.3.4 (4)
   - Drive object type: SERUO
   - Motor Data Set (MDS): 0
   - Drive data set (DDS): 0

2. Press the "Change" vertical softkey.
   The power section (motor module) will be identified:

   Switch the Motor Module LED to make it flash for recognition

   Function modules:
   - DSG with spline
   - Advanced Positioning Control (APC)
   - Extended Stopping and Retraction
   - Moment of inertia estimator
3. Press "Next step >".

4. Select the "Enter motor data" option to select the motor type.

5. Press "Next step >" to select the type of the brake control in the next dialog.

If a connected brake is detected during the unit configuration, the system will automatically activate the brake control and displays "Brake control according to procedural control".
6. Press "Next step >".

7. Enter the data for the connected motor.

8. If you have activated the "Replacement circuit diagram data" option, press "Next step >" to open the following dialog:

9. You can enter additional motor data here.
10. Press "Next step >".

If more than one encoder has been selected, press "Next step >" successively to parameterize each individual encoder:

11. Press "Next step >".
12. Press "Next step >". An identification of the selected encoders is triggered (Encoder 1). The drive unit can identify encoders with EnDat protocol. Select other encoders in the encoder list:

Select a motor encoder

<table>
<thead>
<tr>
<th>Encoder type</th>
<th>Code number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ktn Dbber</td>
<td>0</td>
</tr>
<tr>
<td>Resolver 1-Speed</td>
<td>1001</td>
</tr>
<tr>
<td>Resolver 2-Speed</td>
<td>1002</td>
</tr>
<tr>
<td>Resolver 3-Speed</td>
<td>1003</td>
</tr>
<tr>
<td>Resolver 4-Speed</td>
<td>1004</td>
</tr>
<tr>
<td>2048, 1 Upp, A/B G/D R</td>
<td>2001</td>
</tr>
<tr>
<td>2048, 1 Upp, A/B G/D R</td>
<td>2002</td>
</tr>
<tr>
<td>256, 1 Upp, A/B R</td>
<td>2003</td>
</tr>
<tr>
<td>1488, 1 Upp, A/B R</td>
<td>2004</td>
</tr>
<tr>
<td>152, 1 Upp, A/B R</td>
<td>2005</td>
</tr>
</tbody>
</table>

Select "Identify", so that the drive unit identifies the connected encoder. This is conditional upon the encoder supporting the drive unit.

13. Press the "Input data" softkey to check or modify the encoder data.
14. Confirm with "OK" and press "Next step >" to continue the commissioning.

The control mode and the PROFIBUS telegram are generally correctly pre-assigned by the drive wizards.

15. Set the number of required drive data sets (DDS). The default setting: 1 DDS can be accepted in most cases.

16. Press "Next step >".

The PROFIBUS process data are interconnected with BICO parameters according to the telegram type selected. These BICO parameters cannot be changed at a later stage.

You can select the 2nd Operating condition input 2nd OFF2 (external input for pulse cancellation).
17. Press "Next step >".

The configuration of the drive (SERVO) with third-party motor is completed. You can check the configuration in the summary.

18. Press the "Finish >" softkey.

The configuration of the drive (SERVO) with third-party motor has been completed. The data must be stored in a non-volatile manner for the configuration of drive SERVO_3.3.4 to be retained after a restart.

19. Confirm the query with "Yes".

If the system detects additional drive objects that have not yet been commissioned, you will be prompted to commission the next SERVO. Otherwise, the initial commissioning is complete.
6.3.8 First commissioning of SINAMICS drive ended

Initial commissioning of the drives completed

The initial commissioning of the SINAMICS S120 drives is completed. The unit configuration and parameterization has been completed successfully:

- All upper LEDs of the drives (SERVO) illuminate green.
- The lower LEDs of the drives (SERVO) always continue to light yellow.

Continue with the steps for commissioning the NC.

See also

Communication between the NC and the drive (Page 215)
6.4 Manual commissioning of SINAMICS drives

6.4.1 Introduction to commissioning of SINAMICS drives

Machine configuration

Note

"Manually commissioning" is recommended for experienced commissioning engineers.
Procedure:

1. Press the <MENU SELECT> key.

2. Select the "Commissioning" operating area.

3. Press the "Drive system" softkey.
See also

The following functions for commissioning the SINAMICS drives can be performed manually:

- Restore the factory settings (Page 145)
- Update the component firmware (Page 147)
- Configure the infeed and drives
- Check and configure the PROFIBUS connection (Page 149)

6.4.2 Activate the factory settings

Introduction

After the commissioning, the "Factory setting >" function can be used to reset the drive system to the factory settings.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check the voltage</td>
</tr>
</tbody>
</table>

Before restoring the factory settings, ensure that the EP terminal (Enable Pulses) of the infeed (booksize: X21, chassis: X41) is de-energized.
Loading the factory settings

Procedure:

1. You are in the "Commissioning" > "Drive system" operating area.

2. Press the "Factory settings >" softkey.

3. Press the "Drive system" softkey for this example to load the factory settings for all drive units used in the system (the NCU and NX module).
   You must explicitly confirm another prompt with "OK" or "Cancel".
4. Switch the system (de-energized drive system) off and on again. Wait until communication has been established again with the NC.

5. A message appears that an initial commissioning is required (Alarm 120402). You have the following options in this dialog:

- If you press "OK", the "Guided commissioning" (Page 113) of the SINAMICS drives starts.
- Press "Cancel" to continue the "Manual commissioning".

6.4.3 Firmware update of the drive components

**Precondition**

All NCU/NX components are connected via DRIVE-CLiQ.

**Note**

**Automatic firmware update**

As of SINAMICS V2.5, an automatic firmware update is undertaken when powering up the drive system if required.

The correct firmware update of the SINAMICS components is performed ONLY if ALL were inserted in the switched-off state. The subsequent insertion of components may ONLY be performed in the switched-off state.
Loading firmware for the entire drive system

Procedure:

1. Switch on the system.
   During run-up, it will be detected that an older firmware version is present. This causes the update to start automatically and the firmware is loaded from the CompactFlash card to all DRIVE-CLiQ components of the drive system (NCU and NX).

   **Note**
   Depending on the configuration of the SINAMICS drive line-up, a complete update of the component firmware takes approximately 10 minutes. The firmware component currently being updated is indicated with a flashing LED.

2. While the firmware update is running, a progress bar informs you about the current process. In this case, the following messages are output:
   **Notice**
   The process should not be interrupted! Please wait until the automatic firmware update completes!
   A firmware update is performed for the following drive units of the DRIVE-CLiQ components:
   - CU_I_3.3:1 ... 39%
   - CU_NX_3.15:1 ... 50%

3. The following messages are output when the firmware update completes:
   **Firmware update of the DRIVE-CLiQ components completed.**
   **Notice**
   Switch the control system and the entire drive system (all hardware components) off and then on again to activate the firmware.
   Then commissioning can be continued.
   - CU_I_3.3:1 ... 100%
   - CU_NX_3.15:1 ... 100%

4. Follow this prompt. You can then continue the commissioning of the drive components (infeed, motor modules, encoders).

   **Note**
   **Loading firmware for individual components**
   If only certain components of the drive system have an older firmware version, the update also starts automatically and needs correspondingly less time.
6.4.4 Automatic device configuration

Introduction

The following unit configuration is performed during the initial commissioning of the drive units:

- Transfer of the DRIVE-CLiQ topology to the drive unit. With the transfer of the topology, all components connected on the DRIVE-CLiQ are detected and the drive-internal data traffic is initialized.
- Drive-object assignment for PROFIBUS connection. The PROFIBUS connection via the relevant telegrams has been specified with the configuration in the HW Config.

Operating sequence

The drive unit is in the initial commissioning state.

1. Press the "Drive units" softkey in the "Commissioning" > "Drive system" menu. To start the device configuration for the drive system, confirm the question with "OK ✓".

2. During the unit configuration, a succession of messages containing information on the configuration of the individual drive components are displayed. This procedure depends on the expansion stage of the drive system and can take several minutes.
3. Confirm the following prompt with "Yes ✓" in order to read in the configuration data of the drive units into the NC with a power on.

4. The unit configuration for the drive units and drive components of the NCU has been completed.
5. Confirm with "OK ✓" to continue commissioning in the actual dialog "Drive system" → "Drive units" → "Configuration". The associated components of the selected drive unit are displayed:

<table>
<thead>
<tr>
<th>Drives</th>
<th>Drive unit type</th>
<th>Slot</th>
<th>SINAMICS Drive object</th>
<th>SINAMICS telegram type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXB1:1</td>
<td>Siemens 130</td>
<td>6/80</td>
<td>SERVO, 3.3:30</td>
<td>Siemens 130</td>
</tr>
<tr>
<td>AXB1:1</td>
<td>--</td>
<td>8</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>AXB1:2</td>
<td>--</td>
<td>12</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>AXB1:3</td>
<td>--</td>
<td>18</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>AXB1:4</td>
<td>--</td>
<td>24</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

6. Press "Drive unit +". If you have selected the NX, then the components belonging to the NX are displayed.
7. If you wish to correct or change the settings in the "PROFIBUS" dialog, then press "PROFIBUS" → "Change >".

8. Press the menu back key to return to the "Drive system overview":

![Drive System Overview](image)

<table>
<thead>
<tr>
<th>Axis</th>
<th>Bus</th>
<th>Address</th>
<th>Drive Object Name</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>3</td>
<td>CUI_1.3.3.1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ALM_3.3.2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SERVO_3.3.3</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SERVO_3.3.4</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SERVO_3.3.5</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SERVO_3.3.6</td>
<td>6</td>
</tr>
<tr>
<td>3</td>
<td>15</td>
<td>CUI_NK_3.15.1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SERVO_3.15.2</td>
<td>2</td>
</tr>
</tbody>
</table>
6.4.5 Commissioning using a drive wizard

Introduction

Perform the drive configuration with a drive wizard. The following drive components are to be configured:

- Active Line Module (infeed)
- Motor Module, motor and encoders (drives)

Operating sequence for drive configuration

To start the drive configuration, select the "Commissioning" → "Drive system" operating area:

Procedure:

1. Press the corresponding softkey for the drive object to be configured.
   - "Infeeds"
   - "Drives" for the corresponding drive object (SERVO)
   
   Configuration is performed in the following sequence:

2. Select the component with the "Infeed+/Infeed-" or "Drive+/Drive-" vertical softkey.

3. Press the "Change >" softkey and follow the configuration steps of the drive wizard.

4. Check the power data of the infeed. (Page 117)
6.5 Configuring data sets

6.5.1 Data sets - overview

Benefits

The data set wizard in SINUMERIK Operate offers the machine manufacturer a simple and efficient solution for duplicating and modifying data in order to configure the behavior of drives, motors and encoders:

- Motor data set → MDS0...3
- Drive data set → DDS0...31 (max. 8 per MDS)
- Encoder data sets → EDS0...2

Reusability of the data helps to minimize the configuration effort wherever machine data for the tuning of different components is to be generated, which is required for the synchronization of the machine dynamics of the individual components.

Data set Wizard

Precondition: The drive must already have undergone commissioning in order be able to create data sets.

The data sets are configured in the "Commissioning" → Drive system" → "Drives" → "Data sets" operating area. The data set wizard provide step-by-step guidance through the configuration:

- "Add data set"
- "Remove data set" if additional data sets have already been created.
- "Modify data set"


Boundary condition

Note

Drive parameters that affect data sets

Default setting p2038 = 0 for interface mode: SINAMICS

When a message frame is selected via p0922, the parameter p2038 influences the device-specific assignment of the bits in the control and status words.

For p0922 = 100 ... 199, p2038 = 1 is set automatically and the change of p2038 is blocked. This permanently sets the "SIMODRIVE 611U" Interface Mode with 8 DDS per MDS for these message frames.
6.5.2 Adding a data set

NC/PLC interface

The factory setting is a motor data set MDS0 with a drive data set DDS0. This logic is provided in the data set wizard in SINUMERIK Operate and corresponds with the first line:

<table>
<thead>
<tr>
<th>NC/PLC interface</th>
<th>MDS/DDS</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB31, ... DBX21.0 - 4</td>
<td>PLC → NC Selection</td>
</tr>
<tr>
<td>DB31, ... DBX93.0 - 4</td>
<td>NC → PLC Display</td>
</tr>
<tr>
<td>DB31, ... DBX130.0 - 4</td>
<td>NC → PLC Formatting</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SDS per MDS</th>
<th>Selection and display</th>
<th>Formatting</th>
</tr>
</thead>
<tbody>
<tr>
<td>MDS</td>
<td>4 3 2 1 0</td>
<td>4 3 2 1 0</td>
</tr>
<tr>
<td>1 1 1</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>2 2 1</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>3 3 1</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>4 4 1</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>5 8 1</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>6 16 1</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>7 32 1</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>8 1 2</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>9 2 2</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>10 3 2</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>11 4 3</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>12 8 4</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>13 16 4</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>14 1 4</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>15 2 4</td>
<td>0 0 0 0 0</td>
<td></td>
</tr>
<tr>
<td>16 3 4</td>
<td>0 0 0 0 1</td>
<td></td>
</tr>
<tr>
<td>17 4 5</td>
<td>0 0 0 0 1</td>
<td></td>
</tr>
<tr>
<td>18 8 6</td>
<td>0 0 0 0 1</td>
<td></td>
</tr>
<tr>
<td>19 1 7</td>
<td>0 0 1 1 1</td>
<td></td>
</tr>
<tr>
<td>20 2 8</td>
<td>0 0 1 1 1</td>
<td></td>
</tr>
<tr>
<td>21 3 9</td>
<td>0 0 1 1 1</td>
<td></td>
</tr>
<tr>
<td>22 4 10</td>
<td>0 0 1 1 1</td>
<td></td>
</tr>
<tr>
<td>23 1 11</td>
<td>0 1 1 1 1</td>
<td></td>
</tr>
<tr>
<td>24 2 12</td>
<td>0 1 1 1 1</td>
<td></td>
</tr>
<tr>
<td>25 1 13</td>
<td>1 1 1 1 1</td>
<td></td>
</tr>
</tbody>
</table>

Blue Motor data set (MDS)

Yellow Drive data set (DDS)

Gray Invalid bit position
Example: Add a data set

Procedure:

1. Select "Add data set" to add 4 motor data sets with 1 drive data set respectively (line 4 highlighted in blue in the figure at the top):

2. After pressing "Add data set", you will be directed to Step 1 of the data set wizard. For "Number of MDS", select: 4.
3. Press "Next step >" to select the copy source for MDS0:

The data set wizard will guide you through the next steps.

4. The summary is displayed in the final step. Press "Finish >" to accept the changes.
5. Confirm with "OK" to save the data in non-volatile memory. Saving can take several minutes.

6. The "Drives" → "Overview" dialog of the drive object is displayed. The "Select MDS >" softkey is now available. Press "Select MDS...".

Result

The result is displayed in the "Service drive" overview:

- 4 DDS were created for each MDS.
- Following selection of the data set via PLC program, the selected data set for the drive object is displayed; in this example MDS2.
6.5.3 Remove data set

Precondition

The "Remove data set" softkey is active under the following conditions:

- Number of DDS > 1 in the MDS ⇒ DDS can be removed.
- Number of MDS > 1 ⇒ MDS can be removed.
Example: Remove a data set

**Procedure:**

1. Select the "Remove data set" softkey: In Step 1, select the number of DDS which are to be deleted for each MDS. In this example, 1 MDS.

2. In the next step, select the data set in the first column. Several data sets can also be selected.

3. The summary is displayed in the next step. Press "Finish >" to accept the changes.

When you exit the dialog, press "Yes" to confirm the prompt to save the data to the non-volatile memory.
**Result**

The result is displayed in the "Data set overview" dialog:

<table>
<thead>
<tr>
<th>MDS</th>
<th>Drive data sets (DDS)</th>
<th>Encoder1</th>
<th>Encoder2</th>
<th>Encoder3</th>
</tr>
</thead>
<tbody>
<tr>
<td>MDS0</td>
<td>0</td>
<td>EDS0</td>
<td>EDS1</td>
<td>none</td>
</tr>
<tr>
<td>MDS1</td>
<td>1</td>
<td>EDS0</td>
<td>EDS1</td>
<td>none</td>
</tr>
<tr>
<td>MDS2</td>
<td>2</td>
<td>EDS0</td>
<td>EDS1</td>
<td>none</td>
</tr>
</tbody>
</table>
6.5.4 Modify data set

Example: Modify data set

If more than one encoder is assigned to the drive object, one encoder data set is assigned to
each encoder. To change assignment of the data sets, select the "Modify data sets" softkey:

Open the selection menu with the <INSERT> key. The "OK" softkey will only become active for
adoption of the change after the assignment has actually been changed.
6.6 Diagnostics → Trace

6.6.1 Selecting variables for tracing

"Trace" function

The "Trace" function is an oscilloscope function that supports you when optimizing, troubleshooting and analyzing machines. When selecting the function in the operating area "Diagnostics" → Menu advance key → Softkey "Trace", the list view is opened to insert variables, whose signals are to be graphically displayed in the trace view.

A dedicated "Session type" should be used for the following variables:

- NC/PLC/servo variables
- Drive parameters

New session

Procedure:

1. Select "New trace (drive/NC) softkey >" to create a new session.
2. Selection for a session with PLC/NC/servo variables:

3. Selection for a session with drive variables:

Examples of traces sessions

Example of a trace session with servo variables (Page 164)

Using servo variables as example, the following procedure is shown:

- "Zoom (Page 167)" softkey including zoom with image section and zoom with mouse operation
- "Scale (Page 171)" softkey
- "Cursors (Page 172)" softkey
6.6.2 Example: Trace session with servo variables

Trace session sequence

The trace session is subdivided into the following steps:

- Creating and loading a part program.
- Creating a new session with servo variables.
- Settings for starting and stopping the trace.

Starting/stoping the trace from the part program

To start and stop the trace from the part program, program the $AN_SLTRACE variable that can be selected using the "Quicklist" softkey. To do this, the following program can be used, for example:

```python
def int ii
    SOFT
    $AN_SLTRACE=0
    G90 G1 X0 F10000
    G4 F0.5
    $AN_SLTRACE=1
    G91
    for ii=1 to 4
        X10
        G4 F0.5
        X-10
        G4 F0.5
    endfor
    $AN_SLTRACE=2
    M30
```

Save the program and load it to the NC.
Creating a new session

Procedure:

1. Select operating area “Diagnostics” → Menu forward key → “Trace” softkey. The list view opens:

2. Select softkey “Insert variable >” to open the list of variables.
3. Select at “Filter: Servo” to limit the selection to just servo variables.
4. The following servo variables are inserted in this particular example:
   - Position actual value measuring system 1
   - Position setpoint
   - Torque-generating current actual value $i(q)$

5. Using the “Settings” softkey, matching the example, select “If variable” to start the trace.
6. Softkey “Quick List” is activated. Select variable $AN_SLTRACE and acknowledge with "OK".

7. Matching the example, select "If variable" to stop the trace and acknowledge with "OK".

8. Select the "View trace >" softkey to open the trace view.

9. Select the "Start trace" softkey to activate the trace.

10. Execute the part program with "NC Start".
Trace result

The following graphic is displayed after the trace has been stopped:

Select the "≪ Back" softkey to save the session.
Select what you wish to save with the "Save trace >" softkey: Variables and settings with or without recorded values (graphic).

The name of the session and target directory can be changed.

6.6.3 Example: Zooming in/zooming out

Trace view: Zoom

Procedure:

1. Select the "Fit all" softkey to scale all of the curves.

2. Press the following keys to select curve 1 (position actual value measuring system 1) and curve 2 (position setpoint) for the next steps:

3. Select the "Zoom >" softkey.

4. Select the "Fit overlaid" softkey to precisely place both curves one above the other. Each curve is individually scaled using the "Fit separated".
5. Select the “Zoom +” softkey or the <+> softkey to enlarge the image section.

Using the cursor keys, you can move the image section:

6. You can undo the action using keys <CTRL> + <Z>:
Alternative: Zoom with image section

Procedure:

1. Select the "Zoom area >" softkey, to select a defined zoom area:

2. Select the "Zoom +" softkey or the <+> softkey to enlarge the image section.

3. Using the cursor keys, you can move the image section:
Alternative: Zoom using the mouse

Procedure:

1. While keeping the `<CTRL>` key pressed, using the left-hand mouse key, drag the section of the screen that you wish to zoom into:

   ![Image of zoom procedure step 1]

2. Zoom result after releasing the left-hand mouse key:

   ![Image of zoom procedure step 2]

3. You can undo the action using `<CTRL>` and the right-hand mouse key.

   ![Image of zoom procedure step 3]
6.6.4 Example: Changing the scale

Changing the scale

Procedure:

1. Select the "≪ Back" softkey to exit the zoom area.

2. Select the "Scale >" softkey to scale the graphic in the X and Y axes:

3. After selecting softkey "X time axis" → and softkey "Scale +" - or directly entering "X minimum" and "X maximum".

4. Confirm using softkey "✓ Finish".
6.6.5 Example: Positioning the cursor

Positioning the cursor

Procedure:
1. Select the "Cursors >" softkey and position the active cursor A at the required position.
2. Select the "Cursor B >" softkey and position the active cursor B at the required position.
3. Select the "Both Cursors" softkey in order to read the precise value of the cursor positions below the graphic:

---

6.6.6 Example: Trace session with PLC variables

Trace recording of PLC signals

Procedure:
1. Using softkey "New trace (Drive/NC)", open a new session.
2. Select the "Choose variable >" softkey, and under "Filter: PLC" to restrict the selection to PLC variables.
3. For example, select the following PLC signals:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Comment</th>
<th>Color</th>
<th>Pens</th>
<th>Shows</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>099.6</td>
<td>PLC: 099.6</td>
<td>R</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>099.7</td>
<td>PLC: 099.7</td>
<td>R</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Q141.4</td>
<td>PLC: Q141.4</td>
<td>R</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Q197.4</td>
<td>PLC: Q197.4</td>
<td>R</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

4. Under "Settings", enter a recording duration of 50 seconds, for example.

5. Select softkey "View trace" followed by "Start trace". The outputs are set and reset while tracing.

6. The following result is displayed after the selected trace duration has expired:
6.6.7 Example: Trace session with drive variables

Record the drive trace

Procedure:

1. Open a new session for drive variables.
2. From the list, insert parameter r722 "CU digital inputs status":
   - Select the "Settings" softkey to enter the trigger condition:
   - Select "If variable", and from the "Quick List", insert variable r722.
   - Under condition, select "At bit mask" and enter the required value as decimal number:
3. Select the "Settings" softkey to enter the trigger condition:
4. Select "If variable", and from the "Quick List", insert variable r722.
5. Under condition, select "At bit mask" and enter the required value as decimal number:
6. Confirm with "OK" to accept the settings.
7. Select softkey "View trace" followed by "Start trace".
8. The trace starts, if $r722.1=1$ and $r722.2=1$ are set ⇒ decimal value 6 and stops, which means if the trigger condition is satisfied.

6.6.8 Key combinations to use the trace

**Key combinations**

Key combinations, which function with the control keys as well as on an external keyboard.

**List view:**

- **CTRL + C**: Copy selection.
- **CTRL + V**: Insert selection.
- **CTRL + X**: Delete selection.

**Trace view:**

- **TAB**: Display the individual curves from left → right
- **SHIFT + TAB**: Display the individual curves from right → left
- **Spaces**: Select the display curve. (corresponds to the "Select/Legend" softkey)
- **Arrow keys**: Shift the image section either up or down.
With the cursor quickly to the right.

Move the cursor quickly to the left.

Zoom +

Zoom -

Undo the last action.
6.7 Diagnostics → drive system

Operating sequence

1. To check the status of the drive, select the "Diagnostics" → "Drive system" operating area:

2. Press the "Details" softkey to display further diagnostics data for a drive object:

3. If faults or warnings are pending for a drive object, change to the list view using the associated softkey.
SINAMICS faults and alarms

SINAMICS alarms can be of the alert (A = Alert) or fault (F = Fault) type:

- To activate the fault and warning buffer output for SINAMICS, set MD13150 $MN_SINAMICS_ALARM_MASK to the hexadecimal value "D0D". This automatically outputs the pending faults and warnings of the drive in the message line.
- The parameter r0945 shows the number of faults that have occurred.
- Pending warnings are indicated by parameter r2122 of the relevant drive component.
- The number of warnings that have occurred after the last reset is available in parameter p2111 of the drive components.
- Setting p2111 = 0 results in the deletion of all existing warnings of this component and updates the current warnings still pending. This parameter is reset to zero for a power on of the drive unit.

Example

To display the online help for a pending fault or warning on SINUMERIK Operate, the line must be marked (in orange). You can find remedial measures in the online help.
6.8 Modular machine

6.8.1 What does "modular machine" mean?

Definition

The modular machine concept is based on a maximum target topology created offline. The maximum design of a particular machine type is referred to as the maximum configuration in which all the machine components that may be used are pre-configured in the target topology.

By deactivating or deleting drive objects (p0105 = 2), sections of the maximum configuration can be removed. If a component fails, for example, this sub-topology can also be used to allow a machine to continue running until the spare part is available. In this case, however, no BICO source must be interconnected from this drive object to other drive objects.

**NOTICE**

**Data backup**

To prevent data loss, save the drive data in a commissioning archive, before you make any changes!
The "Commissioning" → "Drive system" → "Drive unit" operating area provides the following functions under "Configuration":

- "Configuration" > "Change >": (Page 186)
  - Change the name of the drive object
  - Change the name of the component
  - Change the comparison level

- "Configuration" → "Sort >": (Page 186)

- "Configuration" → "Display options >":

![Configuration interface screenshot]
## Drive unit - topology

<table>
<thead>
<tr>
<th>Drive object</th>
<th>No.</th>
<th>Component</th>
<th>No.</th>
<th>Socket</th>
<th>Socket</th>
<th>No.</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>CU_1.3.3:1</td>
<td>1</td>
<td>Control_Unit_1</td>
<td>1</td>
<td>X100</td>
<td>X201</td>
<td>2</td>
<td>Line_Module_2</td>
</tr>
<tr>
<td>ALM_3.3:2</td>
<td>2</td>
<td>Line_Module_2</td>
<td>2</td>
<td>X200</td>
<td>X201</td>
<td>3</td>
<td>Motor_Module</td>
</tr>
<tr>
<td>SERVO_3.3:3</td>
<td>3</td>
<td>Motor_Module</td>
<td>3</td>
<td>X200</td>
<td>X201</td>
<td>4</td>
<td>Motor_Module</td>
</tr>
<tr>
<td>SERVO_3.3:4</td>
<td>4</td>
<td>Motor_Module</td>
<td>4</td>
<td>X200</td>
<td>X201</td>
<td>5</td>
<td>Motor_Module</td>
</tr>
</tbody>
</table>

From: CU_1.3.3:Control_Unit_1(1)
To: ALM_3.3:2:Line_Module_2(2)
The "Commissioning" → "Drive system" → "Drive unit" operating area provides the following functions under "Topology":

- "Topology" → "Change >"
  - Delete a drive object
  - Delete the component
  - Enable/disable drive objects
  - Drive object: Change name/number
  - Component: Change name/number

- "Topology" → "Add component >" (Page 197)

- "Topology" → "Display options >":

Note

Changing the topology does not require that the first commissioning is repeated.
Example: Components without DRIVE-CLiQ

To display components, which are not connected via DRIVE-CLiQ, in the "Display options", under "Filter" select the "off" option:

6.8.2 Example: Topology display (graphic)

Topology display

As an alternative to displaying the topology in a tabular form, it is shown graphically based on Create MyConfig .

The following functions are supported:

- Selecting the drive device
- Displaying the actual topology
- Displaying the target topology
- Display to compare the target topology (top, white background) with the actual topology (bottom, bright blue background)
- A fault description when faults are active
- Increasing or decreasing the size of the view using the zoom function
- Displaying the properties of the selected component
- Identifying a component using an LED
Note

Functional scope of the "Topology display"

The functionality under "Drive system" → "Topology display" is a display function with the objective of identifying topology errors.

Contrary to this, in the drive unit functionality under "Drive device" → "Topology " (tabular form) the following additional functions are integrated:

- Activating/deactivating drive objects
- Deleting drive objects
- Adding and deleting components

Target topology

The graphic topology display is shown using the "Target topology" view as example:

![Figure 6-4 Target topology - without error](image)

A DRIVE-CLiQ port is always simultaneously selected for the component in focus. The Drive-CLiQ connection at a selected port is graphically highlighted.
Actual topology

The graphic topology display in the case of an error is shown using the "Actual topology" view:

Figure 6-5  Actual topology - with error

Precondition: It is assumed that the target topology has no error.

As a consequence, the errors are only displayed in the actual topology.

If a component has an error, then in addition to the symbol in the graphic, error information is also provided at the bottom right in the detailed view.

Focus on the component involved to analyze the error that has occurred. To do this, change into the "Topology comparison" view in order to compare the actual topology (top) with the saved target topology (bottom).

Component properties

After switching over the vertical softkey bar, the following properties of the focused component are displayed in the table:

<table>
<thead>
<tr>
<th>Axis:</th>
<th>AX1:X1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive object:</td>
<td></td>
</tr>
<tr>
<td>DO name:</td>
<td>SERVO_3.3:4</td>
</tr>
<tr>
<td>DO number:</td>
<td>4</td>
</tr>
<tr>
<td>Type:</td>
<td>[1] SERVO</td>
</tr>
<tr>
<td>DO status:</td>
<td>Drive object active</td>
</tr>
<tr>
<td>DO variable:</td>
<td></td>
</tr>
<tr>
<td>Component:</td>
<td></td>
</tr>
<tr>
<td>Component name:</td>
<td>SM_17</td>
</tr>
<tr>
<td>Component number:</td>
<td>17</td>
</tr>
<tr>
<td>Type:</td>
<td>512</td>
</tr>
<tr>
<td>Component status:</td>
<td>[1] Component active</td>
</tr>
<tr>
<td>Device:</td>
<td></td>
</tr>
<tr>
<td>Device class:</td>
<td>Sensor Module</td>
</tr>
<tr>
<td>Article number:</td>
<td>6SL3055-0AA0-5BA1</td>
</tr>
<tr>
<td>Serial number:</td>
<td>T-SO2046986</td>
</tr>
<tr>
<td>Comparison level:</td>
<td>high</td>
</tr>
</tbody>
</table>
6.8.3 Modify configuration

Drive unit - Configuration "Change >"

Procedure:

1. Press the "Change > " softkey to change the configuration. "Cancel" can be used to backup the drive data if it does not yet exist.

   2. If a data backup is available, confirm with "OK".

   3. Navigate with the arrow keys to the drive object / component that is to be changed.

   4. Press the "INSERT" key to enter the new designation.
Drive unit - Configuration "Sort >"

Procedure:

1. Press the "Sort >" softkey to open the display of the sort criteria.

2. Select one of the following sort criteria for the display from:
   - Drive object: The display is sorted according to the drive object number.
   - Wiring: The display is sorted according to wiring of the drive components in the drive system.
   - Component number: The display is sorted according to the component number.
   - Axis number: The display is sorted according to the axis number.
6.8.4 Check topology

Comparing topologies

Once you have parameterized the drive components, you can check the topology:

1. Select "Commissioning" → "Drive system" → "Drive unit" → "Topology" in the operating area.
2. Set the actual/target topology comparison for "Display options".

The topology of individual drive components is displayed:

3. This means you are supported during the check whether the displayed target topology matches the actual topology of the system.

Note

You will need the component numbers in order to configure direct measuring systems manually.

See also

Diagnostics → drive system (Page 177)
6.8.5 Changing topology

Drive unit - Topology "Change >"

Procedure:

1. Press the "Change >" softkey to change the topology. "Cancel" backs up the drive data if it does not yet exist.

2. If a data backup is available, confirm with "OK".
3. Navigate with the arrow keys to the drive object / component that is to be changed.

4. Press the "INSERT" key to enter the new designation.
   In the example, the drive object is changed from number "3" to number "30".

**Note**

**Effect**

The change of the name and number is applied to the data in the target and actual topologies of the drive software. Changing the comparison level affects the topology comparison in the drive software.
6.8.6 Activating or deactivating a drive object

Activating/deactivating drive objects

Operating sequence:

1. Select with the arrow keys a drive object.
2. Press the "Activate/deactivate drive object" softkey.
3. Follow the instructions in the information text.
4. Once successfully deactivated, the drive object and the associated components are grayed out.

Example series commissioning

When commissioning several machines (series) of the same type, a drive object that is not present is marked with p0105 = 0. This creates a commissioning archive that is transferred to the next machine.

To avoid triggering the alarm 201416, the serial number of this component must be deleted and the p0105 = 2 parameter of this component must be set to “Deactivate drive object and not present”.

Note

General conditions for deactivating:

- If a component is deactivated, only the component with the correct serial number or none may be inserted.
- If a component with a different serial number is inserted, this is by definition a different component. If no other component remains, it must certainly be an excess component. This component is marked as an additional component and alarm 201416 triggered.
6.8.7 Deleting a drive object

Deleting a drive object

Procedure:

1. Navigate with the arrow keys to the drive object that is to be deleted.
2. Press the "Delete drive" softkey.
   A security prompt follows to delete the drive object.
3. If a data backup is available, confirm with "OK". The drive object is deleted from the target topology.

4. The see the change in the topology, the "Actual/target topology comparison" display options must be set:

<table>
<thead>
<tr>
<th>Topologie</th>
<th>DP3 SLAVE3CU_1.3.3.1(1)</th>
<th>Antriebs-</th>
<th>Antriebs-</th>
<th>Antriebs-</th>
</tr>
</thead>
<tbody>
<tr>
<td>von</td>
<td>nach</td>
<td>gerät-</td>
<td>gerät-</td>
<td>gerät-</td>
</tr>
</tbody>
</table>

**Commissioning NC-controlled drives**

**6.8 Modular machine**

**Result:** The module can now be removed.
6.8.8 Delete the component

Delete the component

Procedure:

1. You are in the "Topology" dialog and have selected the "Change" mode:

   ![Topology dialog screenshot]

   - Navigate with the arrow keys to the component to be deleted.

2. If you select a component, the "Delete component" softkey is active.

   ![Delete component screenshot]
3. Press the "Delete component" softkey, in this example: Sensor SM_14 (sin/cos). A security prompt follows to delete the component.

![Image of a topology with a delete component prompt]

4. If you are sure, confirm with "OK". The component is deleted from the target topology.

![Image of a topology with a component removed and highlighted in red]

If the component is not yet available in the actual topology, i.e. still connected, an alarm is output and the component highlighted in red. To see the change in the topology, the "Actual/target topology comparison" display options must be set.

5. Remove the module.
6.8.9 Adding components

Adding components

If you connect a new component (e.g. SMC20) via DRIVE-CLiQ to the drive system, the drive detects the change in the actual topology and displays the actual/target topology difference.

- **GRAY**: Desired state, drive object / component not plugged in or deactivated in the drive system. Use the cursor keys to select the required line. The state is indicated in the bottom part of the window.

- **RED**: Actual state, drive object/component available in the actual topology.
  New components that have not yet been commissioned have a component number > "200"; in this example, the number "210".

The new component must then be configured and assigned to a drive object (Motor Module) using the drive wizard.

**Note**

Only plug in (connect) components when the drive unit is switched off.

In the "Topology" dialog, start at the actual state: The new component has not been connected yet.
Procedure:

1. To connect a new DRIVE-CLiQ component (e.g. SMC20) to a Motor Module, select "Commissioning" → "Drive system" → "Drive device" → "Topology" in the operating area.

![Topology diagram](image1.png)

- Navigate with the arrow keys to the component that should be inserted in the topology and press the "Add component >" softkey. The system recognizes the new component and outputs a message.

2. Navigate with the arrow keys to the component that should be inserted in the topology and press the "Add component >" softkey. The system recognizes the new component and outputs a message.
3. Press "OK" as confirmation to configure and accept this component. Determining the device configuration may take several minutes. Depending on the device configuration, you will be prompted to perform further actions or to cancel:

To adapt the cyclical data traffic between NCK and SINAMICS to the configuration of the SINAMICS, a RESET must be performed in the NCK and in the drive system. Should a RESET be performed in the NCK and in the drive system?

4. Press "OK" to confirm that an NCK and drive system reset should be performed. The unit configuration is finished. The component has been accepted. The following message will then appear:

5. Press "OK" to include the component in the topology again although it is not yet assigned to any drive:

- Select "Drive unit" to open the drive wizard. Select the drive and assign the new encoder in the encoder configuration (Page 127) to the drive.
- Press "OK" to assign this component to the drive later.

6.8.10 Replacing a SINAMICS S120 component

Requirements

There are two procedures for replacing components:
1. Replacing SMI or SMx motor components.
2. Replacing an existing Motor Module with a more powerful Motor Module.
The following preconditions are satisfied:

- The two Motor Modules are of the same type.
- The serial number is different: ⇒ In this case, another configuration is not required.
- The difference between the two Motor Modules, for example, is 9 A instead of 5 A.

**Note**

Do not make a permanent change in the drive system.

Before you replace the DRIVE-CLiQ component, change the comparison level.

---

### Replacing SMI or SMx motor components

**Note**

The new SMI/SMx motor component must not yet be inserted!

Operating sequence:

1. You have removed the previous SMI or SMx motor component.
   - This motor component is missing in the actual topology. SINAMICS indicates this in the form of a topology error alarm.
   - The "Commissioning" → "Drive system" → "Drive units" → "Topology" dialog shows the previous motor component to be replaced in "gray", i.e. present only in the target topology.

2. In the "Commissioning" → "Drive system" → "Drive units" → "Topology" → "Change..." dialog, remove the SMI/SMx motor component awaiting replacement from the target topology using the "Delete component" (Page 195) dialog.

   **NOTICE**

   **Data loss**

   Save the drive data that has been changed **before** switching off (for example, to a drive data archive).

3. Switch off the drive system and switch on again.

4. In the "Commissioning" → "Drive system" → "Drive units" → "Topology" dialog, check whether the SMI/SMx motor component has been removed from the target topology:
   - The alarm topology error is no longer pending.
   - The "Commissioning" → "Drive system" → "Drive units" → "Topology" dialog no longer shows any differences.

5. Switch off the drive system.

6. Plug in the new SMI/SMx motor component.

7. Switch on the drive system.
8. Add the new SMI/SMx motor component to the target topology using the "Commissioning" → "Drive system" → "Drive units" → "Topology" → "Add component" (Page 197) dialog.

9. Assign the added SMI/SMx motor component via the "Commissioning" → "Drive system" → "Drives" drive wizard.

Replacing a Motor Module

The replacement of components after the first commissioning, e.g. in order to use an ALM with a higher power 16 kW → 50 kW, must be performed in such a way that the configuration data is reimported and is up to date.

Note

Firmware update

The firmware of the configured drive components is updated correctly only when the components were inserted in the switched-off state. The subsequent insertion of drive components must ONLY be performed in the switched-off state.

If a drive component is replaced by a component with a different article number, e.g. a more powerful module, after first commissioning, observe the following sequence:

Procedure:
1. Select "Drive unit" → "Topology" → "Change".
2. Select the module and select "Deactivate drive object".
3. Replace the module in the cabinet.
4. Select the module and select "Activate drive object".
5. The configuration data of the new module is read in.
6. Update the drive data in the commissioning archive with the new configuration data.

6.8.11 Example: Subsequently installing a component

Precondition

To write to Control Unit parameters and drive parameters and activate them, as a minimum, the "Service" access level is required.
Overview of the drive state

Using the "Activate drives" softkey, in the "Drive state overview" open a table listing all of the drive objects, which shows the actual state of parameter p0105: "Activate/deactivate drive objects". Furthermore, the connection status is shown as a symbol:

<table>
<thead>
<tr>
<th>DO status (p0105)</th>
<th>Symbol</th>
<th>Significance</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] deactivated</td>
<td></td>
<td>The component is not inserted, and the status is deactivated.</td>
</tr>
<tr>
<td>[0] deactivated</td>
<td></td>
<td>The component is inserted, and the status is deactivated.</td>
</tr>
<tr>
<td>[1] activated</td>
<td></td>
<td>The component is inserted, and the status is activated.</td>
</tr>
<tr>
<td>[1] activated</td>
<td></td>
<td>The component is inserted, and the status is activated: Component with fault.</td>
</tr>
<tr>
<td>[2] deactivated without hardware</td>
<td>- without symbol -</td>
<td>The component is not inserted, the status is deactivated: However, the component is included in the target topology.</td>
</tr>
</tbody>
</table>

Note

Status p0105 = [2] deactivated without hardware

In the "Drive state overview", only the two states "[1] activated" and "[0] deactivated" are listed for a drive object.

If a drive object exists with status [2] deactivated without hardware, then the status must be changed to "[0] deactivated" and then the hardware component must be inserted and connected.

The "Data backup" column shows the following symbols:

- The backup of the drive parameters for every drive object is saved at:
  /user/sinamics/smi/backup
- Parameter data of drive objects are copied to the CompactFlash card of the control system from a Create MyConfig package.
  If the configuration parameters are overwritten when subsequently connecting the motor with DQI encoder for the automatic controller data calculation, then when activating, these parameters are again written to the drive object.

Subsequently inserting a component

In a Create MyConfig package, you can define and transfer the configuration parameters of the "electronic rating plate" for motors with DQI encoder, without the hardware component having to be already installed. The motor and encoder data are then already transferred to the CompactFlash card when reading in the archive; however, the parameters are only activated after the motor has been installed.

The following procedure applies both when commissioning as well as when replacing parts and components.
Press the "Activate all" softkey to execute the following steps:

1. Read out the motor data on the electronic rating plate.
2. In comparison to p0300 "Select motor type", check as to whether the configured data match the configured component.
3. Activate the drive object.
4. Automatically calculate the controller data.
5. Overwrite parameters with the configured data from the Create MyConfig package.
6. Backup the parameters.

This operation can take several minutes. A progress display is shown.

When changing the status from "[0] deactivated" → "[1] activated" the backup of this drive object is created in the following directory on the CompactFlash card: /user/sinamics/smi/backup. The data for all drive objects is saved at: /user/sinamics/data

If several drive objects are selected, then you can select different procedures for each of the individual drive objects:

1. "Only activate" softkey to activate parameters that are already saved to the CompactFlash card.
2. "CMC data" softkey, to calculate the controller data and to activate the data saved from a Create MyConfig package to the CompactFlash card.
3. "Last backup" softkey to restore the last data backup of the drive object from the backup file.
4. "Exit" softkey to exit the view of the drive objects.
5. You have the following alternatives after successfully completing the procedure:
   - "Cancel" softkey to exit the procedure without restarting the system. As a consequence, the parameters are not yet active.
   - Press the softkey "Accept" to activate the parameters and to execute a restart the system Reset (po).

Replacing a device

SIMOTICS Service Manual: Encoder replacement for SIMOTICS S-1FK7 G2, S-1FG1 and S-1FT7
6.9 Tips for commissioning the SINAMICS drives

6.9.1 Displaying the firmware version of the drive components

Firmware version of the drive components

To check the version of the drive components, select in the "Commissioning" operating area → "Drive system" → "Drive device" → "Configuration":

![Configuration table]

The version for each component is displayed in the "FW version" column. The firmware version is read out from the following SINAMICS parameters:

- r0018: Firmware version of the integrated Control Unit and of the CU_NX expansion, which is always identical to the version of the SINAMICS system software.
- r0128: Firmware version of the infeed module
- r0975[2 and 10]: Firmware version of the Motor Module
- r0148[0...2]: Firmware version of the Sensor Modules that belong to the Motor Module
6.9.2 Check the line data of the infeed

Checking and setting the power data

Finally, after commissioning the drive system, check the power data of the infeed module. In the operating area "Commissioning" → "Drive system" → "Infeed", the "Power data" softkey is enabled if the infeed module has already been commissioned and the data have been saved in the non-volatile memory:

The following power data are configured:

- When the checkbox is selected, the line/DC link identification is activated once the infeed pulse has been enabled (p3410). The infeed then switches to operational mode.

**Note**

**DC link identification**

If the line supply environment changes or the components on the DC link change (e.g. after setting up the equipment at the customer site or after expanding the drive group), the checkbox must be set again: Hence the "Line data" softkey in the overview in order to restart the line/DC link circuit identification.

If p3410 = 5 is saved in the commissioning archive, then the line/DC link identification starts automatically once the drive data is input into the archive.

Only then can it be guaranteed that the infeed operates with the optimum controller settings.

- Enter the device connection voltage: This is the basis for the mains overvoltage (p0281 - p0283), for which an alarm is issued when the threshold is exceeded or undershot (warning threshold and trip threshold). The actual line voltage is determined automatically and the adjustment is made based on this value.
The actual line frequency for the infeed is determined automatically. In parameter p0284, p0285 you set the warning threshold at which an alarm is triggered (presetting of the monitoring function: 45 Hz to 65 Hz).

Quick stop for axes when the voltage dips after a delay time in [ms]:
In the event of a voltage dip, alarm 207862 "External fault 3" is triggered, followed by alarm 207841 "Drive: Infeed operation withdrawn", and the associated fault response is initiated from p2101. If an alarm is not to be initiated for very short voltage dips, this can be configured with the ON-delay time p2101.

The switch-on delay is not active for each specific drive, but per infeed – and therefore for all the drives connected to this infeed. This does not affect alarms, for example from the DC link, and they continue to be triggered.

6.9.3 Mains and DC link identification of the infeed module

Objective
To optimally set the current and voltage control, start a mains and DC link identification after completing the commissioning of the drive.

Automatic identification
The automatic identification determines characteristic mains and DC link characteristics, which serve as the basis for optimally set controllers in the Line Module. You can adapt the dynamics of the voltage control with p3560.
Manual identification

Further identification methods:

- **p3410 = 4** (identify and save controller setting with \(L\) adaptation)
  
  An identification run for the total inductance and DC link capacitance is initiated when the pulses are next enabled: Two measurement routines with different current magnitudes. The determined data (r3411 and r3412) is entered into p3421 and p3422. At the same time, the controllers are recalculated and the parameters for current controller adaptation are defined (p3620, p3622). The parameters for the infeed module are then automatically stored in a non-volatile memory. The infeed unit continues to operate without any interruption with the new controller parameters.

- **p3410 = 5** (resetting, saving ID and controller setting with \(L\) adaption)
  
  The parameter values for line inductance and DC link capacitance are reset before the first identification run:
  
  \[ p3421 = p0223 \text{ and } p3422 = p0227 \]

- **p3410 = 6** (Setting, \(C\)-identifying and saving robust current controller)
  
  For infeed units of the type Chassis 2, use \(p0220 \geq 110\) to select corresponding Active Interface Modules of the Chassis 2 (AIM Chassis-2) design and start the automatic controller setting with \(p3410 = 6\). At the same time, the value of the DC link is determined in a shortened measurement. All of the other controller parameters are already preset by setting \(p3410 = 6\).

  - **Advantage:** For modified mains parameters (e.g. switchover to a different mains), no adaptation of the controller parameters and mains identification is required.

  - **Disadvantage:** Unlike identification over \(p3410 = 5\), the automated controller setting leads to losses in the dynamic response.

\(P3410 = 0\) is automatically set when an identification routine is successfully completed.

Further information can be found in the SINAMICS S120 Function Manual Drive Functions

### 6.9.4 Rules for wiring the DRIVE-CLiQ interface

**Topology rules**

When wiring components with DRIVE-CLiQ, the following rules apply: The rules are subdivided into **obligatory rules**, which must be observed, and **optional rules**, which enable automatic topology detection if they are adhered to.

**Obligatory rules:**

- A maximum of 198 DRIVE-CLiQ node components can be connected for each NCU.
- Up to 16 nodes can be connected to a DRIVE-CLiQ socket.
- A maximum of seven nodes can be connected in one row. A row is always considered from the perspective of the closed-loop control module.
- Ring wiring is not permitted.
- Components must not be double-wired.

**Optional rules:**
When the optional rules for the DRIVE-CLiQ wiring are observed the components concerned will be automatically assigned to the drives:

- For one Motor Module, the related motor encoder must also be connected.
- Due to the improved performance utilization, use as many DRIVE-CLiQ points on the NCU as possible.
- It is essential that you comply with the optional rules when using the macro. This is the only way to achieve a proper assignment of the drive components.

**Use of the SMC40**

The SMC40 Sensor Module Cabinet-Mounted is used to convert encoder signals from absolute encoders with EnDat 2.2 to DRIVE-CLiQ. Two encoder systems with EnDat 2.2 can be connected to the SMC40. Their signals are converted independent of each other on two DRIVE-CLiQ encoder signals.
Connection conditions

To ensure that the SMC40 Sensor Module Cabinet-Mounted is integrated into the topology during the initial commissioning, you must absolutely observe the following rules:

- Connect at least one of the DRIVE-CLiQ interfaces X500/1 or X500/2 on the SMC40 using DRIVE-CLiQ.
- Connect one EnDat encoder to the corresponding encoder interface X520/1 (to X500/1) or X520/2 (to X500/2).
- Operate the SMC40 only in a star topology. The DRIVE-CLiQ X500/1 and X500/2 sockets cannot be used for a series connection.

NOTICE

Display in the "Topology" dialog

The SMC40 is only integrated into the actual topology if the DRIVE-CLiQ interfaces X500/x and the corresponding encoder interfaces X520/x are assigned.

Without a connected encoder, it is also not possible to subsequently integrate the SMC40 in the topology.

6.9.5 Drive-object assignment for PROFIBUS connection

Drive object number

PROFIBUS telegrams (internal PROFIBUS, HW Config) are used to specify the process data to be exchanged between the NC and the drives. The sequence of the drive objects (configurable/configured using HW Config) involved in PROFIBUS process-data exchange is defined via a drive-object list.

The drive-object numbers (DO numbers) can be viewed under "Commissioning > Machine data > Control Unit MD/Infeed MD/Drive MD" in the component name line. An example of a Control Unit name might be: "DP3 Slave3:CU_003 (1)". The DO number appears inside the brackets "(...)".

List of drive objects

You usually configure eight drive objects (default setting): The drive objects have drive-object numbers and are entered in parameter p0978[0…9] as a list of drive objects:

| p0978[0] = 3 | Motor Module 1 |
| p0978[1] = 4 | Motor Module 2 |
| p0978[2] = 5 | Motor Module 3 |
| p0978[3] = 6 | Motor Module 4 |
| p0978[6] = 1 | Control Unit |
PROFIBUS telegram 370 for the infeed (ALM) is not supported by SINUMERIK. However, according to the SINAMICS rule, all DO from parameter p0101 have to be assigned in parameter p0978. For this reason, the DO number of the infeed should be entered in index 9.

**Note**

The list of DO involved in process-data exchange is completed by entering the value "0".

The list of drive objects is already preassigned in the following sequence by the system upon initializing the drive (acceptance of topology): ALM, 1st Motor Module … n, CU; e.g. 2-3-4-5-1.

Components that do not communicate via PROFIBUS automatically have "255" preassigned to them.

### Example: Assigning drive objects

The following table shows on a SINAMICS S120 component structure the drive object assignment for the drive parameters:

- One Control Unit (CU)
- One Active Line Module (ALM)
- Three Motor Modules

Assignment p0978[0…9] for supply with DRIVE-CLiQ connection:

<table>
<thead>
<tr>
<th>Component</th>
<th>Index p0978</th>
<th>List of drive objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Motor Module</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>2. Motor Module</td>
<td>1</td>
<td>4</td>
</tr>
<tr>
<td>3. Motor Module</td>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>not found</td>
<td>3</td>
<td>255&lt;sup&gt;1)&lt;/sup&gt;</td>
</tr>
<tr>
<td>not found</td>
<td>4</td>
<td>255&lt;sup&gt;1)&lt;/sup&gt;</td>
</tr>
<tr>
<td>not found</td>
<td>5</td>
<td>255&lt;sup&gt;1)&lt;/sup&gt;</td>
</tr>
<tr>
<td>CU</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>ALM (only if protocol 370 is available)</td>
<td>7</td>
<td>255&lt;sup&gt;1)&lt;/sup&gt;</td>
</tr>
<tr>
<td>not found</td>
<td>8</td>
<td>0&lt;sup&gt;2)&lt;/sup&gt;</td>
</tr>
<tr>
<td>ALM (default setting for SINUMERIK)</td>
<td>9</td>
<td>2</td>
</tr>
</tbody>
</table>

1) Not active
2) Ends the exchange of PZD

The following table describes the assignment of the drive objects in p0978[0…9] for an infeed without DRIVE-CLiQ connection. This assignment is also done for a drive group with NX module.
Assignment of p0978[0…9] for infeed without DRIVE-CLiQ connection:

<table>
<thead>
<tr>
<th>Component</th>
<th>Index p0978</th>
<th>List of drive objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Motor Module</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>2. Motor Module</td>
<td>1</td>
<td>3</td>
</tr>
<tr>
<td>3. Motor Module</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>not found</td>
<td>3</td>
<td>255&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>not found</td>
<td>4</td>
<td>255&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>not found</td>
<td>5</td>
<td>255&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>CU</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>ALM (only if protocol 370 is available)</td>
<td>7</td>
<td>255&lt;sup&gt;1&lt;/sup&gt;</td>
</tr>
<tr>
<td>not found</td>
<td>8</td>
<td>0&lt;sup&gt;2&lt;/sup&gt;</td>
</tr>
<tr>
<td>not found</td>
<td>9</td>
<td>0</td>
</tr>
</tbody>
</table>

1) Not active
2) Ends the exchange of PZD
Example: Drive group

Using the example of a SINAMICS S120 drive line-up, the significance of the drive components on drive objects is shown: Each drive object has its own parameter list.

Drive object DO3 comprises the following components:

① Single Motor Module
⑧ SMC20
⑨ Motor encoder (direct measuring system)
⑩ Motor

Figure 6-7  Drive group

The component number is assigned by the drive after detection of the DRIVE-CLiQ topology. The associated component numbers can be found in the "Commissioning" → "Machine data" → "Drive MD" → "Select axis" operating area:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Parameter designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>p0121</td>
<td>Power unit component number</td>
</tr>
<tr>
<td>p0131</td>
<td>Motor component number</td>
</tr>
<tr>
<td>p0141</td>
<td>Sensor Module (encoder interface) component number</td>
</tr>
<tr>
<td>p0142</td>
<td>Encoder component number</td>
</tr>
</tbody>
</table>
6.9.6 Adjusting speed and brake behavior

Speed adjustment

The following parameters can be set in the "Commissioning" → "Machine data" → "Drive MD" operating area:

Speed adjustment:

- Spindle drive: 
  p0500 = 102, speed setpoint in p0322 corresponds to setpoint 4000 0000hex
- Feed drive: 
  p0500 = 101, speed setpoint in p0311 corresponds to setpoint 4000 0000hex

The speed setpoint can be diagnosed in the relevant drive in r2050[1+2] and r2060[1].

Brake behavior OFF3

Depending on the requirements, the brake behavior for each drive can be adjusted to the signal 2. OFF3.

Default setting p1135 = 0 brake with maximum current.

Using drive-specific parameterization, a flatter braking ramp can be set with the parameters p1135, p1136, p1137.

Maximum braking ramp setting: 600 seconds.
6.9 Tips for commissioning the SINAMICS drives
7.1 Overview of NC and drive communication

What will be configured next?

The initial commissioning of the PLC and SINAMICS drives is completed.

The machine data that communicates with the drive is:

- **General machine data**
  General machine data required for communication with the drive via PROFIBUS that has been preset with default values. These values can be taken over during the initial commissioning:
  - The telegram type for transfer
  - The logical addresses for the PLC

- **Axis-specific machine data**
  The axis component for transfer of the setpoints and actual values for the relevant axis, is set in the axis machine data.

Assignment of machine data

Using the example of a SINAMICS S120 module structure (one NCU, one ALM, three Motor Modules (MM)), the following table illustrates the assignment of the machine data for input address/output address/telegram/setpoint/actual value.

<table>
<thead>
<tr>
<th>SINAMICS S120</th>
<th>STEP 7 (HW Config) DP slave properties</th>
<th>General machine data</th>
<th>Axis machine data(^2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component</td>
<td>Message frame type and length</td>
<td>I/O address(^1)</td>
<td>MD13120[0] I/O address(^1)</td>
</tr>
<tr>
<td>MM1</td>
<td>136 - PZD-11/19</td>
<td>4100</td>
<td>4100</td>
</tr>
<tr>
<td>MM2</td>
<td>136 - PZD-11/19</td>
<td>4140</td>
<td>4140</td>
</tr>
<tr>
<td>MM3</td>
<td>136 - PZD-11/19</td>
<td>4180</td>
<td>4180</td>
</tr>
<tr>
<td>Not available</td>
<td>136 - PZD-11/19</td>
<td>4220</td>
<td>4220</td>
</tr>
<tr>
<td>Not available</td>
<td>136 - PZD-11/19</td>
<td>4260</td>
<td>4260</td>
</tr>
<tr>
<td>Not available</td>
<td>136 - PZD-11/19</td>
<td>4300</td>
<td>4300</td>
</tr>
<tr>
<td>CU</td>
<td>391 - PZD-3/7</td>
<td>6500</td>
<td>6500</td>
</tr>
<tr>
<td>ALM</td>
<td>370 - PZD-1/1</td>
<td>6514</td>
<td>6500</td>
</tr>
</tbody>
</table>

1) Do not change preassignment.

2) The axis-specific machine data for the configuration of the setpoints and actual values is pre-assigned using the "Assign axis" function.
7.2 Configuring the communication to the drive

Default settings

The telegram length in the hardware configuration is preassigned with the associated I/O addresses. This pre-assignment for SINAMICS corresponds to the following telegrams with the maximum possible telegram length:

- Telegram 136: for the axes
- Telegram 391: For the CU
- Telegram 370: for the ALM

This ensures that all telegrams can be supplied without change.

Telegram lengths and I/O addresses

Procedure:

1. To view this configuration, click in the HW Config on the module "SINAMICS Integrated" and select "Object properties", using the <right mouse button>.

2. Select the "Configuration" tab and select the "Overview" tab to display the lengths of the preassigned telegrams.

   The diagram shows the default setting of the telegrams for 6 axes (object 1 ... 6):

   ![Diagram showing default settings for telegrams]

3. Click "OK" to close the dialog.
Example

The address areas are displayed in the detail view by clicking the "SINAMICS Integrated" object. Here, for example, address 4100 corresponds to the address entered in MD13050 $MN_DRIVE-LOGIC_ADRESS[0]. The addresses have a gap of 40 bytes. The example shows the assignment of the I/O addresses of the PLC configuration to MD13050 $MN_DRIVE-LOGIC_ADRESS[0 … 5]:

![Telegram lengths and I/O addresses](image)

**Figure 7-1** Telegram lengths and I/O addresses

**Default setting in the NC:**

<table>
<thead>
<tr>
<th>Address</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD13050 $MN_DRIVE_LOGIC_ADRESS[0] = 4100</td>
<td>For the 1st axis</td>
</tr>
<tr>
<td>MD13050 $MN_DRIVE_LOGIC_ADRESS[1] = 4140</td>
<td>For the 2nd axis</td>
</tr>
<tr>
<td>MD13050 $MN_DRIVE_LOGIC_ADRESS[2] = 4180</td>
<td>For the 3rd axis</td>
</tr>
<tr>
<td>MD13050 $MN_DRIVE_LOGIC_ADRESS[3] = 4220</td>
<td>For the 4th axis … etc.</td>
</tr>
</tbody>
</table>
7.3 Configuring the I/O address and telegram

PROFIBUS connection

The following general machine data is also set by default for the PROFIBUS connection of the axes to the drive:

- MD13050 $MN_DRIVE_LOGIC_ADDRESS (axis address)
- MD13060 $MN_DRIVE_TELEGRAM_TYPE (telegram type)
- MD13120 $MN_CONTROL_UNIT_LOGIC_ADDRESS (CU address)

The connection of the relevant axes to the drive via PROFIBUS is displayed in the "Commissioning" → "Drive system" → "Drive units" → "PROFIBUS" operating area.

Example for the connection of relevant axis to the drive:

![Figure 7-2 Drive units - PROFIBUS](image)

To change the assignment, press the "Change >" softkey. Then use the arrow softkeys for the new assignment:
Communication between the NC and the drive

7.3 Configuring the I/O address and telegram

Note

Communication with the drive

To ensure the communication with the drive, the I/O addresses and telegram types set here must match the settings in the STEP 7 hardware configuration.
7.4 Process data transfer between the NC and drive

Telegram types

Which telegram types are available?

- **Standard telegrams**
  The standard telegrams are structured in accordance with the PROFIdrive Profile V4.1. The internal process data links are set up automatically in accordance with the telegram number setting.

- **Manufacturer-specific telegrams**
  The manufacturer-specific telegrams are structured in accordance with internal company specifications. The internal process data links are set up automatically in accordance with the telegram number setting.

The telegram length for communication with the drive is specified in the HW Config, and depends on the required axis functions, e.g. the number of encoders or the functionality of the deployed drive.

**Note**

If the telegram length of a drive component is changed in HW Config, the selection of the telegram type also has to be adapted in the configuration of the interface in the NC.

The following manufacturer-specific telegrams can be set with parameter p0922:

<table>
<thead>
<tr>
<th>Telegrams for the axes (SERVO):</th>
<th>Torque reduction</th>
<th>Torque feedforward control</th>
<th>Position controller gain</th>
<th>DSC</th>
<th>Encoder 1</th>
<th>Encoder 2</th>
<th>Encoder 3</th>
<th>Adaptation parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>116</td>
<td>x</td>
<td>--</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>--</td>
</tr>
<tr>
<td>118</td>
<td>x</td>
<td>--</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>--</td>
</tr>
<tr>
<td>136</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>--</td>
</tr>
<tr>
<td>146</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>138</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>x</td>
<td>x</td>
<td>--</td>
</tr>
<tr>
<td>148</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>139</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>x</td>
</tr>
<tr>
<td>149</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>x</td>
</tr>
<tr>
<td>166</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

Telegram 146, 148, 149 also have an additional control and status word.

<table>
<thead>
<tr>
<th>Telegrams for the integrated SINAMICS Control Unit (CU_I):</th>
</tr>
</thead>
<tbody>
<tr>
<td>370</td>
</tr>
<tr>
<td>390</td>
</tr>
<tr>
<td>391</td>
</tr>
<tr>
<td>395</td>
</tr>
</tbody>
</table>
Communication between the NC and the drive

The telegrams from the NC to the drive are transferred via the internal PROFIBUS of the NCU:

- Send telegrams (drive → NC)
- Receive telegrams (NC → drive)

The telegrams are standard telegrams with pre-defined assignment of the process data (PZD), and are interconnected in the drive object using BICO technology.

The following drive objects can exchange process data:

1. Active Line Module (A_INF)
2. Basic Line Module (B_INF)
3. Motor Module (SERVO)
4. Control Unit (CU_I, CU)

The sequence of the drive objects in the telegram on the drive side can be set in parameter p0978[0...15]: Operating area "Commissioning" → "Machine data" → "Control Unit parameters".

Selecting a telegram via p0922 of the related drive object ("Commissioning" → "Machine data" → "Drive parameters" operating area) determines the process data to be transferred.

The receive and send words comprise the following elements:

- Receive words: Control words or setpoints
- Send words: Status words or actual values

Further details are found in the following SINAMICS Manuals:

7.5 Drives: Assign axis

Condition

The commissioning of the drives has been completed.

Assigning drive and axis

Procedure:

1. Press the "Drive system" → "Drives" softkeys in the "Commissioning" operating area.
2. With the "Drive +/-" or "Select drive" softkeys, select the drive; in this example, SERVO_3.3:3 for the spindle.
3. To assign the drive to an axis, press the "Axis assignment >" softkey on the vertical softkey bar.

4. Mark the uppermost selection box for the "Setpoint: Axis → drive".
5. Mark the next selection box for the "Actual value: Encoder → axis" and assign a measuring system in accordance with the table below.

![Image of encoder selection and assignment](image)

6. Select the drive object from "NC drive number": The associated I/O address from the PLC configuring is then displayed automatically.

7. Click "OK" to confirm the assignment and write the data.

### Encoder selection and assignment

The assignment of an axis to a drive is called **setpoint assignment**; the assignment of an encoder to an axis is called **actual value assignment**. The assignments are described below. A setpoint assignment (axis → drive) without encoder assignment is permitted because not all axes require encoders, e.g. spindles. The encoders are assigned automatically if they have already been configured for the drive and are transferred in the telegram.

The tables show which SINAMICS encoders are supported by which telegram:

<table>
<thead>
<tr>
<th>Message frames</th>
<th>(1 / 2)</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>102</th>
<th>103</th>
<th>104</th>
<th>105</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder 1</td>
<td>--</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Encoder 2</td>
<td>--</td>
<td>--</td>
<td>2</td>
<td>--</td>
<td>2</td>
<td>--</td>
<td>2</td>
<td>3</td>
<td>--</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Message frames</th>
<th>106</th>
<th>107</th>
<th>116</th>
<th>118</th>
<th>136/146</th>
<th>138/148</th>
<th>139/149</th>
<th>166</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder 1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Encoder 2</td>
<td>2</td>
<td>3</td>
<td>2</td>
<td>3</td>
<td>2</td>
<td>3</td>
<td>--</td>
<td>2</td>
</tr>
</tbody>
</table>

The numbers in the lines for encoder 1 / encoder 2 indicate the running number of the encoder on the SINAMICS drive. This number is transferred in the selected telegram to the NC and assigned to the axis as encoder 1 or encoder 2.

The telegrams in MD13060 $MN_DRIVE TELEGRAM_TYPE are preassigned with the values from the HW Config. This preassignment is set correspondingly for the assignment of the drive.
to an axis. The following also applies to a setpoint assignment:
MD30130 $MA_CTRLOUT_TYPE[ ] = 1.

Selecting the assignment procedure

Select from the following procedures in the "Assignment Procedure" dialog:

- **Via axis machine data (NC drive number)**
  The NC drive number is retained and written for the selected axis into the following axis machine data:
  MD30110 $MA_CTRL_OUT_MODULE_NR and MD30220 $MA_ENC_MODUL_NR

- **Via general machine data (I/O address) = default setting**
  For this assignment procedure, the I/O address assigned to the drive using the NC drive number is written to the following general machine data: MD13050 $MN_DRIVE_LOGIC_ADDRESS[<NC drive number> - 1]. This assumes that the I/O address default setting is not changed in the PLC project.

- **User-defined**
  If you select this option, the selection list can be edited under "NC drive number". Then assign a drive number and the displayed I/O address to the axis selected above. This option is recommended only for experienced machine manufacturers!
7.6 Configuring machine axes

7.6.1 Axis assignment

Introduction

Generally, a distinction is made between four types of axes:

- **Machine axes**
  Machine axes are the motion units existing on a machine, which can also be designated as linear or rotary axes, depending on their usable movement.

- **Channel axes**
  The total of all machine, geometry and special axes assigned to a channel is designated as channel axes. In this context, the geometry and special axes constitute the program-technological part of the machining process, i.e. they are used for programming in the parts program. The machine axes constitute the physical part of the machining process, i.e. they carry out the programmed traversing movements on the machine.

- **Geometry axes**
  The geometry axes constitute the rectangular Cartesian basic coordinate system of a channel. Generally, (Cartesian arrangement of the machine axes) direct imaging of the geometry axes to the machine axes is possible. If the arrangement of the machine axes, however, is not Cartesian at right angles, the imaging is performed using a kinematic transformation.

- **Special axes**
  Special axes are all other channel axes that are not geometry axes. Unlike for geometry axes (Cartesian coordinate system), no geometric context is defined for special axes, neither between additional axes nor with respect to geometry axes.

---

**Note**

**Geometry and special axes**

A maximum of three channel axes can be declared as geometry axes. The geometry axes must be assigned to the channel axes in ascending order without any gaps. All channel axes that are not geometry axes are special axes.
### Axis assignment

The assignment of geometry axes to channel axes and channel axes to machine axes, as well as the definition of the names of the different axis types is realized via machine data. The following diagram illustrates this relationship:

**Figure 7-4  Axis assignment**

**Communication between the NC and the drive**

#### 7.6 Configuring machine axes

**NCU 1**

- **Geometry axis names**
  - MD20060 `$MC_AXCONF_GEOAX_NAME_TAB[n][m]`

- **Channel axes used**
  - MD20050 `$MC_AXCONF_GEOAX_ASSIGN_TAB[n][m]`

**Channel axis names**

- MD20080 `$MC_AXCONF_CHANAX_NAME_TAB[n][n]`

- **Machine axes used**
  - MD20070 `$MC_AXCONF_MACHAX_USED[n][m]`

**Logical machine axis image**

- MD10002 `$MN_AXCONF_LOGIC_MACHAX_TAB[n]`

**Local machine axes**

- MD10000 `$MN_AXCONF_MACHAX_NAME_TAB[n]`

**Axis container names**

- MD12750 `$MN_AXCT_NAME_TAB[n]`

**Axis container “CT1”**

- MD12701 `$MN_AXCT_AXCONF_ASSIGN_TAB1`

**NCn_AXm: Container link axis**

**Link axis: Machine axis AXn on NCU 2**
Channel axis gaps

Normally, using MD20070, a channel axis is assigned to one machine axis. Not every channel axis must be assigned to a machine axis. Each channel axis with \( MD20070 \ [n] = 0 \) is not assigned any machine axis and represents a channel axis gap.

Channel axis gaps allow the creation of a uniform configuration of the channel axes over different machine versions of a series. Each channel axis of the series has a defined task or function. If the function and therefore the machine axis is not available on a specific machine, the relevant channel axis is not assigned a machine axis:

\[
MD20070 \ \$MC\_AXCONF\_MACHAX\_USED[<\text{channel axis}>] = 0
\]

Advantages:
- Commissioning archive with uniform basic configuration
- Simple post configuration for the specific machine
- Flexible portability of part programs

Enabling channel axis gaps

The use of channel axis gaps is enabled using the machine data:

\[
MD11640 \ \$MN\_ENABLE\_CHAN\_AX\_GAP = 1 \ (\text{channel axis gap allowed}).
\]

If the use of channel axis gaps has not been enabled, then the value 0 for channel axis \( n \) in the following machine data terminates the allocation of additional machine axes to possible channel axes from channel axis \( n \) onwards:

\[
MD20070 \ \$MC\_AXCONF\_MACHAX\_USED[<\text{channel axis } n>] = 0
\]

Supplementary conditions:
- Regarding the number of channel axes and the indexing, a channel axis gap counts just the same as axes.
- Ensure that a geometry axis is not assigned to a channel axis, that is not assigned to a machine axis (channel axis gap). \textit{No} alarm is displayed.
- Transformation: When configuring a channel axis in the following machine data, which is not assigned a machine axis (channel axis gap), an alarm is output:
  - MD24110 ff. \( $MC\_TRAFO\_AXES\_IN1...8 \)
  - MD24120 ff. \( $MC\_TRAFO\_GEOAX\_ASSIGN\_TAB1...8 \)

Example

The 5th channel axis "B" in MD20070 is not assigned to a machine axis.

If channel axis gaps are enabled, six machine axes (1 - 4, 5, 6) are available.

If channel axis gaps are not enabled, then there are four machine axes (1 - 4) available.
### 7.6 Configuring machine axes

#### 7.6.2 Axis names

**Machine axes**

Each machine axis, channel axis and geometry axis is assigned an individual name that clearly identifies the axis. Machine axis names must be unambiguous for the entire NC. The name of the machine axes are defined via the following machine date:

MD10000 $MN_AXCONF_MACHAX_NAME_TAB[n]$ (machine axis name)

The specified names and the associated index are used in the following cases:

- Accessing axis-specific machine data (loading, saving, displaying)
- Reference point approach from the parts program G74
- Measuring
- Test point traversing from the parts program G75
- Traversing the machine axis from the PLC
- Display of axis-specific alarms
- Display in the actual-value system (machine-related)
- DRF handwheel function

**Channel axes**

The name of the channel axes are defined via the following machine date:

MD20080 $MC_AXCONF_CHANAX_NAME_TAB[n]$ (name of the channel axis in the channel)

Channel axis names must be unambiguous for the entire channel.

**Geometry axes**

The names of the geometry axes must be absolutely unique throughout the channel, and are defined using the following machine data:

---

**Figure 7-5**  Axis configuration with channel axis gap
7.6 Configuring machine axes

7.6.3 Drive assignment

Drive assignment

The assignment of machine axes to the SERVO drive objects is realized using machine data.

3. Local machine axes
   MD10000 $MN_AXCONF_MACHAX_NAME_TAB[n]
   1st machine axis          [0] = "AX1"
   2nd machine axis          [1] = "AX2"
   3rd machine axis          [2] = "AX3"
   4th machine axis          [3] = "AX4"
   5th machine axis          [4] = "AX5"
   ...

2. Actual/setpoint channel of the machine axes
   MD30110 $MA_CTRLOUT_MODULE_NR[0][n]
   MD30220 $MA_ENC_MODULE_NR[0][n]

1. I/O addresses of the SERVO drive objects
   MD13050 $MN_DRIVE_LOGIC_ADDRESS[n]
   [0] = I/O address of the SERVO drive object
   [1] = I/O address of the SERVO drive object
   [2] = I/O address of the SERVO drive object
   [3] = I/O address of the SERVO drive object
   [4] = I/O address of the SERVO drive object
   ...

Figure 7-6 Drive assignment
Assignment:

1. Using this machine data, the NC is informed about the I/O addresses of the SERVO drive objects defined in the PLC project:
   MD13050 $MN_DRIVE_LOGIC_ADDRESS[n]

2. Using the following machine data, the setpoint and actual values of the machine axes are assigned to the relevant drive objects:
   - MD30110 $MA_CTRLOUT_MODULE_NR[0]
   - MD30220 $MA_ENC_MODULE_NR[0]
   The logical drive number m to be entered into both machine data, refers to the I/O address entered in ① under index n = (m - 1).

3. Using machine data MD10000 $MN_AXCONF_MACHAX_NAME_TAB, the machine axes in the NC are assigned a unique name. Index n addresses machine axis (n+1).
8.1 Machine and setting data

Setting machine data

Adaptation of the control at the machine is performed using the machine and setting data.

- The machine data (MD) is divided into the following areas:
  - General machine data
  - Channel-specific machine data
  - Axis-specific machine data
  - Parameters for the Control Unit
  - Parameter for the infeed
  - Drive parameters
- The setting data (SD) is divided into the following areas:
  - General setting data
  - Channel-specific setting data
  - Axis-specific setting data

The following table provides an overview of the machine data and setting data areas:

<table>
<thead>
<tr>
<th>Range</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>from 9000 to 9999</td>
<td>Display machine data</td>
</tr>
<tr>
<td>from 10000 to 18999</td>
<td>General NC machine data</td>
</tr>
<tr>
<td>from 19000 to 19999</td>
<td>Reserved</td>
</tr>
<tr>
<td>from 20000 to 28999</td>
<td>Channel-specific machine data</td>
</tr>
<tr>
<td>from 29000 to 29999</td>
<td>Reserved</td>
</tr>
<tr>
<td>from 30000 to 38999</td>
<td>Axis-specific machine data</td>
</tr>
<tr>
<td>from 39000 to 39999</td>
<td>Reserved</td>
</tr>
<tr>
<td>from 41000 to 41999</td>
<td>General setting data</td>
</tr>
<tr>
<td>from 42000 to 42999</td>
<td>Channel-specific setting data</td>
</tr>
<tr>
<td>from 43000 to 43999</td>
<td>Axis-specific setting data</td>
</tr>
<tr>
<td>from 51000 to 51299</td>
<td>General configuration machine data</td>
</tr>
<tr>
<td>from 51300 to 51999</td>
<td>General cycle machine data</td>
</tr>
<tr>
<td>from 52000 to 52299</td>
<td>Channel-specific configuration machine data</td>
</tr>
<tr>
<td>from 52300 to 52999</td>
<td>Channel-specific cycle machine data</td>
</tr>
<tr>
<td>from 53000 to 53299</td>
<td>Axis-specific configuration machine data</td>
</tr>
<tr>
<td>from 53300 to 53999</td>
<td>Axis-specific cycle machine data</td>
</tr>
</tbody>
</table>
The SINUMERIK Operate Online Help provides a context-related description of the machine data and setting data.

**Effectiveness**

The effectiveness of a machine data item specifies when the change becomes active:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>po</td>
<td>The changed machine data require an &quot;NCK Reset&quot; to become effective.</td>
</tr>
<tr>
<td>re</td>
<td>The changed machine data must be activated by pressing the &lt;RESET&gt; key.</td>
</tr>
<tr>
<td>cf</td>
<td>The changed machine data must be activated by pressing the &quot;Apply MD&quot; softkey.</td>
</tr>
<tr>
<td>so</td>
<td>The changed machine data becomes active immediately.</td>
</tr>
</tbody>
</table>

Changes to the setting data always take effect **immediately**.

## 8.2 Procedure when commissioning the NC

### NC commissioning

We recommend the following sequence when commissioning the NC:

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>① Parameter sets of axis/spindle</td>
<td>Velocities, setpoint/actual value systems, closed-loop control&lt;br&gt;Spindles</td>
</tr>
<tr>
<td>② Axis configuration</td>
<td>Axes, coordinate systems, frames&lt;br&gt;Synchronous spindles&lt;br&gt;Rotary axes&lt;br&gt;Compensations</td>
</tr>
<tr>
<td>③ Parameterizing axis data:</td>
<td>Velocities, setpoint/actual value systems, closed-loop control&lt;br&gt;Setpoint/actual value system → Actual value resolution&lt;br&gt;Setpoint/actual value system → Actual value resolution&lt;br&gt;Setpoint/actual value system → Actual value resolution&lt;br&gt;Setpoint/actual value system&lt;br&gt;Tuning of the control&lt;br&gt;Rotary axes&lt;br&gt;Positioning axes&lt;br&gt;Closed-loop control&lt;br&gt;Closed-loop control&lt;br&gt;Velocities&lt;br&gt;Axis monitoring, protection zones&lt;br&gt;Axis monitoring, protection zones</td>
</tr>
<tr>
<td>④ Parameterizing the spindle data:</td>
<td>Spindles&lt;br&gt;Setpoint/actual value system&lt;br&gt;Setpoint/actual value system&lt;br&gt;Gerstages for spindles and gear change change&lt;br&gt;Gerstages for spindles and gear change change&lt;br&gt;Spindle modes &gt; Axis mode&lt;br&gt;Reference / synchronize&lt;br&gt;Spindle monitoring</td>
</tr>
<tr>
<td>⑤ Referencing axis/spindle:</td>
<td>Reference point approach&lt;br&gt;Referencing with incremental measurement systems&lt;br&gt;Referencing with distance-coded reference marks&lt;br&gt;Referencing with absolute encoders</td>
</tr>
<tr>
<td></td>
<td>Incremental measuring system&lt;br&gt;Distance-coded reference marks&lt;br&gt;Absolute encoder homing</td>
</tr>
</tbody>
</table>
References:

  Function Manual
  - Axes, coordinate systems, frames
  - Various NC/PLC interface signals and functions
  - Axis monitoring functions
  - Compensations
  Function Manual
  - Velocities, setpoint/actual value systems, closed-loop control
  - Positioning axes
  - Homing
  - Spindles
  - Synchronous spindle

Setting the technology

User views are lists of machine data and setting data that are compiled for a special application. In order to set all the technology-relevant data for a turning machine or milling machine on the control, the following user views are available to facilitate the commissioning:

- Setup_Milling
- Setup_Turning

The files are stored on the CompactFlash card under:
/user/sinumerik/hmi/template/user_views/param

8.3 Memory configuration

Requirement

A dialog is provided in the "Commissioning" → "NC" → "NC memory" operating area which
supports you when partitioning the NC memory. The "Service" access level is required for this.

Memory division

The memory-configuring NC machine data is divided into various function areas, such as tool
management, user data, zero offsets and memory types. The graphic with the following legend
shows the division of the individual data areas:

- Global user data (GUD)
- Local user data (LUD)
- Macros
- R variables
- Basic tools
- Tool management
- Frames
- Compensations
- Curve tables
- Protection areas
- Cycles
- File system
- REORG
- Interpolation buffer
- Execution from external source
- Synchronous actions

The following memory expansions are available as licensed software option:

- Additional 2 MB CNC user memory (6FC5800-0AD00-0YB0)
- Additional PLC user memory (6FC5800-0AD10-0YB0)
- Execution from external storage (EES) (6FC5800-0AN75-0YB0)
- Expanded CNC user memory (6FC5800-0AN77-0YB0)
- Additional user memory on the CompactFlash card of the NCU (6FC5800-0AP12-0YB0)
8.4 Friction compensation with adaptive characteristics

Conditions

Only those axes are listed for friction compensation for which MD32490 = 3 or 4 is set.

<table>
<thead>
<tr>
<th>Machine data</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32500 $MA_FRICT_COMP_ENABLE = 1</td>
<td>Enable friction compensation for this axis</td>
</tr>
<tr>
<td>Friction compensation with adaptive characteristics:</td>
<td></td>
</tr>
<tr>
<td>MD32490 $MA_FRICT_COMP_MODE = 3</td>
<td>Injection time depends on the velocity setpoint</td>
</tr>
<tr>
<td>MD32490 $MA_FRICT_COMP_MODE = 4</td>
<td>Injection time depends on the position controller output</td>
</tr>
</tbody>
</table>

Software option

In order to use this function a license is required for the following option:

"Friction compensation with adaptive characteristics" (6FC5800-0_S06-0YB0)

Call the function at the control in the "Commissioning" → softkey "Friction compensation" operating area: The softkey is not shown until the option has been set.

Backing up tuning results

When tuning, the axis machine data are changed as follows during the measuring series:

- When a measurement series is started, the friction compensation values in the axis machine data are reset.
- When the measurement series is exited, the new friction compensation values are written to the axis machine data and backed up.
- When the measurement series is canceled, the previous friction compensation values are restored in the machine data.

NOTICE

Backing up tuning results

If the power fails during the tuning process, tuning result data can be lost.

⇒ SINUMERIK 840D sl: In order to avoid that tuning results are lost, it is recommended that you create a commissioning archive with NC data that contains the axis machine data of the last complete measurement series. You do not have to select the "With compensation data" option.

⇒ SINUMERIK 828D: In order to avoid that tuning results are lost, it is recommended that you create a data class archive of the type "INDIVIDUAL" that contains the friction compensation data of the last complete measurement series.

Additional information is provided in Chapter "Compensations" in the "Monitoring and Compensating" Function Manual.
8.4.1 Axis selection and status display

What is displayed in this dialog?

In the dialog "Axis selection for automatic tuning", for each channel, select the axes for automatic friction compensation.

**Automatic tuning:**

**Before starting** automatic tuning:

For Automatic tuning, in a channel, select several axes that should be automatically tuned one after the other. The automatic tuning for the selected axes is started for each channel.

**Status display:**

The following status data is displayed while tuning:

- "waits" for the selected axes, where tuning has still not been started.
- "being tuned" for the axis that is presently being tuned.
- "tuned" for axes, where tuning has already been successfully completed and saved.

---

**Note**

**Time required (radius, feedrates)**

The time required for the automatic tuning is obtained from the selected feedrates and the radius: Align the feedrates in the channel setting data (Page 242) for the tuning of the axes to the machining velocities of the machine.

---

**After completing** automatic tuning:

To visualize the measurement results, for the automatic tuning process, after each step, the tuning result is saved as screenshot under the following path: ..:/user/sinumerik/hmi/data/cst

When tuning an axis, the resolution for the screenshots is the same for all feedrates, and is not selected less than 1 μm.

After completing tuning of an axis in the channel, the compensation values are written to the axis machine data and the status display updated.

**Tuning quality:**

The displayed maximum deviation can vary when repeating the tuning process at the same axis. If, after measurement, the deviation for a feedrate has not improved when compared to the initial state, compensation values are not written to the axis machine data.
Commissioning archive:
The tuning results in the axis machine data and also the tuning status of the axes are backed up in the "NC data" commissioning archive. If the commissioning archive with the tuning data from machine A is read into machine B, then the NC data are completely read in.

- The axis machine data is read in and becomes effective.
- The axis tuning status is read in. Only when selecting the "Friction compensation" dialog, as a result of the different serial numbers of the system CompactFlash card, you will be prompted to accept or reject the tuning status.

General conditions for the commissioning sequence:

- For a feed override not equal to 100 %, the selected axis traverses with the reduced feed. The tuning (automatic and manual) is held, and the circular representation is suppressed until the feed override has been again set to 100%.
- The computational resolution in MD10200 $MN_INT_INCR_PER_MM and MD10210 $MN_INT_INCR_PER_DEG must be at least 10000.
- Tuning is not started if, for the selected axes, the following machine data cannot have a value of 0:
  - MD32450 $MA_BACKLASH
  - MD32456 $MA_BACKLASH_DYN
  - MD32572 $MA_FRICT_V_PULSE_DELAY_TIME
  - MD32575 $MA_FRICT_V_PULSE_SMOOTH_TIME
  - MD32578 $MA_FRICT_T_PULSE_SMOOTH_TIME
  - MD32579 $MA_FRICT_PRETRIGGER_TIME

Manual tuning:
To start manual tuning press the "Manual tuning" softkey. In the next dialog, select the axes that you wish to tune.

After completing tuning for an axis in the channel, the compensation values are written to the axis machine data and the status display updated.

⇒ Further actions:
- "Start" softkey to start automatic friction compensation.
- "Manual tuning >" softkey, to start friction compensation with manual input of the compensation values.
- "OK" softkey to confirm your selection.
- "Cancel" softkey to cancel the selection.

8.4.2 Friction compensation - automatic tuning

Operation on the SINUMERIK Operate
The axes selected in the particular channel are automatically traversed individually one after the other.
Procedure:

1. The radius and the feedrate for the measurements are preset in the following channel setting data and apply for all axes in the channel.

<table>
<thead>
<tr>
<th>Designation</th>
<th>Unit</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius (linear axis)</td>
<td>mm</td>
<td>SD55820 $SCS_FRICT_OPT_RADIUS</td>
</tr>
<tr>
<td>Radius (rotary axis)</td>
<td>° (degrees)</td>
<td>SD55821 $SCS_FRICT_OPT_RADIUS_ROT</td>
</tr>
<tr>
<td>Feedrate (linear axis)</td>
<td>[mm/min]</td>
<td>SD55822 $SCS_FRICT_OPT_FEED[0...8]</td>
</tr>
<tr>
<td>Feedrate (rotary axis)</td>
<td>[°/min]</td>
<td>SD55823 $SCS_FRICT_OPT_FEED_ROT[0...8]</td>
</tr>
</tbody>
</table>

2. Press the "Start" softkey to start measurements. A part program is then automatically generated; this is done by calling CYCLE790 which reverses the axis with the preset feedrate. Before the part program is started, a check is made as to whether the entered feedrates can be achieved based on the dynamic response of the axis. If feedrates are selected to be too high, a message is output that the feedrates should be reduced.

3. If the entered feedrates have been successfully tested and found to be OK, the part program is opened in order to add additional program instructions. Confirm with "OK" to close the window and continue.

On completion of the tuning of an axis in the channel, the compensation values are saved in the axis machine data and the status display is updated. The next axis is then automatically tuned in this channel.

**Note**

**Gantry axis grouping**

For a gantry axis grouping, only the guide axis is displayed. On completion of the tuning, the compensation values of the guide axis are copied to the synchronous axes.

⇒ Further actions:

- "Start" softkey to start tuning.
- "Graphic" softkey to change to the graphic display.
- "Data list" softkey to switch to the list of axis machine data and channel setting data.
- "Cancel" softkey to cancel tuning.

### 8.4.3 Friction compensation - manual tuning

**Operation on the SINUMERIK Operate**

With this function, you can optionally traverse one or two axes. The measurement is graphically displayed as circle diagram. The values entered for the friction compensation only apply to the axis which is selected in the header line.

The scaling in the graphic display is adapted automatically as long as a scaling value is not entered manually. Up to nine measurements with different feedrates can be performed in one pass. With 1-axis and 2-axis traversing, the upper and the lower reversal points are relevant for
tuning. The measurement consists of an initialization phase and the actual measuring process. The current status is displayed at the bottom right in the status line via a progress indicator.

Procedure:

1. Press the "Axis +" or "Axis -" softkey to select the axis for which you activated friction compensation. The radius, the feedrate and the direction of rotation for the measurements are preset in the following channel setting data and apply for all axes in the channel. They can be adapted by pressing the "Data list" softkey:

<table>
<thead>
<tr>
<th>Designation</th>
<th>Unit</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radius (linear axis)</td>
<td>mm</td>
<td>SD55820 $SCS_FRICT_OPT_RADIUS</td>
</tr>
<tr>
<td>Radius (rotary axis)</td>
<td>° (degrees)</td>
<td>SD55821 $SCS_FRICT_OPT_RADIUS_ROT</td>
</tr>
<tr>
<td>Feedrate (linear axis)</td>
<td>[mm/min]</td>
<td>SD55822 $SCS_FRICT_OPT_FEED[0...8]</td>
</tr>
<tr>
<td>Feedrate (rotary axis)</td>
<td>[°/min]</td>
<td>SD55823 $SCS_FRICT_OPT_FEED_ROT[0...8]</td>
</tr>
<tr>
<td>Direction of rotation (only active for two axes)</td>
<td>---</td>
<td>SD55828 $SCS_FRICT_OPT_DIR</td>
</tr>
</tbody>
</table>

2. To start the measurement, press the "Start" softkey. A part program is then automatically generated and selected by the NC; this is done by calling CYCLE790 which reverses the axis with the preset feedrate. Before the part program is started, a check is made as to whether the entered feedrates can be achieved based on the dynamic response of the axis. If this is not the case, a message is issued to reduce the feedrates.

3. The part program for the measurement series is then opened if you want to add further commands. Confirm with "OK" to close the window and continue.

4. Press the NC Start key to start tuning.
5. The first step with the first feedrate of the measurement series is selected. Enter the friction compensation values in the following entry fields:

<table>
<thead>
<tr>
<th>Input field</th>
<th>Unit</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplitude</td>
<td>[mm/min] or [°/min]</td>
<td>MD32571 $MA_FRICT_VELO_STEP</td>
</tr>
<tr>
<td>Decay time</td>
<td>[s]</td>
<td>MD32574 $MA_FRICT_V_PULSE_DECAY_TIME</td>
</tr>
<tr>
<td>Active time</td>
<td>[s]</td>
<td>MD32573 $MA_FRICT_V_PULSE_CONST_TIME</td>
</tr>
</tbody>
</table>

For both traversing directions, as default setting, the same compensation values are entered. By selecting the option “Set reversal points separately”, you can enter different compensation values for an axis, depending on the particular traversing direction.

6. Press the "Next step" softkey to start a new measurement with the next feedrate and enter new values. If the measurement is repeated, the values appropriate for the feedrate from the last measurement are proposed.

After the last step, the measuring series is terminated with "OK" and the data is saved.

**Note**

**Incremental value change**

Use the following shortcut keys to change the compensation values incrementally:

- The selected entry field is activated with the <INSERT> key, and the color changes.
- The values are changed with different increments with the <Page Up> / <Page Down> keys and the ↑↓ cursor keys.
- End the input with the <INPUT> key.

⇒ **Further actions:**

- "Axis +“ or "Axis -“ softkey to select the axis for which the friction compensation is activated.
- "Start" softkey to start the measurement.
- "Next step" softkey to select the next feedrate.
8.4 Friction compensation with adaptive characteristics

- "Previous step" softkey to return to the previous feedrate.
- "Data list" softkey to switch to the list of machine data.
- "Cancel" softkey to cancel the recording and reject the entries.
- "OK" softkey to accept the values determined during the friction compensation.

8.4.4 Data list

In the data list, **axis machine data** and **channel setting data** are displayed, which are relevant for "Friction compensation with adaptive characteristics".

The values can be modified before the start. Changes cannot be made while tuning.

To start tuning with fewer than nine steps, overwrite the feedrates that are not required in the channel setting data MD55822 $SCS_FRICT_OPT_FEED and MD55823 $SCS_FRICT_OPT_FEED_ROT with zero without any gaps. If, after a feedrate = 0, a value ≠ 0 is found, then the procedure is canceled.

The following also applies: MD55822[0] ≠ 0 and MD55823[0] ≠ 0

⇒ **Further actions:**

Softkey "<<" to return to the "Friction compensation" dialog.

8.4.5 Example for a linear axis (automatic tuning)

**Requirement**

The machine data for activating the friction compensation is set for the Y axis:

- MD32490 = 3
- MD32510 = 1

The Y axis is measured with the following settings:

- Radius 5 mm in SD55820 $SCS_FRICT_OPT_RADIUS
- Feedrates in SD55822[n] $SCS_FRICT_OPT_FEED
- The active time is not adapted.

**Result of the Y axis**

<table>
<thead>
<tr>
<th>Step</th>
<th>Feedrate</th>
<th>Amplitude</th>
<th>Decay time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>700 mm/min</td>
<td>68.696 mm/min</td>
<td>0.017 s</td>
</tr>
<tr>
<td>2</td>
<td>560 mm/min</td>
<td>66.240 mm/min</td>
<td>0.017 s</td>
</tr>
<tr>
<td>3</td>
<td>350 mm/min</td>
<td>43.330 mm/min</td>
<td>0.021 s</td>
</tr>
</tbody>
</table>
### 8.4 Friction compensation with adaptive characteristics

| Step 4 of 8: 140 mm/min | Amplitude: 23.848 mm/min  
Decay time: 0.038 s |
|-------------------------|--------------------------|
| Step 5 of 8: 1060 mm/min | Amplitude: 84.688 mm/min  
Decay time: 0.015 s |
| Step 6 of 8: 1410 mm/min | Amplitude: 90.018 mm/min  
Decay time: 0.014 s |
| Step 7 of 8: 1770 mm/min | Amplitude: 109.839 mm/min  
Decay time: 0.012 s |
| Step 8 of 8: 2120 mm/min | Amplitude: 123.012 mm/min  
Decay time: 0.009 s |

The following characteristics show the amplitude and the decay time for different acceleration levels:

![Graph showing friction compensation with adaptive characteristics](image-url)

[LaTeX code for the graph is provided here]
8.4.6 Friction compensation with torque injection pulse

Parameterizing machine data

The following axis machine data must be parameterized in order to use an acceleration-dependent torque injection pulse also for friction compensation:

<table>
<thead>
<tr>
<th>Designation</th>
<th>Unit</th>
<th>Machine data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceleration-dependent amplitude of the</td>
<td>---</td>
<td>MD32576 $MA_FRICT_TORQUE_STEP</td>
</tr>
<tr>
<td>torque injection pulse</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay time of the torque injection pulse</td>
<td>[s]</td>
<td>MD32577 $MA_FRICT_T_PULSE_DELAY_TIME</td>
</tr>
<tr>
<td>Ramp-up time of the torque injection pulse</td>
<td>[s]</td>
<td>MD32578 $MA_FRICT_T_PULSE_SMOOTH_TIME</td>
</tr>
<tr>
<td>Weighting factor for the amplitude of the</td>
<td>---</td>
<td>MD32588 $MA_FRICT_T_STEP[0...9]</td>
</tr>
<tr>
<td>torque injection pulse</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Enter a factor between -1.0 and 1.0 in MD32588 $MA_FRICT_T_STEP[0...9] for each acceleration value in order to weight the amplitude of the torque injection pulse.
8.5 Nodding compensation

8.5.1 Measuring technique and machine data

Benefits

The nodding compensation enhances precision for machining of the workpiece by compensating for compliance within the machine and is beneficial for traveling column machines, for example, in that it improves machining accuracy and surface quality.

Software option

You need licenses for the following options in order to use this function:

- To tune a machine axis with a compensation relationship and position-dependent adaptation:
  "Nodding compensation ECO" (6FC5800-0_S20-0YB0)
- For the optimization of more than one compensation relationship:
  "Nodding compensation ADVANCED" (6FC5800-0_S21-0YB0)

Call the function at the control in the "Commissioning" → softkey "NC" → softkey "Nodding compensation" operating area. The softkey is not shown until the option has been set.

Example

Nodding motion in the Z axis when accelerating in the X axis:

Definition of compliance

From the acceleration or deceleration of an axis as the cause for nodding - and the deviation of an axis as compliance at the position - a factor can be determined, which describes the interrelationship between the accelerating or decelerating axis motion, and the position deviation in the compensated axis. No mass is included in the calculation. The compliance factor is the inverse value of the stiffness.
Measuring procedure

There are two techniques that can be selected for determining compliance:

- **Milling standardized workpiece and selecting the optimum milling path**
  For a standardized workpiece, a cycle is available to mill several milling paths with different compliance factors. The compliance factor can be empirically determined based on the workpiece surface quality.
  For the cycle settings, you can also select face milling for the workpiece in order to carry out several tests with different compliance factors on one workpiece.

- **Determining positional deviations using a probe**
  The position deviation is precisely measured at different positions. Based on this, the compliance factor can be calculated once the acceleration or deceleration that has been achieved is known.

Machine data

Axis machine data for nodding compensation:

<table>
<thead>
<tr>
<th>Number</th>
<th>Name</th>
<th>Effect</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD37302</td>
<td>$MA_{NOCO_FILTER_TIME}$</td>
<td>Time constant for smoothing nodding compensation values</td>
<td>[s]</td>
</tr>
<tr>
<td>MD37310</td>
<td>$MA_{NOCO_INPUT_AX_1}$</td>
<td>Machine axis, which causes nodding motion</td>
<td>[1...31]</td>
</tr>
<tr>
<td>MD37320</td>
<td>$MA_{NOCO_INPUT_AX_2}$</td>
<td>Machine axis, which causes nodding motion</td>
<td>[1...31]</td>
</tr>
<tr>
<td>MD37330</td>
<td>$MA_{NOCO_INPUT_AX_3}$</td>
<td>Machine axis, which causes nodding motion</td>
<td>[1...31]</td>
</tr>
<tr>
<td>MD37312</td>
<td>$MA_{NOCO_ADAPT_AX_1}$</td>
<td>Machine axis, whose position influences nodding motion</td>
<td>[1...31]</td>
</tr>
<tr>
<td>MD37322</td>
<td>$MA_{NOCO_ADAPT_AX_2}$</td>
<td>Machine axis, whose position influences nodding motion</td>
<td>[1...31]</td>
</tr>
<tr>
<td>MD37332</td>
<td>$MA_{NOCO_ADAPT_AX_3}$</td>
<td>Machine axis, whose position influences nodding motion</td>
<td>[1...31]</td>
</tr>
<tr>
<td>MD37314</td>
<td>$MA_{NOCO_ADAPT_NUM_AX_1}$</td>
<td>Number of positions of the adaptation characteristic of nodding compensation</td>
<td>[1...3]</td>
</tr>
<tr>
<td>MD37324</td>
<td>$MA_{NOCO_ADAPT_NUM_AX_2}$</td>
<td>Number of positions of the adaptation characteristic of nodding compensation</td>
<td>[1...3]</td>
</tr>
<tr>
<td>MD37334</td>
<td>$MA_{NOCO_ADAPT_NUM_AX_3}$</td>
<td>Number of positions of the adaptation characteristic of nodding compensation</td>
<td>[1...3]</td>
</tr>
<tr>
<td>MD37316</td>
<td>$MA_{NOCO_ADAPT_POS_AX_1}$</td>
<td>Positions of the adaptation characteristic of nodding compensation</td>
<td>[mm]</td>
</tr>
<tr>
<td>MD37326</td>
<td>$MA_{NOCO_ADAPT_POS_AX_2}$</td>
<td>Positions of the adaptation characteristic of nodding compensation</td>
<td>[mm]</td>
</tr>
<tr>
<td>MD37336</td>
<td>$MA_{NOCO_ADAPT_POS_AX_3}$</td>
<td>Positions of the adaptation characteristic of nodding compensation</td>
<td>[mm]</td>
</tr>
<tr>
<td>MD37318</td>
<td>$MA_{NOCO_COMPLIANCE_1}$</td>
<td>Nodding compensation compliance factor</td>
<td>[s^2]</td>
</tr>
<tr>
<td>MD37328</td>
<td>$MA_{NOCO_COMPLIANCE_2}$</td>
<td>Nodding compensation compliance factor</td>
<td>[s^2]</td>
</tr>
<tr>
<td>MD37338</td>
<td>$MA_{NOCO_COMPLIANCE_3}$</td>
<td>Nodding compensation compliance factor</td>
<td>[s^2]</td>
</tr>
</tbody>
</table>

8.5.2 Nodding compensation - overview

What is displayed in this dialog?

A summary of the following data is provided in the "Nodding compensation" overview:

- Accelerating axis: Axis, which results in nodding motion.
- Compensated axis: Machine axis, whose nodding motion is compensated.
- Adaptation axis: Machine axis, whose position influences nodding motion.
- Position [mm] on the adaptation axis
- Factor for compliance [μm / m/s²]

Supplementary conditions:

- Inadmissible entries are color-coded in the table in the "Nodding compensation - overview" dialog. An explanation is output in the message line below the table.
- A rotary axis is not permissible as accelerating axis, compensated axis or adaptation axis.
- For a gantry axis grouping, only the guide axis is listed. On completion of the tuning, a query is made whether the compensation values of the guide axis are copied to the synchronous axes.
- In order that the "Nodding compensation" function may also be used for rotary axes, the following option is required: RMCC/NOCO nodding compensation (6FC5800-0AN63-0YB0). This option is not part of this description - and is not displayed in this dialog.

⇒ additional actions:

- "New" softkey to create a new compensation:
  - Mill test part
  - Enter manually
- Softkey "Change", to change the compliance and position dependency of the axes involved.
- Softkey Deactivate/activate, to deactivate existing compensation relationships and reactivate them again.
- "Delete" softkey, to delete all values in the machine data of this compensation relationship:
Activating/deactivating nodding compensation

To analyze the effect of the nodding compensation on the machining, you can deactivate individual or all compensation relationships without deleting the original parameterization. Deactivation is useful for the following applications:

- **Diagnostics and problem analysis:**
  The effect of a specific compensation relationship on the workpiece surface should be tested. Because a superimposition of compensation relationships from different axes and different compensation relationships is possible, the effect of an individual or all successive compensation relationships should be tested. For this purpose, the compensation is deactivated temporarily; the determined compliance values are retained.

- **Series commissioning:**
  The compensation values are loaded via the series commissioning archive and can be deactivated during the machine tuning, to tune the machine without the effect of the nodding compensation. On completion of the tuning, the compensation values are reactivated. As check, a test part can be milled.

**Procedure:**

1. In the "Nodding compensation - Overview" select the "Deactivate/activate" softkey to deactivate the compensation relationships.
2. Select the individual compensation relationships or select the "Deactivate all" softkey.
3. The "Back" softkey returns you to the "Nodding compensation - Overview".
4. If the nodding compensation should act again, reset the deactivated compensation relationships to the "active" status.

The compensation relationships are deactivated bit-by-bit in MD37300 $MA_NOCO_ENABLE.

8.5.3 Determining compliance from the best milling path

**Measuring technique: Best milling path**

For a standardized workpiece, a cycle is available to mill several milling paths with different compliance factors. The necessary compliance factor can be empirically determined based on the surface quality of the milled workpiece.

**Note**

**Active transformation**

In order to guarantee a fault-free cycle sequence, active transformations are to be deactivated before starting the cycle.
For the cycle settings, you can also select face milling for the workpiece in order to carry out several tests with different compliance factors on one workpiece.

<table>
<thead>
<tr>
<th>Accelerating axis:</th>
<th>Geometry axes X, Y, Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compensated axis:</td>
<td>Machining plane G17: Z axis</td>
</tr>
<tr>
<td>Type of machining:</td>
<td>[no] path milling only [yes] face milling and path milling</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>RP</td>
<td>Retraction plane [abs]</td>
<td>[mm]</td>
</tr>
<tr>
<td>SC</td>
<td>Safety clearance [inc]</td>
<td>[mm]</td>
</tr>
<tr>
<td>F</td>
<td>Path milling feedrate</td>
<td>[mm/min]</td>
</tr>
<tr>
<td>FA</td>
<td>Face milling feedrate</td>
<td>[mm/min]</td>
</tr>
<tr>
<td>X0</td>
<td>Corner point 1 X [abs]</td>
<td>[mm]</td>
</tr>
<tr>
<td>Y0</td>
<td>Corner point 1 Y [abs]</td>
<td>[mm]</td>
</tr>
<tr>
<td>Z0</td>
<td>Height of blank [abs]</td>
<td>[mm]</td>
</tr>
<tr>
<td>X1</td>
<td>Corner point 2 in relation to X0 [inc.]</td>
<td>[mm]</td>
</tr>
<tr>
<td>Y1</td>
<td>Corner point 2 in relation to Y0 [inc.]</td>
<td>[mm]</td>
</tr>
<tr>
<td>Z1</td>
<td>Feed depth for face milling in relation to Z0 [inc.]</td>
<td>[mm]</td>
</tr>
<tr>
<td>Z2</td>
<td>without face milling: Feed depth for path milling in relation to Z0 [inc.]</td>
<td>[mm]</td>
</tr>
<tr>
<td></td>
<td>with face milling: Feed depth for path milling in relation to Z1 [inc.]</td>
<td>[mm]</td>
</tr>
<tr>
<td>N</td>
<td>Number of milling paths</td>
<td>---</td>
</tr>
<tr>
<td>Minimum value of the compliance factor</td>
<td>[μm / m/s²]</td>
<td></td>
</tr>
<tr>
<td>Maximum value of the compliance factor</td>
<td>[μm / m/s²]</td>
<td></td>
</tr>
<tr>
<td>Compliance factor of the best milling path</td>
<td>[μm / m/s²]</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

**Test run before machining**

To perform a test run before machining, enter a suitable value for the infeed depth.

### 8.5.4 Nodding compensation - manually enter

**Entering compensation data**

For the manual input of the compliance factor, all degrees of freedom in the compensation relationships between accelerating and compensated axes are possible. Further, position-dependent adaptation values can be entered at the user interface.
Procedure without adaptation:
1. Select first the accelerating axis and then the compensated axis. This can also be the same axis.
2. If no position dependency exists, then accept the default setting "No".
3. Enter the compliance factor.

Procedure with adaptation:
1. Select first the accelerating axis and then the compensated axis. This can also be the same axis.
2. If a position dependency exists, select "Yes" and then the adaption axis.
3. Then enter the number of interpolation points and the respective compliance factor for each interpolation point.

In this dialog you can subsequently change the compliance and the position dependency for the configured axes.

### 8.5.5 Determining compliance using a probe

#### Preconditions

If not yet already available, create a commissioning archive with the drive data and connect the probe to a free DRIVE-CLiQ interface (Page 197). Only linear measuring systems are permitted as probes.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Deactivate Safety Integrated temporarily</strong></td>
</tr>
<tr>
<td>If axes still have Safety Integrated activated, a message is displayed to inform you that Safety Integrated must be deactivated in order to configure the probe.</td>
</tr>
<tr>
<td>Following configuration of the probe, Safety Integrated must be activated once again.</td>
</tr>
</tbody>
</table>

#### Initiating trace recording

Procedure:
1. Select "Trace: Yes" to determine the compliance factor of the selected axis using a probe.
2. Select the measuring system for the encoder position actual value:
   ⇒ Select the drive to which the probe is connected, for example SERVO_3.3:6
   ⇒ Select an encoder, for example "Encoder 3".
3. Create a part program which comprises the following components:
   - Trigger tag $AN_CUTRACE
   - Dwell time of at least 200 ms in order that the offset of the probe can be taken into consideration in the graphic representation.
   - Traversing with constant velocity.
   - The accelerating axis is accelerated to at least 1 m/s².

Example:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SOFT</td>
<td>; acceleration with active jerk limitation</td>
</tr>
<tr>
<td>DYNORM</td>
<td>; G command for activating the normal dynamic response</td>
</tr>
<tr>
<td>$AN_CUTRACE=1</td>
<td>; trigger tag</td>
</tr>
<tr>
<td>G4 F0.2</td>
<td>; Dwell time</td>
</tr>
<tr>
<td>G91 G01 F200000 Y-50</td>
<td>; relative traversing motion with programmed feed</td>
</tr>
<tr>
<td>G4 F0.5</td>
<td>; Dwell time</td>
</tr>
<tr>
<td>Y50</td>
<td>; traversing motion</td>
</tr>
<tr>
<td>G4 F0.5</td>
<td>; Dwell time</td>
</tr>
<tr>
<td>M30</td>
<td>; End of program</td>
</tr>
</tbody>
</table>

4. Initiate the trace recording with the "Start trace" softkey. Then initiate the part program with <NC-Start>.

   **Note**
   **Starting the trace**
   Once trace recording has been initiated by the trigger in the part program, it is no longer possible to cancel the recording process.

5. As soon as recording is complete, the following data is displayed in a graphic representation:
   - Encoder position actual value (p0479) of the probe
   - Acceleration of the accelerating axis

6. Enter the compliance factor (positional deviation/acceleration) and repeat the measurement. To clarify the effect of the compliance factor against the first measurement, scaling of the graphic following the first measurement is retained.

7. Once you have determined the optimum compliance factor for the axis, rescaling of the graphic can be performed with the "Rescale" softkey.

8. As soon as the compliance factor is changed, the measurement must be repeated for verification. Only then will the "Accept" softkey become active.

   ⇒ additional actions:
   - "Start trace" softkey to initiate recording of the trace.
   - "Rescale" softkey to automatically scale the graphic.
   - "Cancel" softkey to return to the overview display without any modifications.
   - "Accept" softkey to adopt the new compliance values.
8.5.6 Example: Traveling column machine

Before tuning

The nodding motion of the Z axis when traversing in the Y direction is measured with a probe:
After tuning

Measurement with a compliance value of 20 μm:
8.6 Adaptations

8.6.1 Intelligent load adjustment – function

Benefits
The "Intelligent load adjustment" function is used to optimize the following characteristics of a machine tool by adapting dynamic response and control parameters:

- Shorter machining times
- Increased dynamic response
- Greater accuracy
- Enhanced precision

The machine manufacturer is supported in the commissioning of the function by dialogs on the user interface: "Commissioning" → softkey "NC" → Menu forward key → softkey "Adaptations" operating area. The softkey is shown after setting the option, and only for the "Manufacturer" access level.

Precondition

Software option
In order to use this function a license is required for the following option:
"Intelligent load adjustment" (6FC5800-0_S11-0YB0)

Function description

The "Intelligent load adjustment" function adjusts the dynamic response and control parameters to the current value of the moment of inertia or the mass of the axis. Adaptations are switched on and off by means of CYCLE782.

The following dynamic response and control parameters can be adapted:

- Acceleration: DYNNORM, DYNPOS, DYNROUGH, DYSEMIFIN, DYNFLUSH, DYNPREC
- Jerk: DYNNORM, DYNPOS, DYNROUGH, DYSEMIFIN, DYNFINISH, DYNPREC
- Servo gain factor (position controller gain)
8.6 Adaptations

- Torque feedforward control
- Drive adaptation factor 1 ... 4: A maximum of 4 drive variables from parameter p2782[0...3]
  "Mode adaptation" can be adapted.
  - Kp speed controller P gain adaptation speed
  - Tn speed controller integral time adaptation speed
  - Current setpoint filter 1 denominator and numerator
  - Current setpoint filter 2 denominator and numerator
  - Speed setpoint filter 1 denominator and numerator
  - Speed controller reference model natural frequency and damping
  - APC / APC ECO Tv (p3769)
  - APC / APC ECO filter (p3766)

Example:

For a rotary table with highly variable loading, the effective acceleration (DYNNORM) should be adapted to the current moment of inertia. The "Intelligent load adjustment" function is used to increase acceleration (DYNNORM) at minimal loading to 150%.

Acceleration (DYNNORM) [%]

\[ \begin{align*}
\text{with adaptation} & \quad 150 \\
\text{without adaptation} & \quad 100
\end{align*} \]

\[ \begin{align*}
J_{\text{min}} & \rightarrow \text{MD16506}[0] \, $MN_CADAPT_INPUT_VALUE_1 \\
J_{\text{max}} & \rightarrow \text{MD16507}[0] \, $MN_CADAPT_INPUT_VALUE_2 \\
150\% & \rightarrow \text{MD16508}[0] \, $MN_CADAPT_OUTPUT_VALUE_1 \\
100\% & \rightarrow \text{MD16509}[0] \, $MN_CADAPT_OUTPUT_VALUE_2
\end{align*} \]
Constraints

Please note the following supplementary conditions:

- The "Moment of inertia estimator" function module (bit r0108.30) can be used to determine the moment of inertia of the axis (Example).
- For the adaptation of the drive adaptation factors 1 ... 4, telegram (Page 220) 146, 148 or 149 is required.
- The "Controller parameter adaptation" function module (bit r0171.29) is activated.
- The following conditions apply to the adaptation of "APC / APC ECO Tv (p3769)" and "APC / APC ECO filter (p3766)"
  - A SINUMERIK license for the "Advanced Position Control" (6FC5800-0_M13-0YB0) option is required to use the "Advanced Position Control (APC)" function module (bit r0108.7) with SINUMERIK.
  - A SINUMERIK license for the "Advanced Position Control ECO" (6FC5800-0_M12-0YB0) option is required to use the "Active Vibration Suppression (AVS/APC-ECO)" function module (bit r0108.19) with SINUMERIK.

8.6.2 Intelligent dynamic response adjustment – function

Benefits

The "Intelligent dynamic response adjustment" function is used to optimize the following characteristics of a machine tool by adapting control parameters:

- Shorter machining times
- Increased dynamic response
- Greater accuracy
- Enhanced precision

The machine manufacturer is supported in the commissioning of the function by dialogs on the user interface: "Commissioning" → softkey "NC" → Menu forward key → softkey "Adaptations" operating area. The softkey is shown after setting the option, and only for the "Manufacturer" access level.

Precondition

Software option

In order to use this function a license is required for the following option:
"Intelligent dynamic response adjustment" (6FC5800-0_S23-0YB0)
Function description

The "Intelligent dynamic response adjustment" function adjusts the control parameters for axes with a stability that changes at different positions or at different traversing velocities as a function of the position or velocity.

The following control parameters can be adapted:

- Servo gain factor (position controller gain)
- Torque feedforward control
- Drive adaptation factor 1 ... 4: A maximum of 4 drive variables from parameter p2782[0...3] "Mode adaptation" can be adapted.
  - Kp speed controller P gain adaptation speed
  - Tn speed controller integral time adaptation speed
  - Current setpoint filter 1 denominator and numerator
  - Current setpoint filter 2 denominator and numerator
  - Speed setpoint filter 1 denominator and numerator
  - Speed controller reference model natural frequency and damping
  - APC / APC ECO Tv (p3769)
  - APC / APC ECO filter (p3766)

Constraints

Please note the following supplementary conditions:

- The associated input axis must be referenced for position-dependent adaptation.
- For the adaptation of the drive adaptation factors 1 ... 4, telegram (Page 220) 146, 148 or 149 is required.
- The "Controller parameter adaptation" function module (bit r0171.29) is activated.
- The following conditions apply to the adaptation of "APC / APC ECO Tv (p3769)" and "APC / APC ECO filter (p3766)":
  - A SINUMERIK license for the "Advanced Position Control" (6FC5800-0_M13-0YB0) option is required to use the "Advanced Position Control (APC)" function module (bit r0108.7) with SINUMERIK.
  - A SINUMERIK license for the "Advanced Position Control ECO" (6FC5800-0_M12-0YB0) option is required to use the "Active Vibration Suppression (AVS/APC-ECO)" function module (bit r0108.19) with SINUMERIK.
8.6.3 Commissioning the function

Basic procedure

The following procedure is recommended for commissioning the "Intelligent load adjustment" function:

- Set licensed SINUMERIK Option S11 for the "Intelligent load adjustment" function. The SINAMICS "Moment of inertia estimator" function module (bit r0108.30) can be used to determine the moment of inertia of the axis.
- Set licensed SINUMERIK Option S23 for the "Intelligent dynamic response adjustment" function.
- Enter the adaptation in the "Adaptations – Overview" dialog, "New >" softkey.
- Enable adaptation with "Reset (po)".

---

**Note**

**No adaptation active**

Without active adaptation, the dynamic response and control parameters in the machine data are effective.

---


The online help on SINUMERIK Operate shows you how to enter adaptations.
Adaptations – Overview

Example of an adaptation:

In this dialog, all adaptations are shown in a tabular overview.

The dynamic response and control parameters can be adjusted as functions of the following input variables:

- Moment of inertia
- Position
- Velocity

Inputting an adaptation writes the following machine data:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Input axis</th>
<th>Input variable</th>
<th>Input value</th>
<th>Output axis</th>
<th>Output variable</th>
<th>Output value</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td></td>
<td>Inertia [kgm²]</td>
<td>0.8880168</td>
<td></td>
<td>Acceleration</td>
<td>158.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.8880120</td>
<td></td>
<td>(DRYROUGH)</td>
<td>138.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.8880140</td>
<td></td>
<td></td>
<td>119.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.888160</td>
<td></td>
<td></td>
<td>119.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0.888168</td>
<td></td>
<td></td>
<td>100.9</td>
</tr>
</tbody>
</table>

⇒ Additional actions:

- Press the "New >" softkey to enter a new adaptation table.
- Press the "Change >" softkey to change values or the number of table rows.
- Press the "Filter >" softkey to filter the overview by individual columns.
8.6.4 Example: Enter an adaptation for acceleration

**Objective**

The acceleration (DYNROUGH) of the X axis should be adapted as a function of the moment of inertia of the X axis.

**Enter adaptation**

Procedure:
1. In the operating area, select "Commissioning" → "NC" → Menu forward key → "Adaptations" and then the "New >" softkey. The "Enter adaptation" dialog is opened.
2. Select the mode, and the X axis as input axis.
3. Select "Acceleration (DYNROUGH)" as output variable.
4. Expand the table to enter the following values:

<table>
<thead>
<tr>
<th>Input value [kgm^2]</th>
<th>Output value [%]</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. 0.010000</td>
<td>150.0</td>
</tr>
<tr>
<td>2. 0.012000</td>
<td>130.0</td>
</tr>
<tr>
<td>3. 0.014000</td>
<td>110.0</td>
</tr>
<tr>
<td>4. 0.016000</td>
<td>110.0</td>
</tr>
<tr>
<td>5. 0.018000</td>
<td>100.0</td>
</tr>
</tbody>
</table>

5. Press the "Accept" softkey to display the adaptation in the "Adaptations - Overview" dialog.
6. A "Reset (po)" is required to activate the values in the machine data.

**Rules for entering adaptations**

The input and output values of an adaptation table are only valid and written to the machine data with the "Accept" softkey if the adaptation table fulfills the following criteria:

- Output values less than 100% are not permissible for the output variable "acceleration".
- In a simple adaptation table, only one of the two input values is permitted to be zero.
- In a complex adaptation table, the first and last input values are permitted to be zero.
- In the event of changes, the input values must be entered into a complex adaptation table in ascending order.
The adaptation table is shown in the “Adaptations - Overview” dialog:
8.7 Jerk filter

8.7.1 Putting a jerk filter into operation

Benefits

Reducing the mechanical vibrations generated in the machine can enable a higher surface quality to be achieved. When milling freeform surfaces, it can be advantageous to smooth the position setpoint characteristics of the machine axes by means of a jerk filter. The parameterization of an axial jerk filter depends on the processing technology (dynamic response mode: DYNNORM, DYNPREF, DYNROUGH, DYNSMIFIN, DYNFINISH, DYNPREC) and has the following effect:

- Damping of machine vibrations
- Faster execution

Requirement

Software option

In order to use this function a license is required for the following option:

"Top Speed" (6FC5800-0_S13-0YB0)

The option includes the use of the FIR low pass filter type and the switchover of position setpoint filter ladders at axis standstill.

After the option is set, the "Jerk filter" softkey is displayed in the operating area "Commissioning" → Softkey "NC" → Menu forward key.

Function description

For movements outside the workpiece or during roughing, high axial jerk values can be used in combination with strong damping filters, thus significantly reducing the processing time. An FIR low pass is parameterized depending on the dynamic mode in order to achieve a different effect for the respective type of processing. For an FIR low pass, appropriate values for the frequency and tolerance are entered for each specific dynamic response mode.

Example: If, for DYNROUGH, value is placed on a minimum processing time and, for DYNPREC, value is placed on maximum processing accuracy, these requirements can be implemented with a FIR low pass.

The same values for the machine data are calculated and written for all axes in the channel for the active dynamic response mode in the part program. The CALCFIR instruction must be programmed after each changeover of the dynamic mode in order to explicitly activate the calculation for the FIR low pass.
Jerk filter commissioning

Support for commissioning with SINUMERIK Operate is provided for the following jerk filters:

- FIR low pass (dynamic mode)  
  MD32402 $MA_AX_JERK_MODE = 5
- Double moving average calculation  
  MD32402 $MA_AX_JERK_MODE = 4
- Moving average calculation  
  MD32402 $MA_AX_JERK_MODE = 2

The online help of SINUMERIK Operate supports you when entering jerk filters.


8.7.2 Entering new jerk filter

FIR low pass (dynamic mode)

Requirement:
The maximum axial jerk for a path movement in MD32431 $MA_MAX_AX_JERK lies in the range of 5 ... 500 m/s³ for the selected linear axis. If the value lies outside this range, alarm 21900 is pending for the affected axis.

Entering a new jerk filter:
Depending on the dynamic response mode, enter the following value for the selected axis:

- Frequency in the range from 10 ... 100 Hz
- Tolerance (only for linear axes) in the range of 0 to 0.05 mm

The following machine data is set active with the "Accept" softkey:

<table>
<thead>
<tr>
<th>MD32400 $MA_AX_JERK_ENABLE = 1</th>
<th>Axial jerk limitation</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32405 $MA_CALCFIR_FREQ</td>
<td>FIR low pass - frequency [Hz]</td>
</tr>
<tr>
<td>MD32406 $MA_CALCFIR_TOL</td>
<td>FIR low pass - tolerance [mm]</td>
</tr>
<tr>
<td>MD32404 $MA_CALCFIR_SELECT</td>
<td>FIR low pass - Calculation for the selected filter ladder</td>
</tr>
</tbody>
</table>

Use the "Change" softkey to adjust the parameters of the jerk filter.
Use "Reset (po)" to activate the filter type in the following axis machine data:

MD32402 $MA_AX_JERK_MODE = x5 in the 1st position setpoint filter ladder
MD32402 $MA_AX_JERK_MODE = 5x in the 2nd position setpoint filter ladder

⇒ Additional actions:

- Press the "Cancel" softkey to cancel the inputs.
- Use the "Accept" softkey to accept the entries for the jerk filter.
Calculation of the machine data for FIR low pass

The active dynamic response mode of the G code group 59 is read in again during power-up, during an operator panel reset, and at the end of a part program by evaluating MD20150 $MC_GCODE_RESET_VALUE[58] and MD20152 $MC_GCODE_RESET_MODE[58].

The following machine data is implicitly recalculated and activated depending on the dynamic response mode during power-up, during an operator panel reset, and at the end of a part program:

<table>
<thead>
<tr>
<th>MD32407 $MA_JERK_FIR_FREQ</th>
<th>FIR low pass - cutoff frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32408 $MA_JERK_FIR_ORDER</td>
<td>FIR low pass - filter order</td>
</tr>
<tr>
<td>MD32409 $MA_JERK_FIR_WINDOW = 1</td>
<td>FIR low pass - window type</td>
</tr>
</tbody>
</table>

The same values for the machine data are calculated and written for all axes in the channel for the active dynamic response mode in the part program. The CALCFIR command therefore has to be reprogrammed after each changeover of the dynamic response mode. Use the CALCFIR instruction to explicitly activate the calculation following switchover of the dynamic mode.


Double moving average calculation

Enter the time constants for the delay time for the selected axis.

The following machine data is set active with the "Accept" softkey:

<table>
<thead>
<tr>
<th>MD32400 $MA_AX_JERK_ENABLE = 1</th>
<th>Axial jerk limitation</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32410 $MA_AX_JERK_TIME</td>
<td>Axial jerk limitation: Time constant [s]</td>
</tr>
<tr>
<td>MD32411 $MA_AX_JERK_TIME_ADD</td>
<td>Axial jerk limitation: Time constant [s] for the filter type double moving average calculation</td>
</tr>
</tbody>
</table>

Use the "Change" softkey to adjust the parameters of the jerk filter.

Use "Reset (po)" to activate the filter type in the following axis machine data:

MD32402 $MA_AX_JERK_MODE = x4 in the 1st position setpoint filter ladder
MD32402 $MA_AX_JERK_MODE = 4x in the 2nd position setpoint filter ladder

⇒ Additional actions:
- Press the "Cancel" softkey to cancel the inputs.
- Use the "Accept" softkey to accept the entries for the jerk filter.

Moving average calculation

Enter the time constant for the delay time for the selected axis.

The following machine data is set active with the "Accept" softkey:

<table>
<thead>
<tr>
<th>MD32400 $MA_AX_JERK_ENABLE = 1</th>
<th>Axial jerk limitation</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32410 $MA_AX_JERK_TIME</td>
<td>Axial jerk limitation: Time constant [s]</td>
</tr>
</tbody>
</table>
Use the "Change" softkey to adjust the parameters of the jerk filter. The filter type is activated in the following axis machine data using a "Reset (po)"

MD32402 $MA_AX_JERK_MODE = x2 in the 1st position setpoint filter ladder
MD32402 $MA_AX_JERK_MODE = 2x in the 2nd position setpoint filter ladder

⇒ Additional actions:

● Press the "Cancel" softkey to cancel the inputs.
● Use the "Accept" softkey to accept the entries for the jerk filter.
8.8 Diagnosis → System utilization

System utilization

The channel-specific system utilization is displayed in the "Diagnostics" → Menu forward key → "System utilization" operating area:

<table>
<thead>
<tr>
<th>Component</th>
<th>Current value display</th>
</tr>
</thead>
</table>
| Position controller                            | Position-control cycle time display:  
MD10061 $MN_POSTCTRL_CYCLE_TIME                                                        |
| Interpolator                                    | Interpolation cycle display:  
MD10071 $MN_IPO_CYCLE_TIME                                                              |
| Synchronized actions                            | To display the time required for synchronized actions, activate  
MD11510 $MN_IPO_MAX_LOAD. Enter the proportion of the interpolator cycle in %.         |
| Preprocessing                                   | The factor for the interpolator cycle can be set in  
MD10070 $MN_IPO_SYSCLOCK_TIME_RATIO.                                                  |
| NC load from position controller and interpolator |  
MD10185 $MN_NCK_PCOS_TIME_RATIO = 90 (default setting)  
The average current load should not exceed 50%.  
In order to have sufficient reserves for the program processing, the  
maximum load in typical operations should not exceed 75%. |
| Interpolator buffer level                       | The channel-specific filling level is displayed in  
MD28060 $MC_MM_NUM_IPO_BUFFER_SIZE, and indicates whether block preparation for block processing can commence.  
Jerky machining in continuous-path mode, if for instance a number of short traversing blocks have been programmed in succession, is a typical indicator of the interpolator buffer idling. |

Total system utilization in milliseconds [ms]:  
MD10050 $MN_SYSCLK_CYCLE_TIME (system base cycle)
8.8 Diagnosis → System utilization
9.1 Introduction

Commissioning of PLC-controlled drives

The following tools support the commissioning of PLC-controlled drives:

- **SINUMERIK Operate:**
  - Guided commissioning (Page 113) with the drive wizard for drive objects.
  - Manual commissioning (Page 143) performed by experienced commissioning engineers.

- Access to the parameters of all drive objects in the "Commissioning" → "Machine data" operating area.

- Support for the series commissioning of the PLC-controlled drives, because the parameters are contained in the commissioning archive.

- Topology views, including a list of all drive units of this type that have been found.

- Diagnostics (Page 177) with alarms from those PLC drives whose time stamp is synchronized with the system.

**Note**

**PLC axes with special functions**

Guided commissioning, e.g. for vector control, is not provided by the wizard in SINUMERIK Operate. To do this, the STARTER commissioning software appropriate for the version can be used.

PLC axes can only be used with the "basic positioning" (EPOS) function module if commissioning takes place via STARTER.
9.2 Configuration via PROFIBUS

9.2.1 Supplementary conditions for PLC-controlled drives

Supported versions

Note

The SINUMERIK CNC software V4.9x supports the following Control Units with SINAMICS firmware V5.2:

- CU310-2 DP / CU310-2 PN
- CU320-2 DP / CU320-2 PN

The following applies to PLC-controlled drives:

- Controlled directly from the PLC program.
- Integration in the part program sequence by means of auxiliary functions (H command).

Quantity framework

<table>
<thead>
<tr>
<th>Scaling</th>
<th>SINUMERIK 840D sl</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>710.3B PN</td>
</tr>
<tr>
<td>Drives (drive control DOs) in total(^2):</td>
<td></td>
</tr>
<tr>
<td>Of which assigned to the NC, maximum(^2):</td>
<td>8</td>
</tr>
<tr>
<td>Resulting from this, those not assigned to the NC, minimum:</td>
<td>7</td>
</tr>
<tr>
<td>Not assigned to the NC, maximum:</td>
<td>15</td>
</tr>
<tr>
<td>Drive units (DO1) with drive control objects, in total(^2):</td>
<td>9</td>
</tr>
<tr>
<td>Of which at the virtual, integrated PROFIBUS, maximum(^3):</td>
<td>4</td>
</tr>
<tr>
<td>Of which at the virtual, integrated PROFIBUS, minimum:</td>
<td>1</td>
</tr>
<tr>
<td>Of which at the DP interface(^1) minimum:</td>
<td>5</td>
</tr>
<tr>
<td>Of which at the DP interface(^1) maximum:</td>
<td>8</td>
</tr>
</tbody>
</table>

\(^1\) X126: PROFIBUS DP of the integrated PLC; X136: PROFIBUS DP/MPI of the integrated PLC

\(^2\) The sum is monitored using alarm 380077
Extending the quantity framework

With MD13160 $MN_SINAMICS_MAX_SLAVE_ADDRESS > 0, all SINAMICS drives whose bus address or device number (n + 1) is greater than the entered value (n) are operated on the PLC as standard slaves according to the PROFIdrive profile and are not included in the NC quantity framework according to the above table. This address can be set individually for each bus.

<table>
<thead>
<tr>
<th>MD13160 $MN_SINAMICS_MAX_SLAVE_ADDRESS[i]</th>
<th>Highest address for each bus type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>$MN_SINAMICS_MAX_SLAVE_ADDRESS[0]</td>
<td>PROFIBUS DP1 (X126)</td>
</tr>
<tr>
<td>$MN_SINAMICS_MAX_SLAVE_ADDRESS[1]</td>
<td>PROFIBUS DP2 (X136)</td>
</tr>
<tr>
<td>$MN_SINAMICS_MAX_SLAVE_ADDRESS[2]</td>
<td>PROFIBUS DP3 integrated</td>
</tr>
<tr>
<td>$MN_SINAMICS_MAX_SLAVE_ADDRESS[3]</td>
<td>PROFINET (X150)</td>
</tr>
</tbody>
</table>

A distinction is made between the following scenarios:

- The default setting MD13160 $MN_SINAMICS_MAX_SLAVE_ADDRESS[i] = 0 means that all connected and configured drives are included in the quantity framework.
- If $MN_SINAMICS_MAX_SLAVE_ADDRESS[i] > 0, all SINAMICS drives with a bus address or device number greater than the entered value are not included in the quantity framework, and can be used, for example, for further PLC axes.

Example:

So that all the drives connected via PROFINET, do not have to be taken into account in the NC quantity framework, MD13160 $MN_SINAMICS_MAX_SLAVE_ADDRESS[3] must be = 1 (= n) and must be configured in HW Config as the lowest device number 2 (= n+1).

Supplementary conditions

The extended operator control options for the PLC drives produce the following supplementary conditions:

- Because the PLC drives create an additional communication load, the number of these drive objects (DO) is limited depending on the NCU ⇒ observe the quantity framework:

  Alarm 380077 "PROFIBUS/PROFINET: Too many DOs: currently %2, maximum %3 in DO group %1"

- Depending on the versions used, the texts displayed for the SINAMICS parameters and messages may be incomplete.

- If the drives are assigned to the NC and distributed across several buses, such as DP and DP integrated, then it must be ensured that each isochronous bus has the same cycle clock settings. It is also true for the time of day synchronization via NC with telegram 390 that the cycle settings match for each isochronous bus.

- A DO1 drive unit is required for the internal virtual PROFIBUS DP3 for access to the onboard I/O including probe.
Note
PROFIBUS DP (X126)

The following should be observed for all drive units connected to an external PROFIBUS DP:

- In the configuration, the user must take into account the supply as well as the switch-on and switch-off behavior in interaction with the other axes and their supply.
- For the terminal wiring, observe the "Machine Configuration Guidelines" System Manual. In the simplest case, the feedback signal of the Line Module must be connected to the PLC-controlled drives (see also: Terminal assignment (Page 107)).

9.2.2 Example: Configuration of the drive components

Overview

The SINAMICS drive system for PLC-drives communicates with the PLC via the PROFIBUS DP X126 interface. The commissioning described in this chapter orientates itself on the following example configuration of the SINAMICS drive line-up:

![Configuration via PROFIBUS](image)

Figure 9-1  Configuration via PROFIBUS

Already commissioned are:

- NCU and NX15.3 with additional components.
In this section, the following will be put into operation:

- CU320-2 DP with an infeed (Line Module) and a Double Motor Module.

### 9.2.3 Commissioning the PLC

#### Overview

The following steps are carried out when commissioning drives controlled from a PLC for the first time:

1. PLC commissioning
2. Creating a PLC program
3. Commissioning drives controlled from a PLC
4. Commissioning NC ⇔ drive communication

#### Precondition

- You have connected the PG/PC to the PLC (see Connect PG/PC with PLC (Page 51)).
- You have started the SIMATIC Manager and created a project (see SIMATIC S7 project overview (Page 52)).
- You have inserted a SIMATIC Station-300 in the project (see Adding SINUMERIK NCU to the HW Config (Page 53)).
- You have started HW Config.
- On the integrated PROFIBUS you have configured an NCU and NX15.3.

#### Interfaces

The PLC must be notified about the PROFIBUS interfaces of SINAMICS. You generate a SIMATIC S7 project using the SIMATIC Manager.

To do this, perform the following steps:

- Insert an S120 CU320-2 DP in HW Config.
- Configure the properties of the PROFIBUS interface.
- Compile the configuration and then download it to the PLC.

#### Note

The SINUMERIK Toolbox must be installed.
Inserting an S120 CU320-2 DP component

Procedure:

1. Navigate in the catalog to "PROFIBUS DP" → "SINAMICS" → "SINAMICS S120" → "S120 CU320-2 DP".

2. Keeping the left mouse key pressed, drag the “S120 CU320-2 DP” in the station window to PROFIBUS (1): DP master system.
3. After releasing the mouse key, configure the properties of the SINAMICS PROFIBUS interface:

4. Confirm with "OK".

5. In the "Version" selection box, select the firmware version of the Control Unit.

   **Note**
   
   The firmware version must match the version of the CompactFlash card on the CU320-2 DP. Refer to the upgrade instructions for the versions that have been released for PLC-controlled drives.

6. Confirm with "OK".

7. In the PROFIBUS DP master system (SINUMERIK NCU) under "Properties" → "Network settings" → "Options" and under the "Equidistance" tab activate the option "Activate equidistant bus cycle".
8. In the "DP Slave Properties" of the CU320-2 DP under the "Clock synchronization" tab, activate the option "Synchronize drive to equidistant DP cycle".

9. In the "DP Slave Properties" dialog box, select the "Configuration" tab.

10. Select in the "Overview" the telegrams required for the individual objects (axes and CU320-2 DP):
    - "Siemens telegram 2, PZD-4/4" for example, for speed-controlled axes
    - "Siemens telegram 390, PZD-2/2" for CU320-2 DP

**Note**

SIEMENS telegram 390 is required for the time stamp of alarms from the PLC.
11. Change under "Configuration" to the "Details" view in order to display the associated generated input and output addresses for the individual objects:

![Image of DP slave properties window]

12. Confirm with "OK".

To support automatic device commissioning, the input and output addresses must be identical because the addresses in the PLC program are required for the FB283.
9.2 Configuration via PROFIBUS

Result

Saving/compiling/loading into the module

Procedure:

1. Select the “Station” → “Save and compile" menu.
2. Click the "Load in module" button to load the configuration to the PLC (Page 69).

In the next step, you create the PLC program.
9.3 Creating a PLC program

Requirements

This chapter describes the configuration of PLC drives that are not to be operated as NC axes. The following expansions of the function blocks are required in the PLC program: You will need additional S7 function blocks from the SINAMICS toolbox ≥ V2.1. This Zip file contains a manual in several languages.

The SINAMICS Toolbox is available in the Internet at the following link: SINAMICS Toolbox V2.1 (http://support.automation.siemens.com/WW/view/en/25166781)

Signals "WR_PZD" and "RD_PZD"

The "WR_PZD" and "RD_PZD" signals for FC70 in the example have the following meaning:

<table>
<thead>
<tr>
<th>Signal</th>
<th>Type</th>
<th>Type</th>
<th>Range of values</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>WR_PZD</td>
<td>I</td>
<td>Any</td>
<td>P#Mm.n byte x P#DBno.DBXm.n byte x</td>
<td>Target range for process data, master → slave (control words / set-points) here, generally the axis DB is used, i.e. in the pointer, the same DB number must be specified as formal parameter &quot;NR_ACHS_DB&quot;. The length of the pointer is 30 bytes for Siemens telegram 136.</td>
</tr>
<tr>
<td>RD_PZD</td>
<td>I</td>
<td>Any</td>
<td>P#Mm.n byte x P#DBno.DBXm.n byte x</td>
<td>Target range for process data, slave → master (status words / actual values) here, generally the axis DB is used, i.e. in the pointer, the same DB number must be specified as formal parameter &quot;NR_ACHS_DB&quot;. The length of the pointer is 38 bytes for Siemens telegram 136.</td>
</tr>
</tbody>
</table>

Example with constant speed (fan, pump)

Procedure:

1. You have already created a project and find yourself on the main screen of the SIMATIC Manager.
2. Select the "File" → "Open" menu and then click the "User projects" tab.
3. Open the example project and copy the FB283, FC70, DB70 and DB283 blocks as well as all UDT300xx into your existing project.
4. As the DB70 could be used by another PLC program, rename DB70 as DB111!
5. Create a new FC73. Do not use the FC73 from the SINAMICS toolbox. In the example, 4000m/min corresponds to the rated speed in drive parameter p2000.
6. Edit the OB1, FC70 and FC73 blocks in accordance with the following examples.

**Example of OB1:**

```plaintext
... 
CALL FC70 
CALL FC73 
...
```

**Example of FC70:**

```plaintext
CALL FB283, DB283 
NR_ACHS_DB := 111 
LADDR := 272 //Logical I/O address 
LADDR_DIAG := 8186 //Diagnostic addresses 
WR_PZD := P#DB111.DBX172.0 Byte 8 //Source range for outputs 
RD_PZD := P#DB111.DBX212.0 Byte 8 //Target range for inputs 
CONSIST := TRUE 
RESTART := FALSE 
AXIS_NO := B#16#3 //Number of the drive object 
```

**Example of FC73:**

```plaintext
UN E30.0 //E.g. switch for the enable signal 
SPB frei 
L W#16#47E //All enables set 
T DB111.DBW172 
U E3.7 //MCP reset 
= DB111.DBX173.7 //Reset fault memory 
BEA 
frei: 
L W#16#47E //All enable signals except ON/OFF1 
T DB111.DBW172 
L W#16#4000 //Rated speed in drive parameter p2000 
T DB111.DBW174 //Set speed high 
```

7. You have now finished programming the PLC program. Load the project to the PLC (Page 91).

8. To synchronize the PLC and NC, a system reset (po) is required:
   - NCU: RUN LED is continuously lit green.
   - NCU: Status display shows a "6" with a flashing dot.
   - SINAMICS CU320-2 DP: LED RDY flashes slowly green (0.5 Hz)

⇒ PLC and NC are in cyclic operation.
9.4 Commissioning PLC drives

Automatic device configuration

Procedure:

1. Select the "Commissioning" → "Drive system" operating area.

2. Confirm with "OK". You will then be guided through the individual steps of the automatic device configuration.

3. In the "Machine configuration" overview, press the "Drives without NC assignment" softkey to display all drive objects:
Diagnostics

The status is likewise displayed in the “Diagnostics” → “Axis diagnostics” → “Service axis” operating area with the selection “Drives without NC axis assignment”.

![Diagnostics screenshot](image-url)
9.5 Checking the communication to the drive

Check configuration

The PLC alarms of the drives must have an identical time stamp with the NC.

For the configuration in the hardware configuration, define the associated Siemens telegram 390 for the SINAMICS CU. The corresponding logical input and output addresses of this communication interface are entered in the following machine data item:

- MD13120[n] CONTROL_UNIT_LOGIC_ADDRESS
- MD13120[1]...[5] are reserved for NX expansion modules.

Note

You can view these logical addresses in the HW configuration when configuring the properties of SINAMICS components under "Details".

Procedure:

1. Check the logical address for SINAMICS CU in the "Commissioning" → "Machine data" → "General MD" operating area and enter, for example, the following value:
   MD13120[6] = 288

2. Press the "Reset (po)" softkey to accept the changed machine data.

This completes the commissioning of the PLC drives.
9.6 Safety functions for PLC drives

Introduction
This section only partially describes how a PLC drive can be integrated in a safety-related application. In this case, the published supplement of the PROFIdrive profile that includes drive-based safety functions via the PROFIsafe supplement with telegram 30 is used.

Basic procedure
The following steps are necessary to integrate drive-based safety functions:
- Configuration with SIMATIC Manager under HW Config.
- Embedding in safe programmable logic (SPL).

Further information
The following Function Manuals for Safety Integrated are binding when it comes to implementing a safety-related design:
  - SINUMERIK 840D sl Safety Integrated plus Commissioning Manual

9.6.1 Configuring PROFIsafe

Requirement
In order to configure PROFIsafe, it is necessary that the "S7 Configurations Pack" option is installed.
Configuring the operating sequence for PROFIsafe

Procedure:

1. For this telegram, select the PROFIsafe telegram 30 in the "Option" selection field.

2. Under the "Details" tab, set the input/output addresses. The PROFIsafe option requires an additional 6 bytes.

3. Click the "PROFIsafe ... " button to set the F parameters.
4. To change the "F_Dest_Add" parameter, select "F_Dest_Add" in the "Parameter Name" column and click the "Change value ..." button.

5. Check the following values/settings:
   - The value of the "F_Dest_Add" parameter must be entered as a hexadecimal value in p9610 and p9810 of the corresponding drive (e.g. 200\text{dec} corresponds to C8\text{hex}).
   - The value of the "F_Source_Add" must match the other used PROFIsafe modules and also be entered in MD10385 $MN\_PROFISAFE\_MASTER\_ADDRESS.
   - It must be ensured that the same source address is set for all PROFIsafe modules.
9.6.2 Example: Embedding in safe programmable logic (SPL)

Introduction

The following machine data and files must be taken into account when embedding telegram 30 in a safe programmable logic:

- NC machine data
- Drive machine data
- "safe.SPF" file
- PLC program expansion
NC machine data

The SPL PROFIsafe configuration for the basic safety functions STO without SSI are then shown:

<table>
<thead>
<tr>
<th>Archive excerpt</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHANDATA(1)</td>
<td></td>
</tr>
<tr>
<td>N10385 $MN_PROFISAFE_MASTER_ADDRESS='H50007d2'</td>
<td>;=&gt; entry from HW Config</td>
</tr>
<tr>
<td>N10386 $MN_PROFISAFE_IN_ADDRESS[0]='H50000c8'</td>
<td>;=&gt; entry from HW Config</td>
</tr>
<tr>
<td>N10387 $MN_PROFISAFE_OUT_ADDRESS[0]='H50000c8'</td>
<td>;=&gt; entry from HW Config</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>N10390 $MN_PROFISAFE_IN_ASSIGN[0]=9011</td>
<td>;=&gt; INSE[9] for S_STW1.0 No Safe Torque Off</td>
</tr>
<tr>
<td></td>
<td>;=&gt; INSE[10] for S_STW1.1 No Safe Stop 1</td>
</tr>
<tr>
<td></td>
<td>;=&gt; INSE[11] for S_STW1.7 INTERNAL_EVENT_ACK</td>
</tr>
<tr>
<td></td>
<td>; No extended functions</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>N10400 $MN_PROFISAFE_OUT_ASSIGN[0]=9011</td>
<td>;=&gt; OUTSE[9] for S_ZSW1.0 Power removed</td>
</tr>
<tr>
<td></td>
<td>;=&gt; OUTSE[10] for S_ZSW1.1 Safe Stop 1 not active</td>
</tr>
<tr>
<td></td>
<td>;=&gt; OUTSE[11] for S_ZSW1.7 INTERNAL_EVENT</td>
</tr>
<tr>
<td></td>
<td>; No extended functions</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>N13300 $MN_PROFISAFE_IN_FILTER[0]='H83'</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>N13320 $MN_PROFISAFE_OUT_FILTER[0]='H83'</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
</tbody>
</table>

Drive machine data

Values that have been added as a result of telegram 30:
- p9601=p9801=0x8
- p9610=p9810=0xC8

"safe.SPF" file:

<table>
<thead>
<tr>
<th>Program example</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>IDS = 40 DO $A_OUTSE[09] = $A_INSE[2]</td>
<td>;If the cover is locked then deselect STO</td>
</tr>
<tr>
<td>IDS = 41 DO $A_OUTSE[10] = $A_INSE[2]</td>
<td>;If the cover is locked then deselect SS1</td>
</tr>
</tbody>
</table>

PLC program extension:

<table>
<thead>
<tr>
<th>Program example</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>U &quot;SPL&quot;.SPL_DATA.INSEP[2];</td>
<td>// -&gt; cover switch locked?</td>
</tr>
<tr>
<td>= &quot;SPL&quot;.SPL_DATA.OUTSEP[9];</td>
<td>// $A_OUTSE[9] -1 -&gt; Deselect STO</td>
</tr>
<tr>
<td>= &quot;SPL&quot;.SPL_DATA.OUTSEP[10];</td>
<td>// $A_OUTSE[10] -1 -&gt; Deselect SS1</td>
</tr>
<tr>
<td>//Enable signal OFF1 set:</td>
<td></td>
</tr>
<tr>
<td>UN &quot;SPL&quot;.SPL_DATA.INSEP[9];</td>
<td>// -&gt; No STO?</td>
</tr>
<tr>
<td>UN &quot;SPL&quot;.SPL_DATA.INSEP[10];</td>
<td>// -&gt; No SS1?</td>
</tr>
<tr>
<td>U E 0.0;</td>
<td>// only if OFF1 is also requested via switch</td>
</tr>
<tr>
<td>Program example</td>
<td>Comment</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------</td>
</tr>
<tr>
<td>&quot;CU320_A&quot;.Speed_Control.WR_PZD_DREHAHL.STW1.Aus1</td>
<td></td>
</tr>
</tbody>
</table>
Configuring PLC-controlled drives

9.6 Safety functions for PLC drives
10.1 Tuning procedure

Precondition

Once the drives have been commissioned and the axes assigned, you must start tuning the particular machine or a machine type.

- The commissioning of the drives has been completed.
- The topology has been checked and is OK.

Tuning procedure

Depending on the requirements, the following tuning procedure is recommended: Procedure when tuning axes and drives (Page 28)

Especially efficient procedure: Tuning, utilizing all default settings of the automatic servo tuning:

- Example: This is how you tune the X axis (Page 300)
- Example: This is how you tune the Y axis (Page 304)
- Example: This is how you start to tune the path interpolation (Page 307)

Procedure for experts:

- Tuning using the automatic servo tuning with manual parameter settings: Example for experts: Axis tuning (Page 310)
- Tuning using measuring functions and manual parameter settings of the position controller, speed controller and current controller:
  - Example: Setting the filter for the following error (speed control loop) (Page 324)
  - Examples for the measuring methods (position control loop) (Page 327)
  - Example, function generator: Speed setpoint after the filter (Page 331)

The SINUMERIK Operate Online Help provides more detailed, context-related information on the parameterization of the "Automatic Servo Tuning".

Further information can be found in:

10.2 Function overview for the tuning

Commissioning → Tuning/test

The following functions are available to support the commissioning:

- Automatic servo tuning
- Measuring functions (Page 316) (current control loop, speed control loop, position control loop)
- Function generator (Page 329)
- Circularity test (Page 334)
- Characteristic curves for the hydraulic module (if present)
- Active filters (Page 333)

![Table of Auto servo tuning: Axis selection](image)

**Figure 10-1** Example: "Automatic servo tuning"

Diagnosis → Trace

With the "Trace (Page 163)" function, you select the NC variables, PLC variables or drive variables whose signal chart is to be visualized:

- **Trace for PLC/NC/servo variables**
  Recording and graphical representation of the signal values with respect to time, such as actual position value, following error, etc.

- **Trace for drive variables**
  Recording and graphical representation of the signal values with respect to time from the drive system, such as e.g. speed actual value, current actual value etc.
10.3 Automatic servo tuning

Which functions are available?

The following options are available for automatically tuning an axis:

- Selection of an individual axis for tuning
- Selection of a strategy from many options
- Reconfiguration of measurement conditions
- Chart display and activity log for tuning process
- Display of the measured frequency responses (speed control system) and the calculated frequency responses (open circuit, closed control loop)
- Checking and processing the tuning results for speed and position controller: The response of the control loop is simulated on the basis of the frequency response and displayed in the bode diagram.
- Accept or reject the results of the tuning

The function "Automatic servo tuning" is started in the operating area "Commissioning" → "Automatic servo tuning", and can be used for all servo and direct drives.

Interpolation axes

For axes which make up an interpolation group, additional tuning steps should be undertaken, e.g.:

- Path interpolation (Page 307) with the automatic servo tuning.
- Circularity test (Page 334)
- Adjust servo gain factor.
- When using feedforward control, transfer equivalent time constants of the slowest axis (highest value) in all interpolating axes.

10.3.1 Setting the options for the measurement procedure

Options in JOG mode

In the first step, press the "Options" softkey to set the general behavior for automatic servo tuning.

For a predominantly automatic sequence in the JOG mode the following selection is recommended, utilizing all automatic sequences and settings:
Condition for AUTO mode

Software option

In order to use this function a license is required for the following option: "Call AST from the part program" (6FC5800-0_S10-0YB0)

With the option "Assign this HMI for "Call AST from the part program"", you select SINUMERIK Operate to perform the automatic servo tuning in the AUTO mode:

- ☑ If this option is selected, the current SINUMERIK Operate performs the automatic servo tuning.
- ☐ If this option is not selected, a different SINUMERIK Operate performs the automatic servo tuning.
Sequence in AUTO mode

As a result of the changing load, for direct drives (e.g. torque motors) it may be necessary to tune the axis involved for each new workpiece size or clamping device.

Standard cycles (CYCLE751...759) are available, that machine OEMs can use in a manufacturer cycle. The automatic servo tuning can be parameterized and started using the cycles. The previous settings and results from the automatic servo tuning can be employed, using SINUMERIK Operate. The machine manufacturer provides the machine operator with a manufacturer's cycle, which includes the appropriate commands. This means that after retuning, an end user can insert a manufacturer's cycle in his part program, which performs the tuning and selects the appropriate data sets. The part program does not have to be interrupted for the retuning.

The following settings must be made by the machine manufacturer so that the cycle call for the automatic servo tuning from the part program functions at the end user.

- The instance of SINUMERIK Operate on which the cycles are executed has been selected.
- The XML files with the appropriate tuning settings for the respective axis, which are required by the cycles, are available.
- The manufacturer cycles are available, and when required a parameter set switchover is set up.

10.3.2 Selecting the tuning strategy

Default setting for "Axis" strategy

For a predominantly automatic sequence in the JOG mode the following selection is recommended: Select a tuning strategy for axis, speed controller and position controller using softkey "Select strategy >". The recommended strategies are 102, 303 and 203.

![Strategy: Axis example](image)

For the "Axis" strategy, select which controller should be tuned. When doing this, the tuned, closed control loop can be measured to check the results.
Example for "Axis": Strategy 108

When selecting "User-defined strategy (108)" for the axis, all options are active and can be set using the "Adapt strategy" softkey:

![Image of strategy setup](image1)

Figure 10-3  User-defined strategy (108) - example

Further, additional strategies that can be combined with a tuning objective are available in the list.

Example for "Speed": Strategy 303

![Image of speed setup](image2)

Figure 10-4  Strategy: Speed control loop - example
The most important settings are: Tuning aggressiveness and minimum integral time Tn.

- **Tuning aggressiveness:**
  This parameter determines the setting of Kp and Tn based on stability limits. The phase margin and amplitude margin values are pre-assigned according to this setting.
  - Default setting = 0.5
  - Min = 0 [maximum stability]
  - Max = 1 [maximum aggressiveness]

- **Minimum integral time Tn:**
  This parameter prevents automatic servo tuning from setting the integrator time of the speed control loop too low. If the automatic servo tuning sets a value lower than this parameter has set, the actual value used will be limited to the value set by the minimum integral time Tn. A higher integral time ensures a more rugged closed-loop control if changes to the weight or the moment of inertia are expected. This is recommended for direct drives and main spindles of turning machines.
  - Default setting = 10 ms
  - Min = 0.5 ms
  - Max = 100 ms

- **Pole/zero point identification as from frequency:**
  This parameter sets the lower limit value of the frequency range, through which the automatic servo tuning searches for natural frequency modes: Pole and zero points on the controlled system. This parameter is intended to prevent measurement noise in the low frequency range being incorrectly marked as the pole or zero position. The frequencies identified as pole or zero positions play a role in the estimation of the total inertia of the axis. For this reason, it is important that the lowest natural frequency of the axis is correctly identified by the automatic servo tuning.
  On large machines with low frequency vibration modes, it may be necessary to reduce the 15 Hz default value of this parameter. The reduction of this parameter may have to be accompanied by a reduction in the bandwidth of the measurement of the speed-controlled system.
  Default setting: 15 Hz
Example for "Position": Strategy 203

Figure 10-5  Strategy: Position control loop - example

The value for reducing the servo gain factor and its upper limit depends on the selected tuning objective.

- **Reduce servo gain factor**
  The maximum servo gain factor is calculated from the automatic servo tuning; in the process, no overshoot is allowed with the position controller. The maximum servo gain factor is the value that does not result in any overshoot. The maximum servo gain factor can be reduced to increase ruggedness against mechanical changes. A reserve of 40% is set for the tuning objective "moderate responsiveness". Furthermore, the servo gain factor is limited to 4 mm/min.
  - Default setting = 0.6
  - Min = 0.1
  - Max = 1 (no reduction)

- **Feedforward control mode**: Torque feedforward control is recommended. When telegram 136 is used, the torque feedforward control allows the highest contour precision to be achieved.

**Tuning objective**

The default settings for speed and position controllers are adapted by selecting the tuning objective.

<table>
<thead>
<tr>
<th>Tuning objective</th>
</tr>
</thead>
<tbody>
<tr>
<td>Moderate responsiveness</td>
</tr>
<tr>
<td>Maximum responsiveness</td>
</tr>
<tr>
<td>Moderate responsiveness</td>
</tr>
<tr>
<td>Conservative / robust</td>
</tr>
</tbody>
</table>
10.3 Automatic servo tuning

- **Maximum responsiveness:**
  The speed and position controller gain (servo gain factor) is tuned with maximum values and minimum ruggedness.
  Application: High-speed machining with maximum suppression of all disturbing forces such as friction, teeth of the drive belt, strong cutting forces, when machining titanium, for example. Recommended for high-speed machining with linear motors.
  Precondition: The machine must have a rigid design; the dynamic masses do not change significantly.

- **Moderate responsiveness (= default):**
  This controller dynamic response is sufficient for the majority of machines and applications. The setting is more rugged than “Maximum responsiveness”.
  Application: The inertia or the load mass of the axes does not change much and therefore this setting is suitable for numerous applications.

- **Conservative/robust responsiveness:**
  Only weak control gains are selected in order to ensure as high a level of ruggedness as possible.
  The speed controller is tuned so that it achieves maximum damping to prevent oscillations and to achieve good position controller gain.
  Application: Recommended for machines on which the mechanical axis system or the load mass can change significantly. Also suitable for axes that respond with oscillations, e.g. main spindles on turning machines or large axes with high load mass.
  Recommended for applications with low requirements on the machining time.

### 10.3.3 Example: This is how you tune the X axis

#### Precondition

This example shows how to tune the X1 axis using the “Automatic servo tuning” function. In this case, the following machine configuration is assumed:

<table>
<thead>
<tr>
<th>Machine axis</th>
<th>Type</th>
<th>Drive No.</th>
<th>Motor Type</th>
<th>Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>M1</td>
<td>4</td>
<td>SERVO_3.3.6</td>
<td>CH1H1</td>
</tr>
<tr>
<td>2</td>
<td>M1</td>
<td>2</td>
<td>SERVO_3.3.4</td>
<td>CH1H1</td>
</tr>
<tr>
<td>3</td>
<td>M1</td>
<td>3</td>
<td>SERVO_3.3.5</td>
<td>CH1H1</td>
</tr>
<tr>
<td>4</td>
<td>M1</td>
<td>1</td>
<td>SERVO_3.3.3</td>
<td>CH1H1</td>
</tr>
<tr>
<td>5</td>
<td>M1</td>
<td>5</td>
<td>SERVO_3.3.7</td>
<td>CH1H1</td>
</tr>
<tr>
<td>6</td>
<td>M1</td>
<td>7</td>
<td>SERVO_3.3.3</td>
<td>CH1H1</td>
</tr>
<tr>
<td>7</td>
<td>M1</td>
<td>8</td>
<td>SERVO_3.3.4</td>
<td>CH1H1</td>
</tr>
<tr>
<td>8</td>
<td>M1</td>
<td>9</td>
<td>SERVO_3.3.5</td>
<td>CH1H1</td>
</tr>
</tbody>
</table>

Current access level: Manufacturer
WARNING

Avoiding unwanted axis movements

Automatic servo tuning is based on the analysis of measurements. These measurements require the axis to move. Carefully ensure that all axes are in a safe position and no collisions will occur during the traversing motion that is required.

Number of measurements

For tuning purposes, the following measurements are taken with the speed controller:

Speed controlled system:
- Overall bandwidth: Preliminary measurement in both directions
- Overall bandwidth: Measurement in both directions
- Reduced bandwidth: Preliminary measurement in both directions
- Reduced bandwidth: Measurement in both directions

Mechanical system motor to DMS:
- Measurement in both directions

Tuning the X axis

Procedure:
1. Softkey "Options >", to select options when performing the measurements.
2. Softkey "Select strategy >", to select a strategy: Default setting 102, 203, 303.
3. Check that the tuning objective "Moderate responsiveness" is selected
4. In dialog "Axis selection", select the X axis:

5. Start the measurement with the "Tune" softkey.

6. Confirm the "Axis park position" with "OK". Two measurements are performed.
7. Follow the instructions by pressing `<NC START>`. After the measurements have been successfully made, the tuned values of the parameters are output:

8. Softkey "Accept", to activate the parameters and exit tuning.

9. OR: Enter suitable values in column "Manual" and confirm using softkey "Accept", to activate the parameters and exit tuning:

10. After completion of the measurement, you can display the complete tuning log: "Tuning log" softkey.
Result for the X axis

After confirming with "OK", you get the following result:

<table>
<thead>
<tr>
<th>Axis</th>
<th>Optimization</th>
<th>Information/Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1</td>
<td>06/04/19 2:31:58 PM</td>
<td></td>
</tr>
<tr>
<td>X2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X8</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

10.3.4 Example: This is how you tune the Y axis

Tuning the Y axis

**WARNING**

Avoiding unwanted axis movements

Automatic servo tuning is based on the analysis of measurements. These measurements require the axis to move.

Carefully ensure that all axes are in a safe position and no collisions will occur during the traversing motion that is required.
Procedure:

1. The options and strategies that have been set remain valid.

2. In dialog "Axis selection" select the Y axis:

3. Start the measurement with the "Tune" softkey.

4. Confirm the "Axis park position" with "OK". Two measurements are performed.

5. Follow the instructions by pressing <NC START>. After the measurements have been successfully made, the tuned values of the parameters are output:

6. Softkey "Accept", to activate the parameters and exit tuning.
7. OR: Enter suitable values in column "Manual" and confirm using softkey "Accept", to activate the parameters and exit tuning:

8. After completion of the measurement, you can display the complete tuning log: "Tuning log" softkey.

**Result of the Y axis**

After confirming with "OK", you get the following result:
10.3.5  Example: This is how you start to tune the path interpolation

Interpolation of the axes

Procedure:

1. Softkey "Path interpolation", to select the axes for path interpolation.

   ![Softkey Path Interpolation]

   Softkey "Tune" to start measurements.

2. Softkey "Select strategy", to check the interpolation strategy:

   ![Softkey Select Strategy]

   The following parameters are adapted:
   - The dynamic adaptation in MD32900 $MA_DYN_MATCH_ENABLE=1 is active.
   - The feedforward control is always active.
You set a user-defined strategy for path interpolation using softkey "Adapt strategy".

3. Once tuning has been completed, the tuned values are shown for the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>RX1/F1</th>
<th>RX2/F1</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proportional gain Kp</td>
<td>0.1832</td>
<td>0.2696</td>
<td>Nms/rad/min</td>
</tr>
<tr>
<td>Integral time Tc</td>
<td>0.01</td>
<td>0.01</td>
<td>s</td>
</tr>
<tr>
<td>Reference model active</td>
<td>☑</td>
<td>☑</td>
<td></td>
</tr>
<tr>
<td>Reference model frequency</td>
<td>143.0</td>
<td>145.1</td>
<td>Hz</td>
</tr>
<tr>
<td>Feed forward type</td>
<td>Torque</td>
<td>Torque</td>
<td></td>
</tr>
<tr>
<td>Curr ctrl EQ time for Torque FFU</td>
<td>1.25e-4</td>
<td>1.25e-4</td>
<td>s</td>
</tr>
<tr>
<td>Speed delay time (PI/429)</td>
<td>0.001125</td>
<td>0.001125</td>
<td>s</td>
</tr>
<tr>
<td>Interpolation speed pre-control</td>
<td>Linear</td>
<td>Linear</td>
<td></td>
</tr>
<tr>
<td>Interpolation supplementary torque</td>
<td>Off</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Dynamic match filter time (FT1)</td>
<td>0</td>
<td>0</td>
<td>s</td>
</tr>
<tr>
<td>Desired value delay (dead time)</td>
<td>0.4961e-6</td>
<td>0.4961e-6</td>
<td>s</td>
</tr>
<tr>
<td>Total time constant</td>
<td>0.001125</td>
<td>0.001125</td>
<td>s</td>
</tr>
</tbody>
</table>

- Softkey ">>", to switch over the vertical softkey bar for further processing:
  - Softkey: "Retune"
  - Softkey: "Revert to auto tuned"
  - Softkey: "Revert to axis opt."
  - Softkey "<<", to switch over the vertical softkey bar.
  - Softkey "Save to file", to save the tuning data to an xml file.
  - Softkey "Generate report", to generate a report in the rtf format.

A signal indicates that additional measures are required for path interpolation.
Result

The tuned axis data are activated in the associated machine data using softkey "Accept":

Documenting the result

The following reports are available to document the measurement results:

- After each individual axis has been tuned
- After path interpolation for the interpolating axes

The results are available in the following form:

- Softkey "Save to file", to save the tuning data to an xml file.
- Softkey "Generate report", to generate a report in the rtf format. The report includes parameters as well as diagrams, and is created in the language set for the control system.

The following directory is the default directory for these reports:

user/sinumerik/hmi/log/optimization
10.3.6 Example for experts: Axis tuning

Axis: User-defined strategy (108)

Manual setting of the measurement parameters

The tuning objective can be directly entered in "Speed" or "Position". Alternatively, a predefined strategy (102, etc.) can be selected, accepted with "Adapt strategy" and then changes can be made.

By activating the checkbox, the commissioning engineer selects the individual steps for measuring and tuning. Several steps are interdependent: For instance, the speed-controlled system must always be measured before tuning the speed controller. All checkboxes which result in a measurement are marked with an arrow. Additional default settings are available for each measurement using the "Meas. parameters >" vertical softkey.

Perform preliminary measurement to determine the excitation:

The preliminary measurement to determine the excitation can always be selected or deselected. The preliminary measurement is always recommended when first commissioning the axis or for unknown mass relationships (load/motor). The measurement parameters for the following measurement are automatically determined after the preliminary measurement. User-defined measurement parameters are then overwritten.

Deactivate controller properties that are not supported in the NC and drive:
The following functions are deactivated if they are used:

- **Axis:**
  
  MD32220 $MA_POSCTRL_INTEGR_ENABLE = 0
  
  MD32610 $MA_VELO_FFW_WEIGHT = 1.0   (should always be 1)
  
  MD32930 $MA_POSCTRL_OUT_FILTER_ENABLE = 0

- **Drive:**
  
  If the Advanced Position Control (APC) function module is activated: p3700.0 = 0
  
  Velocity control configuration: p1400.5 = 0
  
  The speed controller adaptation is deactivated.
  
  Speed controller integrator feedback time constant: p1494 = 0.0

**Measure smoothed speed setpoint step to create a mechanical model:**

At the start of the tuning, the load moment of inertia, the stiffness of the coupling and the correctness of the current controller setting are unknown. A step response can be measured to make a first estimate. As a consequence, while measuring the speed-controlled system, it is easier to automatically determine parameters.

**Measure speed-controlled system:**

This measurement is required to tune the speed controller.

It is initially performed with the maximum bandwidth (e.g. 4000 Hz)

**Measure speed-controlled system with reduced bandwidth:**

This measurement is required to tune the speed controller.

This measurement is performed with reduced bandwidth in order to improve the frequency resolution.

**Measure speed control loop for speed controller-controlled system model:**

This measurement is necessary if the position control loop (including feedforward control) is to be automatically tuned, but the speed controller was not tuned with automatic servo tuning.

**Tune speed controller:**

The parameters for the speed controller (including current setpoint filter) are calculated on the basis of the measured speed-controlled systems and the specified tuning objective. The parameters are not transferred into the drive until the axis tuning has been completed, or a measurement for checking has been performed. The "Speed" settings are applied.

**Measure speed control loop for checking:**

The closed speed controller is measured with the new parameters. To do this, the new parameters are written to the drive.

**Measure mechanical system:**

Measure the transmission link between the motor encoder and direct encoder (e.g. linear scale). This does not include any influence on the closed-loop control. Using this measurement, the position control loop can be calculated with closed-loop control on the direct encoder.

**Tune position controller: without parameters**

Servo gain factor and feedforward control are tuned on the basis of the prior measurements. The tuning objective is also applied. The "Position" settings are applied. If a second encoder is setup, then the position control is always calculated as if this second encoder is used for the position control.
Control measurement position control loop:
The closed position controller is measured with the new parameters. To do this, the new speed
and position control parameters are written to the drive and the NC. The feedforward control
must be disabled for this measurement. Depending on the option setting, this is the reason that
a message is output to press the reset button on the machine control panel. After the
measurement, the feedforward control is reactivated; this why another request for a reset (re)
is issued after the measurement .

⇒ Checking the measurement data quality: without parameters
The software for automatic tuning checks whether the excitation and offset velocity were
sufficient, and then outputs an appropriate message.

⇒ Measurement parameters:
Individual measurement parameters can be entered for each of the following measurements:

- Measure speed setpoint step for the mechanical model
- Measure speed-controlled system
- Measure speed-controlled system with reduced bandwidth
- Measure speed control loop for speed controller-controlled system model
- Measure speed control loop for checking
- Measure mechanical system
- Control measurement position control loop

⇒ Additional actions:
- Press the "Adapt strategy" softkey to adapt the default values to a predefined strategy. The
  values of the pre-defined strategy are assigned to the user-defined strategy (108). All
  parameters can be set in the "User-defined strategy". The tuning objective "Moderate
  responsiveness" is the default setting for the "User-defined strategy".
- Press the "Meas, parameters >" softkey to adapt the parameters for a measurement. This
  softkey can only be used when selecting the "User-defined strategy".
- Press the "Speed" and "Position" softkeys to toggle between speed controller and position
  controller when selecting a strategy.
- "Cancel" and "OK" softkeys to cancel or accept the new settings.
10.4 Spindle optimization (automatic)

Benefits

The automatic spindle optimization function supports you in the following scenarios:

- Controller optimization in the various modes: Axis mode and spindle mode.
  To this end, the speed controller, position controller, and feedforward control are optimized.
- Calibration of the following errors for tapping by means of path optimization
- Calibration of the following errors for the axis mode by means of path optimization

The progress of spindle optimization is clearly visible to the machine manufacturer:

- The optimization strategy set for the spindle.
- The suitable default setting of the optimization strategy for the selected use case.
- The mode that must still be optimized and the mode that is already optimized.
- The gear stages that must still be optimized and the ones that are already optimized.

Spindle optimization sequence

In operating area "Commissioning" → “Tuning/Test” → "Automatic Servo Tuning: Press "Axis selection" to select the spindle for optimization:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Overview</td>
<td>The &quot;Automatic servo tuning: Axis selection&quot; dialog shows the current status of the axes/spindles.</td>
</tr>
</tbody>
</table>
| 2    | Preparing   | ● Selection of the modes to be optimized  
          ● Tapping: Definition of the participating axes and gear stages  
          ● Check and edit the optimization strategy |
| 3    | Measuring & Optimization | ● Optimization of the individual gear stages or of the axis mode  
          ● Tapping: Calibration of the following error of the axes involved |
| 4    | Check       | The "Automatic servo tuning: Axis selection" dialog shows the time of the optimization for each axis/spindle.  
          The "Automatic servo tuning: Tapping" dialog (bottom section) shows which parameter sets are already path-optimized:  
          - not optimized  
          - axis-optimized  
          - path-optimized |
| 5    | Accept      | The "Automatic servo tuning: Controller data overview" dialog shows the optimized controller settings for the gear stage and for the comparison of the original data.  
          Use the "Accept" softkey to write and save the data. |
**Optimization strategy**

Different optimization strategies are used, depending on the operating range of the spindle:

- A robust setting is selected for speed controller and position controller for the spindle operation and tapping. The optimization aggressiveness is reduced for the spindle and the servo gain factor is limited to 3 [1000/min].

- In addition to the speed control mode, the position control mode is also optimized, e.g. for SPOS: Servo gain factor maximum 3 [1000/min].

- The same optimization strategy that was selected for the path axes is selected for the axis mode. If only one drive data set (DDS) is defined, this strategy will also be used for the other modes. If the speed controller adaptation is also enabled in the drive, the speed controller gain and the integral time are attenuated at higher speeds.

- For tapping, the spindle mode with gear stages and position control is used. The path calibration with the relevant path axis is needed for tapping. Ensure that all gear stages used during tapping are calibrated both in the spindle and along the path axis.

**Optimization result**

The optimized parameters are displayed in the "Controller data overview" dialog:

<table>
<thead>
<tr>
<th>Parameter Description</th>
<th>Manual</th>
<th>Auto tuned</th>
<th>Original</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feed forward type: Torque</td>
<td>1.25e-4</td>
<td>1.25e-4</td>
<td>1.25e-3</td>
<td>1e-3 s</td>
</tr>
<tr>
<td>Curr ctrl Eq time for Torque FFU</td>
<td>8.881625</td>
<td>8.881625</td>
<td>5e-4</td>
<td>5e-4  s</td>
</tr>
<tr>
<td>Speed delay time (P1429):</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0     s</td>
</tr>
<tr>
<td>Interpolation speed pre-control: Linear</td>
<td>Off</td>
<td>Off</td>
<td>Off</td>
<td>5e-4  s</td>
</tr>
<tr>
<td>Interpolation supplementary torque:</td>
<td>8.81634</td>
<td>8.81634</td>
<td>0 kg/m²</td>
<td>8.81634</td>
</tr>
<tr>
<td>Total time constant:</td>
<td>8.804619</td>
<td>8.804619</td>
<td>8</td>
<td>8</td>
</tr>
</tbody>
</table>

During tapping, the same values are set in the following machine data for the spindle and all further axes:

<table>
<thead>
<tr>
<th>Machine Data Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32200 $MA_POSCTRL_GAIN</td>
<td>Servo gain factor</td>
</tr>
<tr>
<td>MD32800 $MA_EQUIV_CURRCTRL_TIME</td>
<td>Equivalent time constant current control loop for feedforward control [s]</td>
</tr>
<tr>
<td>MD32810 $MA_EQUIV_SPEEDCTRL_TIME</td>
<td>Equivalent time constant speed control loop for feedforward control [s]</td>
</tr>
<tr>
<td>MD32900 $MA_DYN_MATCH_ENABLE</td>
<td>Dynamic response adaptation</td>
</tr>
</tbody>
</table>
Constraints

The operating range is currently limited to the following:

- Only one gear stage can be optimized.
- The spindle cannot be optimized in axis mode.
- Only one spindle can be selected for the path calibration when tapping.
10.5 Measuring functions (manual tuning)

Explanation of the measuring functions

A range of measuring functions allows the time and frequency response of drives and controls to be displayed in graphical form on the screen. For this purpose, test signals with an adjustable interval are connected to the drives.

The measuring functions are located under "Commissioning" → "Optimization/Test". The current controller, speed controller, and position controller horizontal softkeys provide access to the dialogs for each corresponding control loop. The screen navigation, screen layout, and general logic are identical in each of the three areas. The difference between the areas is that each area on the relevant control loop offers tailored measurements.

Measurement parameters and signal parameters

The test setpoints are adapted to the application in question by means of measurement or signal parameters, the units of which are determined by the relevant measuring function or operating mode. The default setting for all parameters is 0.

The measurement or signal parameter units are subject to the following conditions:

<table>
<thead>
<tr>
<th>Size</th>
<th>Unit</th>
</tr>
</thead>
</table>
| Velocity  | • Metric system: Specification in mm/min for translatory or rpm for rotary movements  
|           | • Inch system: Specification in inches for translatory or rpm for rotary movements |
| Distance  | • Metric system: Specification in mm for translatory or degrees for rotary movements  
|           | • Inch system: Specification in inches for translatory or degrees for rotary movements |
| Time      | Specified in ms                                                      |
| Frequency | Specified in Hz                                                      |
Preconditions for starting measuring functions

To ensure that no erroneous traversing movements due to part programs can be carried out, the measuring functions have to be started in <JOG> mode.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Avoiding collisions</strong></td>
</tr>
<tr>
<td>When traversing movements are carried out within the framework of measuring functions, no software limit switches and working area limitations are monitored, since these are carried out in follow-up mode.</td>
</tr>
<tr>
<td>Prior to starting traversing movements, the user must therefore ensure that the axes are positioned such that the traversing limits specified within the framework of the measuring functions are sufficient to prevent collision with the machine.</td>
</tr>
</tbody>
</table>

Starting measuring functions

Measuring functions initiating a traversing movement are only selected using the specific softkey. The actual start of the measuring function and thus of the traversing movement is always carried out with <NC-START> on the machine control panel.

If the main screen of the measuring function is exited without the traversing movement being initiated, the selection of the traversing function is canceled.

Once the traversing function has been started, the main screen can be exited without any affect on the traversing movement.

---

Note

<JOG> mode must be selected when measuring functions are started.

Further safety notices

When using the measuring functions, it must be ensured:

- There are no obstacles in the traversing range.
- The Emergency Stop button is always within reach.

Canceling measuring functions

The following events will cancel active measuring functions:

- Hardware limit switch reached
- Traversing range limits exceeded
- Emergency Stop
- Reset (mode group, channel)
- NC STOP
10.5 Measuring functions (manual tuning)

- No controller enabling command
- Canceling drive enable
- Canceling traversing enable
- Selection of parking (in position-controlled operation).
- Feed override = 0%
- Spindle override = 50%
- Change in operating mode (JOG) or operating mode JOG not selected
- Actuation of traversing keys
- Actuation of handwheel
- Alarms leading to axis shutdown

10.5.1 Measurement of current control loop

Function

The current control loop only needs to be measured for diagnostic purposes if there is a fault or if there is no standard data for the motor / power unit combination (third-party motor).

For SINAMICS S120, it is possible to measure the input/output behavior of the current control loop directly in the speed controller without needing to open it. For this reason, measurements in the speed controller are preferable. The user is made aware of this advantage as red text in the center of the "Measurement selection" dialog.

The preferred method for measuring the dynamic response of the current controller is the "Reference frequency response with active speed controller" measuring type. The other measuring types are only for experts or for comparison measurements of motors not decoupled from the mechanical components.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safety measures for hanging/suspended axes</td>
</tr>
</tbody>
</table>

For hanging/suspended axes, measuring the current control loop requires that users apply special safety measures, for instance:
- Perform the measurement using external weight compensation.
- Perform the measurement without external weight compensation, e.g. by safely and reliably clamping/locking the drive.
Measuring procedure

For the following measuring types, the current setpoint filter is not involved:

<table>
<thead>
<tr>
<th>Measuring type</th>
<th>Measured quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended measuring type for experts:</td>
<td></td>
</tr>
<tr>
<td>This measuring type is recommended for vertical axes.</td>
<td></td>
</tr>
<tr>
<td>● Reference frequency response with active speed controller</td>
<td>Torque-generating current setpoint (input)</td>
</tr>
<tr>
<td></td>
<td>Torque-generating actual current value (output)</td>
</tr>
</tbody>
</table>

Additional measuring types:

The speed controller is deactivated when measuring the current control loop. This is the reason why a vertical axis can drop.

<table>
<thead>
<tr>
<th>Measuring type</th>
<th>Measured quantities</th>
</tr>
</thead>
<tbody>
<tr>
<td>● Reference frequency response (after the current setpoint filter)</td>
<td>Torque-generating current setpoint (input)</td>
</tr>
<tr>
<td></td>
<td>Torque-generating actual current value (output)</td>
</tr>
<tr>
<td>● Setpoint step (after the current setpoint filter)</td>
<td></td>
</tr>
</tbody>
</table>

Measurement

The measurement sequence is divided into the following steps:

1. Set the traversing range monitoring and release logic.
2. Select the type of measurement:

![Image of measurement selection]
3. Press the "Meas. parameters >" softkey to adapt the parameters for a measurement. **Measurement parameters:**

   - **Amplitude:** Magnitude of the test signal amplitude.
     - Given in percent of the peak torque. Values from 1 % to 5 % are suitable.
   - **Bandwidth:** The frequency range analyzed with the measurement.
     - The bandwidth depends on the current controller sampling time.
     - Example: Sample time: 125 μs, bandwidth: 4000 Hz

4. To start the measurement, press softkey "Measure >" followed by softkey "Start meas."

Two measurements are performed and the result is then displayed:

10.5.2 Speed control loop measurement

**Function**

The response characteristics for the motor measurement system are analyzed when measuring the speed control loop. Various measurement parameter lists are available depending on the basic measurement setting which has been selected.

The predefined processes for the speed control loop are listed below. As in the current controller range, the excitation and measurement signals in the speed controller range refer to the SINAMICS S120 drive. The speed controller measurements differ in terms of the excitation, which can either be a disturbing torque, a speed setpoint before the filter or a speed setpoint after the filter. This is comparable with parameter p0480 for values 2, 3 or 5.

A distinction is made in the table between the input node and the excitation point. The input node only determines which signal is considered as the input for the subordinate system to be measured.
## Measuring functions

The following measuring functions are available for measuring the speed control loop:

<table>
<thead>
<tr>
<th>Measuring type</th>
<th>Waveform</th>
<th>Measured variable (input)</th>
<th>Measured value (output)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference frequency response (after the speed setpoint filter)</td>
<td>PBRS</td>
<td>Speed setpoint after the filter</td>
<td>Actual speed value motor</td>
</tr>
<tr>
<td>Reference frequency response (before the speed setpoint filter)</td>
<td>PBRS</td>
<td>Speed setpoint before the filter</td>
<td>Actual speed value motor</td>
</tr>
<tr>
<td>Setpoint step (after the speed setpoint filter)</td>
<td>PBRS</td>
<td>● Speed setpoint after the filter</td>
<td>Actual speed value motor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Actual torque value</td>
<td></td>
</tr>
<tr>
<td>Disturbance frequency response (disturbance after the current setpoint filter)</td>
<td>PBRS</td>
<td>Torque setpoint (function generator)</td>
<td>Actual speed value motor</td>
</tr>
<tr>
<td>Disturbance variable step (disturbance after the current setpoint filter)</td>
<td>Jump</td>
<td>● Torque setpoint (function generator)</td>
<td>Actual speed value motor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>● Actual torque value</td>
<td></td>
</tr>
<tr>
<td>Speed-controlled system (excitation after the current setpoint filter)</td>
<td>PBRS</td>
<td>Actual torque value</td>
<td>Actual speed value motor</td>
</tr>
<tr>
<td>Reference frequency response, current control loop</td>
<td>PBRS</td>
<td>Speed setpoint after the filter</td>
<td>Torque-generating actual current value</td>
</tr>
<tr>
<td>APC open control loop *</td>
<td>PBRS</td>
<td>Speed setpoint after the filter</td>
<td>APC controller output (r3777[1])</td>
</tr>
<tr>
<td>APC closed control loop *</td>
<td>PBRS</td>
<td>Speed setpoint after the filter</td>
<td>Actual speed value from the direct measurement system</td>
</tr>
<tr>
<td>APC mechanical system *</td>
<td>PBRS</td>
<td>Actual speed value motor encoder</td>
<td>Actual speed value from the direct measurement system</td>
</tr>
</tbody>
</table>

*) APC-related inputs appear only when the SINAMICS APC function module is activated. The status of the APC controller is determined depending on the measurement procedure.
Measurement sequence

The measurement sequence is divided into the following steps:

1. Set the traversing range monitoring and release logic.
2. Select the type of measurement:

   ![Image of measurement selection]

3. Press softkey "Meas. parameters >" to set the parameters.
4. To start the measurement, press softkey "Measure >" followed by softkey "Start meas.". In the example shown, the speed control loop has not yet been tuned:

   ![Image of measurement results]
5. A suitable filter parameterization is used to tune the dynamic response. Press the "Active filter" softkey. The following diagram shows the standard settings for a lowpass filter at 1999 Hz and a bandstop filter:

![Diagram showing filter settings](image)

6. After using the filter, the following tuned measurement curve results for the speed control loop:

![Measurement diagram](image)
Example: Setting the filter for the following error (speed control loop)

Requirement

The X axis is measured with the following settings:

- With feedrates in SD55822[0...5] $SCS\_FRICT\_OPT\_FEED$ for step 1 ... 6 and SD55822[6...8] $SCS\_FRICT\_OPT\_FEED$ = 0 for step 7 ... 9
- Radius 8 mm in SD55820 $SCS\_FRICT\_OPT\_RADIUS$

Measuring the X axis

Procedure:

1. Select the dialog for the tuning via the "NC" and "Friction compensation" softkeys.
2. Select the X axis and press "Start".
3. Confirm the program editor by pressing "OK" without any further inputs. The X axis is not measured with separate reversal points.
4. Enter a value for step 1 and change the parameters until you are satisfied with the compensation.
5. Press "Next >" to change to the next step.

<table>
<thead>
<tr>
<th>Step 1 of 6:  1,000 mm/min</th>
<th>Amplitude: 15.220 mm/min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decay time: 0.038 s</td>
</tr>
<tr>
<td></td>
<td>Active time: 0.012 s</td>
</tr>
<tr>
<td>Step 2 of 6:  600 mm/min</td>
<td>Amplitude: 10.750 mm/min</td>
</tr>
<tr>
<td></td>
<td>Decay time: 0.034 s</td>
</tr>
<tr>
<td></td>
<td>Active time: 0.016 s</td>
</tr>
</tbody>
</table>

6. Repeat this process for all steps. Press "OK" to save the data.

Result

The following graphic shows the characteristic curves of the X axis for various radiiuses:

Position control loop measurement

Function

The predefined processes for the position control loop are listed in the following table. The position controller measurements are performed in the NC. The measurements support three excitation variants: Position setpoint, speed setpoint, torque setpoint and torque feedforward control. In cases with two configured measuring systems, the selection of the signal output node supports encoder 1, encoder 2, and the active encoder.
## Predefined measuring procedure

The following measuring procedures are available for measuring the position control loop:

<table>
<thead>
<tr>
<th>Process</th>
<th>Curve form</th>
<th>Excitation point</th>
<th>Input signal</th>
<th>Output signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference frequency response</td>
<td>PRBS</td>
<td>Position setpoint</td>
<td>Position setpoint</td>
<td>Position actual value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Position actual value encoder 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Position actual value encoder 2</td>
</tr>
<tr>
<td>Setpoint step</td>
<td>Jump</td>
<td>Position setpoint</td>
<td>Position setpoint</td>
<td>Position actual value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>System deviation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Contour deviation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Speed actual value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Position actual value encoder 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Position actual value encoder 2</td>
</tr>
<tr>
<td>Setpoint ramp (recommended)</td>
<td>Ramp</td>
<td>Position setpoint</td>
<td>Position setpoint</td>
<td>Position actual value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>System deviation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Contour deviation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Speed actual value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Position actual value encoder 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Position actual value encoder 2</td>
</tr>
<tr>
<td>Mechanical frequency response</td>
<td>PRBS</td>
<td>Speed setpoint</td>
<td>Position actual value</td>
<td>Position actual value encoder 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Position actual value encoder 1</td>
<td>Position actual value encoder 2</td>
</tr>
<tr>
<td>Disturbance frequency response</td>
<td>PRBS</td>
<td>Torque feedforward control</td>
<td>Torque feedforward control (excitation)</td>
<td>Position actual value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>System deviation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Contour deviation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Speed actual value</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Position actual value encoder 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Position actual value encoder 2</td>
</tr>
</tbody>
</table>

* The mechanical frequency response represents the relationship between the motor measuring system and the direct measuring system, and is measured by the position controller. The selection is only possible if a second encoder has been detected.
Measurement sequence

The measurement sequence is divided into the following steps:

1. Set the traversing range monitoring and release logic.

2. Select the type of measurement:

   ![Measurement selection screenshot]

   - Measurement type: Linear
   - Drive type: SRM (synchronous rotation motor)
   - Drive number: 3
   - Drive identifier: SERVO_3_35
   - Meas. system 1: Motor
   - Meas. system 2: Direct

3. Press softkey "Meas. parameters >" to set the parameters.

4. To start the measurement, press softkey "Measure >" followed by softkey "Start meas.".

   Two measurements are performed. The result shows a tuned position control loop in which the servo gain factor has been adapted with the associated machine data MD32200 $MA_POSCTRL_GAIN.

   ![Measurement result screenshot]

   - Amplitude (dB) / Phase (∘) vs. Hz

   ![Amplitude and phase graph]

   - Current cont. loop
   - Speed cont. loop
   - Position cont. loop
   - Function generator
   - Circular test
   - Active filters
   - Auto servo tuning

---

Drive tuning

10.5 Measuring functions (manual tuning)
10.5.5 Examples for the measuring methods (position control loop)

Measuring type: Reference frequency response

The reference frequency response measurement determines the transfer behavior of the position controller in the frequency range. The position actual value is taken from the active measuring system. The setpoint filters, control loop gain and feedforward control must be parameterized so that resonance is avoided wherever possible over the entire frequency range.

Measurement parameters:

- **Amplitude**
  This parameter determines the magnitude of the test signal amplitude. It should be set to the smallest possible value, e.g. 0.01 mm

- **Bandwidth**
  The bandwidth parameter is used to set the analyzed frequency range. The larger this value, the finer the frequency resolution and the longer the measurement time. The maximum value is specified by the position controller cycle ($T_{position\ controller}$):
  \[
  \text{Bandwidth}_{\text{max}}[\text{Hz}] = \frac{1}{2 \times T_{position\ controller}[\text{s}]} 
  \]
  Example:
  - Position controller cycle: 2 ms
  - Bandwidth$_{\text{max}} = \frac{1}{2 \times 2 \times 10^{-3}} = 250$ Hz

- **Averaging**
  The accuracy of the measurement and in turn the measurement duration increase with this value. A value of 4 is normally adequate.

- **Settling time**
  This value represents the delay between recording of the measured data and injection of the test setpoint and offset. A value of between 0.2 s and 1 s is recommended. Do not set too low a value for the settling times or the frequency response and phase diagrams will be distorted.

- **Offset**
  The measurement requires a speed offset of a few motor revolutions per minute. The offset must be set such that no speed zero crossings occur at the set amplitude, and that the axis continually moves in one direction.

Measuring type: Setpoint step and setpoint ramp

The transient and the positioning response of the position control in the time domain, and in particular the effect of setpoint filters, can be assessed with the step and ramp excitation functions.

**Setpoint step:**

To avoid overloading the machine mechanical system, for the “Setpoint step” measuring type, the step amplitude is limited to the following value:

$MD32000 \ \text{SMA\_MAX\_AX\_VELO (maximum axis velocity)}$

**Setpoint ramp:**
Solid line: At maximum axis acceleration, the velocity changes (almost) according to a step function.

Dashed line: This characteristic corresponds to a realistic, finite value. The offset component is excluded from the display graphic in order to emphasize the transient processes.

Figure 10-6 Signal characteristic for position control

With measuring type "Setpoint ramp", the following machine data influences the measurement result:

- **MD32000 $MA_MAX_AX_VELO** (maximum axis velocity)
  The maximum axis velocity limits the ramp gradient (velocity limitation). The drive does not reach the programmed end position (amplitude).

- **MD32300 $MA_MAX_AX_ACCEL** (maximum axis acceleration)
  The maximum axis acceleration limits the velocity change (acceleration limitation).

---

**CAUTION**

**Protection of the machine**

In normal cases the machine data corresponds exactly with the load capacity of the machine kinematics and should not be changed (increased) as part of the measurements:

- **MD32000 $MA_MAX_AX_VELO** (maximum axis velocity)
- **MD32300 $MA_MAX_AX_ACCEL** (maximum axis acceleration)

---

**Measurement parameters: Setpoint step and setpoint ramp**

The transient and the positioning response of the position control in the time domain, and in particular the effect of setpoint filters, can be assessed with the step and ramp excitation functions.

Measurement parameters:

- **Amplitude**
  Determines the amplitude of the specified setpoint step or setpoint ramp.

- **Rise time**
  This parameter determines the period of time to be recorded (maximum 2048 position controller cycles).
- **Settling time**
  This value represents the delay between measured data recording / test setpoint output and the injection of the offset.

- **Rise time**
  The position setpoint is specified with the “Setpoint ramp” basic setting according to the selected ramp duration.

- **Offset**
  The step is stimulated from standstill or starting from the constant traverse speed set in this parameter. If an offset value other than zero is input, the test excitation takes place during the traverse. For the sake of clarity, the displayed position actual value does not include this constant component.

### 10.5.6 Function generator

**Function description**

The function generator can be used, for example, to perform the following tasks:

- Measuring and optimizing closed-loop control circuits
- Comparing the dynamic properties of coupled drives
- Specifying a straightforward traversing profile without traversing program

The function generator can be used to generate various signal forms.

In the Servo mode, the setpoint can additionally be supplied into the control structure in accordance with the currently selected mode, for example, as a current setpoint, disturbing torque or speed setpoint. Any influence of overlaid closed-loop control circuits is suppressed automatically.

**Position of the application points:**

![Diagram of application points](image)
To activate the function generator, select "Commissioning" operating area → "Automatic servo optimization" → "Function generator".

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting/stoping the function generator</td>
</tr>
<tr>
<td>The motion of the drive is not monitored when the function generator is activated.</td>
</tr>
<tr>
<td>With the corresponding ramp-function generator parameter settings (e.g. offset), the axis can traverse to the end stop.</td>
</tr>
</tbody>
</table>

The travel-release drive test can be performed by the PLC with or without active monitoring of the axis:
- With PLC
- Without PLC

The NC monitors the position and stops the function generator when the axis position goes beyond the specified upper or lower limit. The scaling can be changed while the function generator is running.

Operating mode of the function generator for servo and vector:
- Connector output

Operating modes of the function generator only for servo:
- Current setpoint after the filter
- Disturbing torque
- Speed setpoint after the filter
- Current setpoint before the filter
- Speed setpoint before the filter

Periodic or non-periodic signals with different waveforms are generated by the function generator. The curve parameters vary depending on the signal type.

<table>
<thead>
<tr>
<th>Connection point</th>
<th>System</th>
<th>Waveform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>SINAMICS</td>
<td>Rectangle</td>
</tr>
<tr>
<td>Current setpoint after the filter</td>
<td></td>
<td>Staircase</td>
</tr>
<tr>
<td>Disturbing torque</td>
<td></td>
<td>Triangle</td>
</tr>
<tr>
<td>Speed setpoint after the filter</td>
<td></td>
<td>PRBS (white noise)</td>
</tr>
<tr>
<td>Current setpoint before the filter</td>
<td></td>
<td>Sinusoidal</td>
</tr>
<tr>
<td>Speed setpoint before the filter</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Position setpoint</td>
<td>NC</td>
<td>Rectangle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PRBS (white noise)</td>
</tr>
</tbody>
</table>

Further actions:
- "Axis +", "Axis -" or "Direct selection >" softkeys to select the axis on which the signal is applied (that to be excited).
- "Start" softkey to start the function generator.
● “Stop” softkey to stop the function generator.
● “Parameter” softkey to adapt the parameter belonging to the connection point.

10.5.7 Example, function generator: Speed setpoint after the filter

Example

Function generator with connection point "Speed setpoint after filter":

Description of parameters

Parameter at the connection point "Speed setpoint after filter":

---

CNC Commissioning: NC, PLC, Drive
Commissioning Manual, 12/2019, A5E48312804B AA
The bars in the upper line indicate the traversing path, the actual position and the software limit switches. The value for the **absolute position** is displayed in the first line of the table.

- **Status** indicates whether the axis is referenced, and whether sufficient space is available to the software limit switch. If the measurement parameter results in an excessively long traversing distance, so that before the end of the measurement, a software limit switch would be reached, then this is displayed in color, in the "Status" row:
  - "Fault" + red: The measurement is not possible, as the software limit switch would be passed.
  - "Caution" + yellow: The measurement is possible, but there is only a limited distance remaining.
  - "No reference point + yellow: The axis is not referenced, the user must check the traversing distance.
  - "OK" + green: The axis is referenced, and a measurement is possible as the traversing distance lies within the software limit switch.

- **Waveform**: Depending on the selection (square wave, staircase, triangular, PBRS, sinusoidal)
  - Amplitude and offset velocity can either be entered as an absolute number or as a percentage. The amplitude can be specified to be either positive or negative.
    - **Amplitude**: Velocity in [mm/min]
    - **Amplitude %**: Velocity in %
    - **Offset**: Constant velocity in [mm/min]
    - **Offset %**: Constant velocity in %

- **Period**: In [ms]
- **Pulse width**: In [ms]
- **Ramp-up time**: In [ms]

- **Upper/lower limit**: The limiting of the output signal to the minimum and maximum value can be set. If the signal characteristic is greater than the upper limit value, the signal is cut off above the limit.

- **Upper/lower limit %:**
- **Sample time**: Time in [ms] until the measurement starts: 0.125 ms (default setting).

**Further actions:**
- Softkey "<< back", to return to the function generator overview.
10.6 Define filter

Filter types

The graphical user interface for the display and processing of filters actively available in the SINAMICS converter can be found under "Active filter":

<table>
<thead>
<tr>
<th>Filter type</th>
<th>Parameter 1</th>
<th>Parameter 2</th>
<th>Parameter 3</th>
<th>Parameter 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT1 low pass</td>
<td>Time constant [ms]</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>PT2 low pass</td>
<td>Frequency [Hz]</td>
<td>Damping (without unit)</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>General 2nd order</td>
<td>Rated frequency [Hz]</td>
<td>Rated damping [without unit]</td>
<td>Counter frequency [Hz]</td>
<td>Counter damping [without unit]</td>
</tr>
<tr>
<td>Band-stop (notch)</td>
<td>Notch frequency [Hz]</td>
<td>Band frequency [Hz]</td>
<td>Notch amplitude [dB]</td>
<td>Final amplitude [dB]</td>
</tr>
<tr>
<td>Low-pass with reduction</td>
<td>Frequency [Hz]</td>
<td>Damping [without unit]</td>
<td>Final amplitude [dB]</td>
<td>---</td>
</tr>
</tbody>
</table>

*) A negative value is often set here in order to attain attenuation of the notch frequency.

Automatic generation and representation of frequency response functions (dB amplitude and degree phase compared to frequency) provides the user with immediate feedback for each filter parameter. The units for the filter type and the limits for the parameters are defined directly by the metadata for the corresponding drive parameters.

Example: "Active filters"

The new values become active in the drive with softkey "Accept".

The values are saved in the drive and backed up in the drive archive with softkey "Save drive object".
10.7 Circularity test

10.7.1 Circularity test: Function

**Benefits**

The circularity test serves to set and assess the dynamic response for interpolating axes and to analyze the contour accuracy on the quadrant transitions (circular contours) achieved by means of friction compensation. The circularity test is used to check the interpolation of the axes which work together. This function measures a circle with reference to the motor or to the direct measuring system. Alignment of the machine-mechanical equipment is not taken into account in the result. This gives the commissioning engineer the option of separating problems with the controller tuning from mechanical problems.

The following axis machine data and parameters are checked with this procedure:

- MD32200, MD32400, MD32402, MD32410, MD32490, MD32500, MD32510, MD32520, MD32540, MD32620, MD32640, MD32810, MD32900, MD32910, MD32930, MD32940
- p1421 bis p1426, p1400, p1433, p1434

The following compensations should be disabled if this procedure is carried out:

- MD32450 backlash compensation
- MD32500 friction compensation
- MD32700 leadscrew error compensation
- MD32710 Enable sag compensation
- MD32750 Temperature compensation type

**Note**

MD32450 $MA_BACKLASH: Backlash compensation must be adjusted using an external device, such as a circularity test or gauge.

**Example of an NC program to dimension X-Y axes:**

```plaintext
FFWON
SOFT
G90 G01 F3000 X400 Y200 Z500
LAB:
G91 G64 G02 X0 Z0 I10
GOTOB LAB
M30
```

Position, feedrate and active plane must be adjusted to the machine! Alternatively, you can generate a program using a softkey.
Result

The best contour results are achieved when the circular form test results are in the correct actual size, shape and minimum p/p deviation between a combined interpolation of the axes (X-Y, X-Z, Y-Z).

An NC program in the MDA operating mode and the circularity test function are used to measure and evaluate these results. The “worst case” of a circle radius and the path velocity must lead to a realistic radial acceleration of which the machine is capable.

Circularity tests of machine manufacturers usually use a radius of 100 mm or 150 mm with feedrate speeds that are determined by the machine manufacturer. The machine manufacturer determines the specifications for an acceptable result.

High-speed processes generally have higher requirements for testing circles with high-speed milling machines and can range from circle radii of 10 - 25 mm and feedrates of 5 - 10 m/min. For high-speed milling machines, the results are generally acceptable if the P/P deviation ≤ 0.010 mm and the actual size of the circle is equal to the programmed radius – or in the worst-case scenario – to the path velocity.

10.7.2 Circularity test: Performing the measurement

Setting parameters

![Figure 10-8  Circularity test - measurement](image)
Enter the following parameters to carry out a measurement:

- **"Measurement"**: Selection of the two axes that are intended to be measured and selection of the measurement system. Parked encoders are not displayed for selection.

- **"Parameter"**: The parameter settings in the "Radius" and "Feed" input fields must correspond to the values from the part program that controls the circular motion of the axes, taking account of the feed override switch setting.

- **"Representation"**: Parameters for displaying the graphics
  - "Resolution" (scaling) of the diagram axes in [mm/scaled]
  - "Display" via the mean radius or programmed radius

**Perform measurement**

Procedure:

1. In the "Commissioning" operating area select the "Optim./test" softkey → "Circularity test" softkey.

2. Select the axes that are intended to be measured with the <SELECT> key or with the "Axis +"/"Axis -" softkeys.

3. Set the parameters for the measurement: "Radius" and "Feed"
   The "Measurement time" display field shows the measurement time calculated from the "Radius" and "Feed" values for recording the actual position values during the circular movement:
   If the measurement time is not sufficient then only parts of the circle are portrayed. The measurement time can be increased by reducing the feed value. This also applies if the circularity test is started from the stationary condition.

4. Set the parameters for displaying the graphic:
   If the measurement time calculated from this exceeds the time range that can be displayed (maximum measurement time = position controller cycle frequency * 2048), an appropriate sample time is calculated for recording (n * position controller cycle frequency), so that a complete circle can be displayed.

5. To automatically generate a program, with which you traverse the selected axes, press softkey "Generate circle program". The program is displayed for checking purposes and must be confirmed. Ensure that the axes can be traversed according to the program and that the traversing paths are free.

6. To start the measurement, press the "Start" softkey. The softkeys cannot be used while the measurement is being performed - with the exception of the "Stop" softkey.
Displaying a graphic

To display the measurement result as a graphic, press the "Graphic" softkey.

Additional actions:

- Press softkey "Full screen" to display the graphic on a full screen. If the active "Full screen" softkey is activated a second time, you will return to the previous display with graphic and display information.
- Press the "Tuning" softkey to carry out additional tuning adaptations. On a new softkey bar, you can navigate directly to the following areas:
  - "Service axis" in the operating area "Diagnostics"
  - "Axis machine data"
  - "Drive machine data"
  - "User views"
- To start the measurement, press the "Start" softkey.
- To stop the measurement, press the "Stop" softkey.
- Press the "Load" softkey to display parameters or the graphic of a measurement.
- Press the "Save" softkey to save parameters or the graphic of a measurement. The graphic can be saved as a pixel graphic in the PNG or BMP format. The measurement data are saved in the xml format as *.sud. The following path is set as default path: user/sinumerik/hmi/log/optimization/circular
- With softkey "<< Back", you return to dialog "Circularity test - measurement".

10.7.3 Circularity test: Examples

The MD32400 $MC_AX_JERK_ENABLE axial jerk limitation is set via a time constant and is always active.
Machine data for setpoint filter:

- MD32402 $MC_AX_JERK_MODE = Type 2 is recommended, type 1 is preset for compatibility reasons. Parameterizing a pure band-stop filter is expressly not recommended.

- MD32402 $MA_AX_JERK_MODE (filter type) and MD32410 $MA_AX_JERK_TIME > 0 is effective only if MD32400 $MA_AX_JERK_ENABLE = 1 is set.

**Example 1 for optimization**

Machine data after optimization of the axes:

<table>
<thead>
<tr>
<th>Parameters / machine data</th>
<th>X axis</th>
<th>Z axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32200 $MC_POSCTRL_GAIN</td>
<td>8.500</td>
<td>8.500</td>
</tr>
<tr>
<td>p1460 SPEEDCTRL_GAIN1</td>
<td>3.01</td>
<td>3.89</td>
</tr>
<tr>
<td>p1462 SPEEDCTRL_INTEGRATOR_TIME_1</td>
<td>6.18</td>
<td>6.18</td>
</tr>
<tr>
<td>p1463 SPEEDCTRL_REF_MODEL_FREQ</td>
<td>106.3</td>
<td>106.3</td>
</tr>
<tr>
<td>p1440 NUM_SPEED_FILTERS</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>MD32610 $MC_VELO_FFW_WEIGHT</td>
<td>1.0</td>
<td>1.0</td>
</tr>
<tr>
<td>MD32620 $MC_FFW_MODE</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>MD32810 $MC_EQUIV_SPEEDCTRL_TIME</td>
<td>0.0022</td>
<td>0.0022</td>
</tr>
<tr>
<td>MD32400 $MC_AX_JERK_ENABLE</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

The actual value of the radius is generally too large with optimized feed precontrol. This can be corrected with the MD32410 $MC_AX_JERK_TIME time constant. Use a time constant in all axes if required.

This circle displays the results after the feed precontrol has been optimized. However, the mean radius is 0.0019 mm too large:

- X1: active measuring system
- Z1: active measuring system

**Parameter**
- Radius: 10.00000 mm
- Feedrate: 3000.00000 mm/min
- Measurement time: 1257 ms
- X1: active measuring system
- Z1: active measuring system

**Representation**
- Resolution: 0.01000 mm
- Display of. mean radius
  - Radius: 10.00190 mm
  - Delta R: 4.02698 μm

<table>
<thead>
<tr>
<th>Parameters / machine data</th>
<th>X axis</th>
<th>Z axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32200 $MC_POSCTRL_GAIN</td>
<td>8.500</td>
<td>8.500</td>
</tr>
<tr>
<td>p1460 SPEEDCTRL_GAIN1</td>
<td>3.01</td>
<td>3.89</td>
</tr>
<tr>
<td>p1462 SPEEDCTRL_INTEGRATOR_TIME_1</td>
<td>6.18</td>
<td>6.18</td>
</tr>
</tbody>
</table>
Example 2 for optimization

This circle shows the effect of a slightly different time constant for the axial jerk filter. The time constant is adapted in order to correct this type of error:

<table>
<thead>
<tr>
<th>Parameters / machine data</th>
<th>X axis</th>
<th>Z axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32400 $MC_AX_JERK_ENABLE</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>MD32402 $MC_AX_JERK_MODE</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>MD32410 $MC_AX_JERK_TIME</td>
<td>0.012</td>
<td>0.0125</td>
</tr>
</tbody>
</table>

X1: active measuring system
Z1: active measuring system

Parameter
Radius: 10.00000 mm
Feedrate: 3000.00000 mm/min
Measurement time: 1257 ms
X1: active measuring system
Z1: active measuring system

Representation
Resolution: 0.01000 mm
Radius: 10.00029 mm
Delta R: 25.47002 μm

Example 3 for optimization

This circle shows the effect of a significantly different time constant for the axial jerk filter. The time constant is adapted in order to correct this type of error:

<table>
<thead>
<tr>
<th>Parameters / machine data</th>
<th>X axis</th>
<th>Z axis</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD32400 $MC_AX_JERK_ENABLE</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>MD32402 $MC_AX_JERK_MODE</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>MD32410 $MC_AX_JERK_TIME</td>
<td>0.015</td>
<td>0.012</td>
</tr>
</tbody>
</table>

Parameter
Radius: 10.00000 mm
Feedrate: 3000.00000 mm/min
Measurement time: 1257 ms
X1: active measuring system
Z1: active measuring system

Representation
Resolution: 0.01000 mm
Radius: 10.00029 mm
Delta R: 25.47002 μm
10.7.4 Circularity test: Saving data

Backing up measurement data

The file is structured as follows (with comments in brackets [ ]):

H: CstPic [Identifier for circularity test graphic]
V: 5.0 [Version number of the file format]
@ parameters
P 1: 10 [Radius]
P 2: 3000 [Feed]
P 3: 1257 [Measuring time]
P 4: 0 [Measuring system Axis 1 - 0: active; 1: first; 2: second]
P 5: 0 [Measuring system Axis 2 - 0: active; 1: first; 2: second]
@ Representation
P 10: 10 [Resolution]
P 11: 8 [8 = mean R; 9 = prog. radius]
P 12: X1 [Axis name 1]
P 13: Z1 [Axis name 2]
@ Intermediate values
P 20: 15.6632 [max. radius measured values]
P 21: 10.9326 [min. radius measured values]
P 22: 13.6694 [mean radius measured values]
P 23: 1886 [Number of measured values]
@Additional values
P 30: 1000 [Accuracy (1/P30)]

@Physical units
P 40: 5370 [Text number radius unit]
P 41: 5381 [Text number feed unit]
P 42: 6165 [Text number Resolution unit]
P 43: 5346 [Text number DeltaRadius unit]
P 44: 0 [New: Operate: Basislengthunit]

@Abscissa
Ai: [Abscissa values i : 0..P23]

@Ordinate
Oi: [Ordinate values i : 0..P23]

@Radius
Ri: [Radius values i : 0..P23]
10.8 Decision-making support for APC and APC ECO

Conditions for Advanced Position Control

There is a vibration on the load side of the axis (carriage, table) in the axis direction:

- The vibration is excited by the axis motion.
- The vibration is excited by the machining process (e.g. milling, first cut).

Software option
In order to use this function a license is required for the following option:
"Advanced Position Control" (6FC5800-0AM13-0YB0)

Criteria for Advanced Position Control

The vibration could also be reduced by a weaker speed controller:

- p1460 Speed controller P gain adaptation speed, lower Increase P gain
- p1462 Speed controller integral time adaptation speed, lower Reduce integral time Tn

The noise suppression and dynamic behavior of the closed-loop controller worsens with a weak speed controller. Disturbance variables, such as friction, then occur more often, especially with reversing behavior (the quadrant on the circle worsens), and marks become visible on the workpiece. Use the Advanced Position Control to find a compromise between noise suppression and oscillation damping.

Conditions for Advanced Position Control ECO

The vibration could also be reduced by a weaker speed controller:

- p1460 Speed controller P gain adaptation speed, lower Increase P gain
- p1462 Speed controller integral time adaptation speed, lower Reduce integral time Tn

This is, for example, possible if the gear factor is small or the spindle pitch is at least 10 mm.

Software option
In order to use this function a license is required for the following option:
"Advanced Position Control ECO" (6FC5800-0AM12-0YB0)

Criteria for Advanced Position Control ECO

If the above-mentioned conditions are fulfilled, perform the following steps:

1. Configure Advanced Position Control ECO to identify the frequency of the vibration: Approx. 30% accuracy is adequate.
2. Oscillation damping: Enter frequency, activate Advanced Position Control ECO and then check the vibration response on the load side.
If the oscillation reduction is not effective, another mode can be activated which can specifically compensate machine base-related oscillation.

It is recommended first to deactivate the oscillation damping of junction ② and to activate the APC filter for the machine base-related oscillation.

If the filters for the machine base-related oscillation are also ineffective, the causes may be:
1. The vibration does not occur in the axis direction.
2. The vibration cannot be measured on the motor.
3. The vibration is not measured with Advanced Position Control ECO.

For a machine equipped with SINUMERIK 840D sl and a second measuring system for the axis, it is recommended to install the Advanced Position Control function module with two encoders.

**Decision-making support**

When is Advanced Position Control needed with a second encoder?

- If the damping achieved by "Advanced Position Control ECO" is inadequate.
- If the motor cannot attenuate the vibration - even with a weak speed controller.

Possible reasons:
- The leadscrew pitch is too small, e.g. 5 mm
- The Gear factor motor/load revolutions is very high, e.g. p0433 ≥ 30
- The drive train has too much self-locking.
- The Tool Center Point is so far from the motor that the vibrations can only be measured by a nearby direct measuring system.
10.8 Decision-making support for APC and APC ECO
Saving and managing data

11.1 Saving data

Time of the data backup
The following times are recommended for performing a data backup:
- After commissioning
- After changing machine-specific settings
- After replacing a hardware component
- Before a software upgrade
- Before the activation of memory-configuring machine data

Creating and importing a commissioning archive
In order to create and import a commissioning archive of the type "*.arc", select the softkey "IBN Archive":
- Creating a commissioning archive
- Creating a PLC hardware upgrade archive (only SDBs)
- Importing a commissioning archive
- Creating an original status archive
- Reading in an original status archive
### What data is saved?

<table>
<thead>
<tr>
<th>Components</th>
<th>data</th>
</tr>
</thead>
</table>
| NC data    | ● 3D collision model  
            | ● Compile cycles  
            | ● Cycles  
            |   – User cycles  
            |   – Manufacturer cycles  
            |   – Standard cycles  
            | ● Definitions  
            | ● NC active data  
            |   – User data (GUD, LUD)  
            |   – Machine data  
            |   – Compensation data (measuring system error compensation, friction compensation, sag / angularity error compensation)  
            |   – Zero offsets  
            |   – Option data  
            |   – R parameters  
            |   – Protection zones  
            |   – Setting data  
            |   – Tool and magazine data  
            |   – Initialization program (INI)  
            | ● Part programs  
            | ● Subprograms  
            | ● Workpieces  
            | ● Comments  
| NC data with compensation data | **Note:** It only makes sense to archive machine-specific compensation data if the commissioning file is reloaded into the same controller. |
| NC data with compile cycles | The compile cycles (`.elf`) option is displayed only if compile cycles are also available. |
| PLC data   | ● OB (organization blocks)  
            | ● FB (function blocks)  
            | ● FC (functions)  
            | ● DB (data blocks)  
            | ● SFB (system function blocks)  
            | ● SFC (system functions)  
            | ● SDB (system data blocks).  
|            | **Note:** System data blocks are only used to back up the hardware configuration (not the programming logic). |
## Components data

| Drive data | • Binary or ASCII format  
| • Extended selection: Drive units |
| HMI data | • Applications: User, manufacturer  
| • Data backups: Commissioning data, network topology  
| • Easy Extend  
| • Settings  
| • Help  
| • PLC project  
| • Reports: Action log, screenshots etc.  
| • Safety Integrated (acceptance test)  
| • Texts  
| • Version data  
| • Templates  
| • Dictionaries: For Chinese simplified and Chinese traditional (IME) |

### 11.1.1 Backup of PLC data

#### PLC operating state

When creating a commissioning archive with PLC data, the PLC image that is saved during this process depends on the operating state of the PLC at the time of creation:

- Original image
- Instantaneous image
- Inconsistent image

The operating state of the PLC can be changed in the following ways:

- With SIMATIC STEP 7 Manager
- With the PLC mode selector on the NCU: Position " 2" → STOP, position " 0" → RUN

#### Operating sequence for original image

The original image of the PLC is represented by the PLC-data state immediately after loading the S7 project into the PLC.

1. Set the PLC to the STOP operating state.
2. Load the appropriate S7 project into the PLC using SIMATIC Manager STEP 7.
3. Create a commissioning archive with PLC data.
4. Set the PLC to the RUN operating state.
Operating sequence for instantaneous image

If you cannot create an original image, you can save an instantaneous image as an alternative.

1. Set the PLC to the STOP operating state.
2. Archive the PLC data.
3. Set the PLC to the RUN operating state.

Operating sequence for inconsistent image

An inconsistent image results if a commissioning file with PLC data is created and the PLC is in the RUN state (cyclic operation). The data blocks of the PLC are saved at different times with contents that have changed in the meanwhile. This may result in a data inconsistency that, once the data backup has been copied back to the PLC, may under certain circumstances result in a PLC stop in the PLC program.

---

NOTICE

Ensure data consistency

The creation of a commissioning file with PLC data while the PLC is in RUN state (cyclic operation) may result in an inconsistent PLC image in the commissioning archive. After this commissioning archive has been copied back, the data inconsistency in the PLC program may under certain circumstances result in a PLC stop.

---

11.1.2 Creating a commissioning archive

Requirement

The following access levels are required:

- In order to create a commissioning archive, at least access level 4 (key-operated switch 3) is required.
- In order to import a commissioning archive, at least access level 2 (service) is required.

It is not permissible that the default setting in MD11230 $MN_MD_FILE_STYLE is changed in order to guarantee that a commissioning file with access level 2 (service) can be read in:

- Generate line checksum and MD numbers.
- To prevent a topology error, Control Unit parameter p9906 (topology comparison level of all components) should be set to "Medium" in order to import a commissioning archive.

Creating a commissioning archive

Series commissioning means bringing a series of control systems to the same initial state as regards their data. A commissioning archive contains NC, PLC, drive and HMI data. Compensation data of the NC can also be optionally saved. For a data backup, the drive data is saved as binary data that cannot be read.
Procedure:

1. To create a commissioning archive, select: "Commissioning" operating area → forward key → "Commissioning archives" → "Creating a commissioning archive" option:

![Screenshot of the Siemens SINUMERIK Operate interface showing how to create a commissioning archive]

- Select the data to be backed up:
  - NC data: With/without compensation data
  - PLC data
  - Drive data: Binary/ASCII
  - HMI data: All/selection

2. Enter an archive name.

3. The following directories are offered as a storage location for the archive:
   - Archive/user or Archive/manufacturer
     Absolute path specification: /user/sinumerik/data/archive or /oem/sinumerik/data/archive
   - All configured logical drives (USB, network drives)

Note

USB FlashDrive

USB FlashDrives are not suitable as persistent memory media.
11.2 Managing data

Application

The "Manage data" function is used to support and simplify the commissioning and provides functions for backup, load and comparison of machine, setting, compensation and drive data.

In contrast to a commissioning archive, only a single control object (axis, channel, servo, infeed, etc.) is saved in ASCII format (*.TEA). This file can be edited and transferred to other control objects of the same type. The "Manage data" function is also the basis for copying DO for SINAMICS drives.

Managing data

The "Manage data" function offers the following options:

- Transfer data within the controller
- Save data to a file
- Load data in a file
- Compare data

The function is called from "Commissioning" → "Machine data" → "Manage data".

Example of "Transfer data within the controller":

The following data can be saved and stored under the following absolute path on the CompactFlash card:

- **user/sinumerik/hmi/data/backup/ec** for compensation data
- **user/sinumerik/hmi/data/backup/md** for machine data
- **user/sinumerik/hmi/data/backup/sd** for setting data
- **user/sinumerik/hmi/data/backup/snx** for SINAMICS parameters
11.2.1 How to transfer data within the controller

Transfer data within the control

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protection of the machine</td>
</tr>
<tr>
<td>For safety reasons, the machine and setting data should only be transferred when the enable is locked.</td>
</tr>
</tbody>
</table>

Procedure:
1. Select the "Transfer data within the control" option.
2. Select the source data in the data structure and confirm with "OK".
3. In the drop-down list, select an object, e.g. a different axis or a different drive object, to which you want to transfer the data and confirm with "OK".
4. Observe the safety instructions and check the enable signals at the machine and the drive.
5. For drive data, the "Load" softkey is used to transfer the data to the target object.

11.2.2 To save and load data

Save data to a file

Procedure:
1. Select the "Save data to a file" option.
2. In the data structure, select the data that you want to save to a file and confirm with "OK".
3. Select as the storage location, a directory or a USB storage medium and enter a name.

Note
SINAMICS parameters

An ASCII file (*.TEA) is always generated when saving.

Three files of the following type are generated when saving the drive data:
- A binary file (*.ACX) that cannot be read.
- An ASCII file (*.TEA) that can be read or edited in the ASCII editor.
- A log file (*.log) that contains message texts (error situation) or is empty (successful storage).
Loading data from a file

| NOTICE |
| Protection of the machine |
| For safety reasons, the machine and setting data should only be transferred when the enable is locked. |

Procedure:
1. Select the "Load data from a file" option.
2. In the data structure, select the saved file and confirm with "OK".
3. In the drop-down list, select an object, e.g. a different axis or a different drive object, to which you want to transfer the data and confirm with "OK".
4. Observe the safety instructions and check the enable signals at the machine and the drive.
5. For drive data, the "Load" softkey is used to transfer the data to the target object.

11.2.3 How to compare data

Compare data

Select the data sources to compare the data. For instance, compare the actual data in the control system with data saved in a file.

Procedure:
1. Select the "Compare data" option.
2. In the data structure, select the data that you want to compare.
3. Press the "Add to list" softkey to transfer the data to the list in the lower area of the display.
4. Press the "Delete from list" softkey to remove the data again.
5. If the list contains more than two data objects, you can activate the checkbox to compare two or more data objects from the list.
6. Press the "Compare" softkey to start the comparison. The display of the comparison results can take some time for extensive parameter lists.
7. Press the "Legend" softkey to display or hide the legend. The following display is the default:
   - Different parameters are displayed.
   - Parameters that do not exist in both data sources, are displayed.
   - The same parameters are not displayed.
11.2.4 Example: Importing/exporting SINAMICS lists

Overview of SINAMICS lists

The following data are processed using the Import/export SINAMICS lists options:

- Motor data list of a "third-party motor" (= not a Siemens motor)
- Valve data list of a SINAMICS S120 Hydraulic Linear Actor Module

Example: Importing/exporting data lists

Import procedure:

1. Select the "Import SINAMICS lists" option to import a list from a USB storage medium.

2. The file name of the valve data list is not relevant. When importing, the file is copied with this name to the following target folder:
   Valve data list: /user/siemens/sinumerik/hmi/cfg/slsuhlvlvls.ini

3. The file name of the motor data list is not relevant. When importing, the file is copied under the associated name to the folder of the selected CU_I or CU_NX
   Motor data list for an induction rotation motor: ../motarm.acx
   If a motor data list is already available, a prompt asks whether it should be overwritten.

Procedure for exporting a valve data list:

1. Select the option "Export SINAMICS lists".

2. The archive location for the list is selected automatically.

3. Before copying, you can select a new file name when selecting the target folder.
12 New installation / upgrading

12.1 With the help of an NCU service system

Introduction

The CNC software on the CompactFlash card can be newly installed or upgraded.

- A reinstallation is required if there is no CNC software on the CompactFlash card (see Section New installation (Page 355)).
- An upgrade is required if an older CNC software is available on the CompactFlash card (see Chapter Upgrading (Page 362))

Tools for reinstallation/upgrade

You can perform a reinstallation/upgrade using the following tools:

- Access MyMachine /P2P
- WinSCP and VNC Viewer

For a reinstallation/upgrade, you require a bootable USB FlashDrive as an NCU service system.

Additional information is provided in Chapter "Generate service system" in the Operating system NCU (IM7) (https://support.industry.siemens.com/cs/de/de/view/109481527/en) Commissioning Manual

12.1.1 New installation

Introduction

No CNC software was installed on the CompactFlash Card. The CompactFlash Card is empty.

You have the following options of initiating a new installation of the CNC software:

- Automatic installation using USB-FlashDrive
- Installation using USB-FlashDrive
- Installation using WinSCP on PG/PC
- Installation using VNC Viewer on PG/PC
12.1.1.1 Automatic installation of the CNC software using USB-FlashDrive

Flow diagram

Automatic installation of the CNC software by USB flash drive

Is USB flash drive available with NCU service system?

Yes

No

Open Windows Explorer

Insert USB flash drive into PC/PG

Copy "autoexec.sh" and "<cnc-sw>_tgz" to USB flash drive (root folder)

Rename <cnc-sw>_tgz to full.tgz

Remove USB flash drive

NCU Power OFF?

Yes

No

SIM/NCK -> 7
PLC -> 0

Insert USB flash drive into NCU (X125)

NCU Power ON

-> RDY LED flashes green (approx. 5 s)

RDY LED red?

Yes

No

See error cause in the autoexec.log file (e.g. CompactFlash card too small)

RDY LED OFF?

Yes

No

Remove USB flash drive

SIM/NCK -> 1
PLC -> 3

NCU Power ON

PLC general reset

SIM/NCK -> 0
PLC -> 0

END

Figure 12-1 Automatic installation using USB-FlashDrive
Installation of the CNC software using USB-FlashDrive

Flow diagram

- Installation of the CNC software using USB flash drive
  - Installation of the NCU service system on USB flash drive
    - USB flash drive available with NCU service system
      - No
      - Open Windows Explorer
      - Insert USB flash drive into PC/PG
      - Copy "<cnc-sw>tgz" to USB flash drive (root folder)
      - Remove USB flash drive
        - NCU Power OFF
        - NCU Power OFF?
          - No
          - System TCU?
            - No
              - Connect the standard PC keyboard to the USB Front of PCU or OPx
              - SIM/NCK -> 0 PLC -> 0
                - 1
              - System PCU?
                - No
      - Insert USB flash drive into NCU (X125)
        - SIM/NCK -> 0 PLC -> 0
          - 2
  - Notice: File name of "<cnc-sw>tgz" lower case only.

Figure 12-2 Installing the control software using USB-FlashDrive
New installation / upgrading

12.1 With the help of an NCU service system

Flow diagram - installation of the system TCU (1) continued

![Flow diagram](image-url)

Figure 12-3 Installing the control software using USB-FlashDrive - continued (TCU system)
Flow diagram - installation of the system PCU (2) continued

1. Connect PCU Xxxx -> NCU X120
2. NCU / PCU Power ON
   - Boot PCU in service mode (WXP)
   - (key 3 -> manufacturer password)
   - Start WinSCP (desktop icon)
   - Login to 192.168.214.1 with user: "admin"
   - Password: "SUNRISE"
   - Menu "Commands" -> "Open terminal"
   - Input: "sc restore -full /data/<cnc-sw>.tgz"
   - Possible error: sc: ERROR: unknown option
     - -full/data/<cnc-sw>.tgz
     - Cause: Space missing between
     - -full and /data
   - Any data on the Compact-Flash card are deleted!

   - $ prompt reappears? No
     - NCU Power OFF
     - Remove USB flash drive
   - SIM/NCK -> 1
   - PLC -> 3
   - NCU Power ON
   - PLC general reset
     - SIM/NCK -> 0
     - PLC -> 0
   - Main Menu: 6 / F6: Restore NCU Software
     - 1 / F1: Recover from USB
     - 1 / F1: Recover system from selected file
     - 5 / F8: OK, continue
     - 7 / F7: to confirm
     - Display "Syncing disk... done."

   - Start VNC viewer (desktop icon)
   - Connect to 192.168.214.1

Figure 12-4 Installing the control software using USB-FlashDrive - continued (PCU system)
12.1.1.3 Installation of the CNC software using WinSCP on PC/PG

Flow diagram

Figure 12-5  Installation using WinSCP on PG/PC
12.1.1.4 Installation of the CNC software using VNC Viewer on PC/PG

Flow diagram

Figure 12-6: Installation using VNC Viewer on PG/PC
12.1.2 Upgrading

Upgrade options

You have the following options of upgrading the CNC software:

- Automatic upgrade using USB-FlashDrive
- Upgrade using USB-FlashDrive
- Upgrade using WinSCP on PG/PC
- Upgrade using VNC Viewer on PG/PC

**Note**

An upgrade is possible as of CNC software 2.xx. An upgrade from other software versions is not permitted. In this case, a new installation is required.

Before the upgrade, you can backup the complete CompactFlash card. Using Restore, you can write back this backup to the CompactFlash card.

Data backup before upgrades

Carry out a data backup before each upgrade:

- Commissioning archive of NC/PLC/drive data
- Load the PLC project into the PC/PG (STEP 7)
- License key

When the software is upgraded, all user data is kept on the CompactFlash card in the directories /user, /addon, /oem. The license key is kept as well.

Prior to overwriting a licensed CompactFlash card, a backup of the license key is absolutely necessary. The key is available in file 'keys.txt' and is stored under the path keys/sinumerik. The backup of the key can be performed, for example, with WinSCP, from the PG/PC.

**Note**

The licenses are permanently assigned to the CompactFlash card (card ID) and can only be used on this card.

The license key can be read back via Web License Manager (Page 45) using the card number.

Automatic upgrading

For an automatic upgrade with autexec.sh from the USB-FlashDrive, the CompactFlash card is first backed up.

The backup file "card_img.tgz" is saved under the following directory:

/machines/[machine name+serial number of the CompactflashCard]
An existing data backup is not overwritten. In this case, the operation is exited with an error. The upgrade is made once the backup has been successfully completed.

12.1.2.1 Backup/Restore

Introduction

Before the upgrade, you can backup the complete CompactFlash Card. Using Restore, you can write back this backup to the CompactFlash Card.
Automatic backup of the complete CompactFlash Card

Flow diagram

Figure 12-7  Automatic backup of the complete CompactFlash Card
Automatic restoration of the complete CompactFlash Card

Flow diagram

Figure 12-8  Automatic restoration of the complete CompactFlash Card
12.1.2.2 Automatic upgrade of the CNC software using USB-FlashDrive

Flow diagram

Figure 12-9 Automatic upgrade of the CNC software using USB-FlashDrive
12.1.2.3 Upgrading the CNC software using USB-FlashDrive

Flow diagram

Figure 12-10  Upgrading the CNC software using USB-FlashDrive
Flow diagram - continued system TCU (1)

Figure 12-11  Upgrading the CNC software using USB-FlashDrive - continued (TCU system)
Flow diagram - continued PCU system (2)

1. Connect PCU Xxxx -> NCU X120
2. NCU / PCU X120 Power ON
3. Boot PCU in service mode (Windows XP, key 3 -> manufacturer password)

Start WinSCP (desktop icon)
- Login to 192.168.214.1 with user "manufactur" PW "SUNRISE"
- Menu "Commands" -> "Open terminal"
- Input: "sc restore -update /data<ncu-sw>.tgz"
- $ prompt reappears?
  - No

Start VNC viewer (desktop icon)
- Connect to 192.168.214.1
- Main Menu: 5 / F5: Update NCU Software
  - 1 / F1: Update system software from USB memory stick
  - 8 / F8: OK, continue
  - 7 / F7: to confirm
- Display "Syncing disk... done."

NCU Power OFF
- Remove USB flash drive
- SIM/NCK -> 1 PLC -> 3
- NCU Power ON
- PLC general reset
- SIM/NCK -> 0 PLC -> 0
- Loading NC archive

New Toolbox
- No
- Load PLC archive
- Notice: Do not overwrite blocks with user program (e.g. OB1, OB100, etc.)
- Load drive archive
- END

Possible error: sc ERROR: unknown option -update/data<ncu-sw>.tgz
Cause: Space missing between -update and /data

Figure 12-12  Upgrading the CNC software using USB-FlashDrive - continued (PCU system)
12.1.2.4 Upgrading the CNC software using WinSCP on PC/PG

Flow diagram

- Upgrade the CNC software using WinSCP on PC/PG
  - Create NC/PLC/drive archive on CompactFlash card, PCU and/or USB flash drive
  - Load PLC project to PC/PG (STEP 7) USB flash drive
  - Is USB flash drive available with NCU service system?
    - Yes: Installation of the NCU service system on USB flash drive
    - No: Copy "<cnc-sw.tgz" to USB flash drive (root folder)
  - NCU Power OFF?
    - Yes: Insert USB flash drive into NCU (X125)
      - Connect NCU (X127) = PC/PG
        - NCU Power ON
        - Start WinSCP on PC/PG
  - Only if new Toolbox necessary
    - Login to 192.168.215.1 with user: "admin" password: SUNRISE
      - "Commands" menu ⇒ "Open terminal"
      - Input: sc restore -update /data/<cnc-sw>.tgz
      - Display "Syncing... disk done."
        - Yes: NCU Power OFF
        - No: Remove USB flash drive
          - SIM/NCK = 1
            - PLC = 3
            - NCU Power ON
            - PLC general reset
              - SIM/NCK = 0
              - PLC = 0
              - Set password
                - Load NC archive
                  - Notice: Do not overwrite blocks with user program (e.g., OB1, OB100, etc.)
                  - New Toolbox?: No
  - Possible error:
    - sc ERROR: unknown option -update /data/<cnc-sw>.tgz
    - Cause: Space missing between -update and /data

Figure 12-13 Upgrading the CNC software using WinSCP on PG/PC
12.1.2.5 Upgrading the CNC software using VNC Viewer on PC/PG

Flow diagram

- Upgrade the CNC software using VNC Viewer on PC/PG
  - Create NC / PLC / drive archive on Compact-Flash card, CU and/or USB flash drive
  - Load PLC project (STEP 7) to PC/PG
  - Is USB flash drive available with NCU service system?
    - No: Copy <cnc-sw-tgz> to USB flash drive (root folder)
  - Is the NCU service system installed on USB flash drive?
    - No: NCU Power OFF?
      - No: Insert USB flash drive into NCU (X125)
      - Connect NCU (X127) and PC/PG
        - NCU Power ON
        - Start VNC Viewer on PC/PG
  - NCU Power OFF?
    - No: VNC server input: 192.168.215.1
      - Main menu: 5 / F5: Update NCU software
        - 1 / F1: Update system software from USB memory stick
          - 1 / F1: Update system software by selected file
            - 8 / F8: OK, continue
            - 7 / F7: to confirm
          - Display "Syncing disk... done.?"
            - No: NCU Power OFF
              - Remove USB flash drive
                - SIM/NC = 1
                  - PLC = 3
                    - NCU Power ON
                      - PLC general reset
                        - SIM/NC = 0
                          - PLC = 0
                            - Set password
                              - Load NC archive
                                - New Toolbox?
                                  - No: Open PLC project (STEP 7) - Toolbox bp7x0.xx
                                    - Copy new blocks from Toolbox bp7x0.xx to the PLC project
                                      - Load PLC archive
                                      - Load PLC project
                                        - Load drive archive
                                          - END
                                    - Copy new blocks with PLC program (e.g. OB1, OB100, etc.)
12.2 With the help of the "Create MyConfig" software

Precondition

The "Create MyConfig" software on PG/PC is the precondition to configure a package.

Basic procedure

The descriptions for automatically reinstalling/upgrading using Create MyConfig include the basic steps for configuring and subsequent automatic execution at the control system. The "Create MyConfig" software has integrated online help.

12.2.1 Reinstallation with Create MyConfig

Preconditions

The following preconditions must be met for the CompactFlash card of the NCU:

- The CompactFlash card of the NCU is empty or contains executable NCU software. If any CNC software and possibly irrelevant user data are on the CompactFlash card, then these are lost when the software is newly installed.
- You have a <name>.tgz file (cnc-sw.tgz) with the actual software.
- You want to initiate a new installation of the NCU via a USB FlashDrive.
- If the CompactFlash card is empty or does not contain executable CNC software, you need a USB FlashDrive with installed "NCU Service System".

Operating sequence

In order to configure a package for the reinstallation of the CNC software with "Create MyConfig Expert"

1. Start the "Create MyConfig Expert" software.
   With this software you configure an Installer package that initiates a reinstallation from the USB Flashdrive to the CompactFlash card of the NCU.
2. Create a new project via the menu "Project" > "New".
3. Activate the "NCU" area under the "Package" tab.

4. Activate the "NCU software" window from the "Dialogs" tab.
5. In the context menu, select > right mouse button > "Edit mode for all dialog boxes" > "Automatic".

6. In the "CNC software" window under "Installation", select the "New installation" mode.

7. For the file "<name>.tgz" you have the following options:
   - The file is embedded in the project or linked to the project. For the automatic reinstallation, insert the "<name>.tgz" file in the project under "CNC software (*.tgz)". To do this, enter the name of the tgz file in the "Preselection" area.
   - Copy the file to the USB FlashDrive in the root directory in which the package is stored subsequently. The file is automatically selected while the package is running. Enter the name with the prefix "./" <name>.tgz in the "Preselection" field under "CNC software (*.tgz)".
8. Create a package "<name>.usz" via the menu "File" > "Transfer" > "Linux package (NCU)" and select as target path the root directory of the USB FlashDrive. Create MyConfig Expert saves the project, performs a validation run, creates and saves the package under the specified target path. A "<name>.usz" package is then located in the root directory of the USB FlashDrive. Depending on the configuration in the previous step, the "<name>.tgz" file is also located next to the package.

**Note**

The USB FlashDrive must only be bootable if the CompactFlash card of the NCU does not contain executable CNC system software.

9. Insert the USB FlashDrive into a USB socket (X125 or X135) of the NCU.

10. Switch the control system off and on again.

    Provided that when configuring you configured the "Edit mode of all dialogs" > "Automatic", then the package is automatically executed when the control system boots-up. The dialogs are displayed, but require no operator actions.

    The CNC software has been installed once the package has been completed. A logbook about the activities that have been performed can be saved. The logbook documents all activities performed during the new installation.

11. Switch-off the control system.

12. Remove the USB FlashDrive.

13. Commissioning work can continue after the control system has been switched on.

**Optional additional functions for the installation of the CNC software**

In the same package - after the CNC software has been installed - the following actions can be optionally configured, which can either run completely automatically or conditionally at the machine:

- Loading an SDB Archive
- SINAMICS device configuration
- Renaming DO, SINAMICS components and DO numbers
- Assignment of the drives to NC axes
- Manipulation of display machine data
- Manipulation of individual NC and drive data
- Loading the PLC program or from individual blocks
- Installing software
- Copying, deleting and manipulating files on the CompactFlash card
- Conditional execution of actions, executing, deleting, copying and manipulating
- Messages and interactions to the operator
12.2.2 Upgrade with Create MyConfig

Introduction

Note
For details on upgrading the CNC software versions, read the "siemensd.rtf" (German) or "siemense.rtf" (English) file on the product CD of Create MyConfig.

When the software is upgraded, all user data is kept on the CompactFlash card and in the control areas NC, PLC, and drives. The NC and drive data is automatically transferred into the new CNC software version. Archives neither have to be created nor imported again.

The "NCK commissioning switch" and "PLC mode selector switch" remain during the upgrade in position "0".

In conjunction with an upgrade, using the same package, the automatic generation of a backup can be configured, which is then stored on the USB FlashDrive. It is not necessary to first generate an archive.

Note
After the CNC software has been upgraded, adaptations may be required. Using the Create MyConfig Expert, these adaptations can also be configured and therefore automatically executed.

For information about the necessary adaptations, please refer to the upgrade instructions of the respective CNC software versions.

Operating sequence

In order to configure a package for the upgrade of the CNC software with "Create MyConfig Expert":

1. You have started the "Create MyConfig Expert" software.
   Using this software, you configure a package that initiates an upgrade of the CNC software on the CompactFlash card of the NCU.

2. You have created a new project via the menu "Project" > "New".
3. Activate the "NCU" area under the "Package" tab.

4. Activate the "NCU software" window from the "Dialogs" tab.
5. In the context menu, select > right mouse button > "Edit mode for all dialog boxes" > "Automatic".

6. In the "CNC software" window under "Installation", select the "Upgrade" mode.

7. For the <name>.tgz files you have the following options:
   - The file is embedded in the project or linked to the project. For the automatic reinstallation, insert the "<name>.tgz" file in the project under "CNC software (*.tgz)". To do this, enter the name of the tgz file in the "Preselection" area.
   - Copy the file to the USB FlashDrive in the root directory in which the package is stored subsequently. The file is automatically selected while the package is running. Enter the name with the prefix "./" <name>.tgz in the "Preselection" field under "CNC software (*.tgz)".
8. Create a package "<name>.usz" via the menu "File" > "Transfer" > "Linux package (NCU)
and select as target path the root directory of the USB FlashDrive.
Create MyConfig Expert saves the project, performs a validation run, creates and saves the
package under the specified target path.
A "<name>.usz" package is then located in the root directory of the USB FlashDrive.
Depending on the configuration in the previous step, the "<name>.tgz" file is also located
next to the package.

9. Insert the USB FlashDrive into a USB socket (X125 or X135) of the NCU.

10. Switch the control system off and on again.
Provided that when configuring you configured the "Edit mode of all dialogs" → "Automatic",
then the package is automatically executed when the control system boots-up. The CNC
software has been upgraded and all data is available again after the package has been
completed on the NCU.
A logbook about the activities that have been performed can be saved. The logbook
documentst all activities performed during the upgrade.

11. Switch-off the control system.

12. Remove the USB FlashDrive.

13. The machine is ready for operation again after switch-on.

Optional additional functions when upgrading the CNC software
In the same package - after the CNC software has been installed - the following actions can be
optionally configured, which can either run completely automatically or conditionally at the
machine:

- Manipulation of display machine data
- Manipulation of individual NC and drive data
- Loading the PLC program or from individual blocks
- Installing software
- Copying, deleting and manipulating files on the CompactFlash card
- Conditional execution of actions, executing, deleting, copying and manipulating
- Messages and interactions to the operator
12.2 With the help of the "Create MyConfig" software
## A.1 Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACX</td>
<td>Compressed format for XML</td>
</tr>
<tr>
<td>ALM</td>
<td>Active Line Module</td>
</tr>
<tr>
<td>APC</td>
<td>Advanced Position Control (SINUMERIK option M13)</td>
</tr>
<tr>
<td>AUTO</td>
<td>AUTO mode: Continuous and automatic execution of programs</td>
</tr>
<tr>
<td>BERO</td>
<td>Proximity limit switch</td>
</tr>
<tr>
<td>BI</td>
<td>Binector Input</td>
</tr>
<tr>
<td>BICO</td>
<td>Binector Connector</td>
</tr>
<tr>
<td>BO</td>
<td>Binector Output</td>
</tr>
<tr>
<td>CI</td>
<td>Connector Input</td>
</tr>
<tr>
<td>CNC</td>
<td>Computerized Numerical Control: Computerized numerical control</td>
</tr>
<tr>
<td>CO</td>
<td>Connector Output</td>
</tr>
<tr>
<td>CoL</td>
<td>Certificate of License</td>
</tr>
<tr>
<td>CP</td>
<td>Communication Processor: Communications processor</td>
</tr>
<tr>
<td>CPU</td>
<td>Central Processing Unit: Central processing unit</td>
</tr>
<tr>
<td>CU</td>
<td>Control Unit</td>
</tr>
<tr>
<td>DHCP</td>
<td>Dynamic Host Configuration Protocol: Protocol for automatic assignment of IP addresses from a DHCP server to a client computer.</td>
</tr>
<tr>
<td>DO</td>
<td>Drive Object: Drive object</td>
</tr>
<tr>
<td>DP</td>
<td>Distributed I/O</td>
</tr>
<tr>
<td>DRAM</td>
<td>Dynamic Random Access Memory</td>
</tr>
<tr>
<td>DRF</td>
<td>Differenzial Resolver Funktion: Differential function for rotary resolver</td>
</tr>
<tr>
<td>DRIVE-CLiQ</td>
<td>Drive Component Link with IQ</td>
</tr>
<tr>
<td>DSC</td>
<td>Dynamic Stiffness Control: Dynamic stiffness control</td>
</tr>
<tr>
<td>DWORD</td>
<td>Doubleword</td>
</tr>
<tr>
<td>ESD</td>
<td>Electrostatic Sensitive Device</td>
</tr>
<tr>
<td>EMC</td>
<td>Electro-Magnetic Compatibility</td>
</tr>
<tr>
<td>EN</td>
<td>European standard</td>
</tr>
<tr>
<td>EPos</td>
<td>Basic positioning (SINAMICS S120)</td>
</tr>
<tr>
<td>GECOS</td>
<td>General Electric Comprehensive Operating System: Information about the identity of a user under Linux</td>
</tr>
<tr>
<td>GSD</td>
<td>Device master file</td>
</tr>
<tr>
<td>GUD</td>
<td>Global User Data</td>
</tr>
<tr>
<td>IPO</td>
<td>Interpolator</td>
</tr>
<tr>
<td>JOG</td>
<td>JOG mode: manual mode for setting up the machine</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network</td>
</tr>
<tr>
<td>LED</td>
<td>Light-Emitting Diode: Light-emitting-diode display</td>
</tr>
<tr>
<td>LUD</td>
<td>Local User Data</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>MD</td>
<td>Machine Data</td>
</tr>
<tr>
<td>MDI</td>
<td>MDI mode (Manual Data Automatic): Enter program blocks manually and execute</td>
</tr>
<tr>
<td>MM</td>
<td>Motor Module</td>
</tr>
<tr>
<td>MCP</td>
<td>Machine Control Panel</td>
</tr>
<tr>
<td>NC</td>
<td>Numerical Control: Numerical control</td>
</tr>
<tr>
<td>PIO</td>
<td>Process Image Output</td>
</tr>
<tr>
<td>PII</td>
<td>Process Image Input</td>
</tr>
<tr>
<td>PCU</td>
<td>PC Unit: computer unit</td>
</tr>
<tr>
<td>PELV</td>
<td>Protective Extra Low Voltage</td>
</tr>
<tr>
<td>PG</td>
<td>Programming device</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable Logic Control: (component of the CNC)</td>
</tr>
<tr>
<td>PM</td>
<td>Power Module</td>
</tr>
<tr>
<td>PUD</td>
<td>Program global User Data</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory: Program memory that can be read and written</td>
</tr>
<tr>
<td>REF POINT</td>
<td>Function for approaching the reference point in JOG mode.</td>
</tr>
<tr>
<td>REPOS</td>
<td>Function for repositioning in JOG mode</td>
</tr>
<tr>
<td>SD</td>
<td>Setting Data</td>
</tr>
<tr>
<td>SLM</td>
<td>Smart Line Module</td>
</tr>
<tr>
<td>SMC</td>
<td>Sensor Module Cabinet Mounted</td>
</tr>
<tr>
<td>SME</td>
<td>Sensor Module Externally Mounted</td>
</tr>
<tr>
<td>TEACH IN</td>
<td>Function for creating programs in interactive mode with the machine in MDI and AUTO modes</td>
</tr>
<tr>
<td>TCU</td>
<td>Thin Client Unit</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>XML</td>
<td>Extensible Markup Language</td>
</tr>
</tbody>
</table>
A.2 Information about third-party software used

Copyright 1995 Sun Microsystems, Inc.

Printed in the United States of America.

All Rights Reserved.

This software product (LICENSED PRODUCT), implementing the Object Management Group's "Internet Inter-ORB Protocol", is protected by copyright and is distributed under the following license restricting its use. Portions of LICENSED PRODUCT may be protected by one or more U.S. or foreign patents, or pending applications.

LICENSED PRODUCT is made available for your use provided that you include this license and copyright notice on all media and documentation and the software program in which this product is incorporated in whole or part. You may copy, modify, distribute, or sublicense the LICENSED PRODUCT without charge as part of a product or software program developed by you, so long as you preserve the functionality of interoperating with the Object Management Group's "Internet Inter-ORB Protocol" version one. However, any uses other than the foregoing uses shall require the express written consent of Sun Microsystems, Inc.

The names of Sun Microsystems, Inc. and any of its subsidiaries or affiliates may not be used in advertising or publicity pertaining to distribution of the LICENSED PRODUCT as permitted herein. This license is effective until terminated by Sun for failure to comply with this license. Upon termination, you shall destroy or return all code and documentation for the LICENSED PRODUCT.

LICENSED PRODUCT IS PROVIDED AS IS WITH NO WARRANTIES OF ANY KIND INCLUDING THE WARRANTIES OF DESIGN, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, OR ARISING FROM A COURSE OF DEALING, USAGE OR TRADE PRACTICE.

LICENSED PRODUCT IS PROVIDED WITH NO SUPPORT AND WITHOUT ANY OBLIGATION ON THE PART OF SUN OR ANY OF ITS SUBSIDIARIES OR AFFILIATES TO ASSIST IN ITS USE, CORRECTION, MODIFICATION OR ENHANCEMENT. SUN OR ANY OF ITS SUBSIDIARIES OR AFFILIATES SHALL HAVE NO LIABILITY WITH RESPECT TO THE INFRINGEMENT OF COPYRIGHTS, TRADE SECRETS OR ANY PATENTS BY LICENSED PRODUCT OR ANY PART THEREOF.

IN NO EVENT WILL SUN OR ANY OF ITS SUBSIDIARIES OR AFFILIATES BE LIABLE FOR ANY LOST REVENUE OR PROFITS OR OTHER SPECIAL, INDIRECT AND CONSEQUENTIAL DAMAGES, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Use, duplication, or disclosure by the government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 and FAR 52.227-19.

SunOS, SunSoft, Sun, Solaris, Sun Microsystems and the Sun logo are trademarks or registered trademarks of Sun Microsystems, Inc.

SunSoft, Inc.
2550 Garcia Avenue
Mountain View, California  94043

Copyright (c) 1991 by AT&T.

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which
is or includes a copy or modification of this software and in all copies of the supporting
documentation for such software.
THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED
WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR AT&T MAKES ANY
REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR
PURPOSE.

This product includes software developed by the University of California, Berkeley and its
contributors.
QLocale’s data is based on Common Locale Data Repository v1.6.1.

Note
You can find additional information on the product DVD in the Readme_OSS file about the third-
party software used.
Index

A
Access levels, 39
Adaptations
   Moment of inertia, 255
   Overview, 260
   Position, 258
   Velocity, 258
Assigning device names, 83
Assignment procedure, 224
Automatic servo tuning, 292, 293
   Path interpolation, 307
   Report, 309
   Tuning log, 303, 306
Axis assignment, 226
Axis strategy, 296

B
Backing up tuning results, 236
BICO interconnections, 112
Brake behavior OFF3, 213

C
Catalog motor, 129
Certificate of License (CoL), 44, 48
Channel axes, 225
Circularity test, 292
   Backing up, 340
   Examples of the position setpoint filter, 338
   Optimization example 1, 338
   Optimization example 2, 339
   Optimization example 3, 339
   Perform measurement, 336
   Setting parameters, 336
Coding switches, 34
Commissioning archive
   Creating, 348
   Reading in, 348
CompactFlash card, 43, 48
Compliance - definition, 246
Configuration
   Change, 186
   Sorting, 187
Control mode, 133
Create MyConfig, 372

D
Data backup
   Point in time, 345
Data set
   Add, 156
   Boundary condition, 154
   Drive (DDS), 154
   Encoder (EDS), 154
   Modify, 162
   Motor (MDS), 154
   Remove, 160
DC link identification, 205
   Automatic, 206
   Manual, 207
Details, 55
Diagnostics
   Drive system, 177
   Trace, 163
Drive
   Assign axis, 222
   Faults, 178
   PLC-controlled, 270
   PROFIBUS DP, 270
   Warnings, 178
Drive components, 212
Drive object, 212
   Activate,
   Deactivation,
   Delete,
Drive system
   Activate drives, 202
   Diagnostics, 177
Drive unit
   Configuration, 117
   Topology, 181
Drive wizard, 127

E
Electronic rating plate, 202
F
Factory settings, 146
Filter, 292
   Example, 333
   Type, 333
Firmware update, 148
Friction compensation
   Automatic sequence, 238
   Example, 242
   Manual sequence, 239
   Torque injection pulse, 244
   Tuning quality, 237
   Velocity injection pulse, 238, 239
Function generator
   Connection point, 330
   Parameter, 332
   Positioning monitoring, 330

G
Geometry axes, 225

H
Hardware configuration, 55
Hardware reference, 43
Hardware serial number, 43, 48

I
Infeed
   Configuration, 118
   Initial commissioning, 117
   Overview, 123
   Parallel connection, 125
   Power data, 120, 205
   Saving the configuration, 123
   Summary, 122
   Terminal wiring, 121
Intelligent dynamic response adaptation
   Function, 258
   Option, 257
Intelligent load adaptation
   Function, 255
   Option, 255
Interpolation, 307
Interpolation axes, 293
Isochronous operation, 71

J
Jerk filter
   Benefits, 263
   Commissioning, 264
   Double moving average calculation, 265
   FIR low pass, 264
   Moving average calculation, 265

L
License, 48
License database, 46
License information, 43
License key, 43, 49
License number, 49
Line checksum, 348

M
Machine axes, 225
   MD13160 $MN_SINAMICS_MAX_SLAVE_ADDRESS, 271
Measuring functions, 316
   Cancel, 317
   Start, 317
Monitoring the line voltage, 205

N
NCK commissioning switch, 34
NCU interfaces, 33
Nodding compensation
   deactivate, 249
   Measuring procedure, 247
   Option, 246
   Part program, 252
   Trace, 251

O
Option, 49

P
Parameter
   Speed setpoint before/after filter, 332
Password
change, 41
Rules, 40
Set, 40
PLC
Changing the operating state, 347
Communication setup, 51
Mode selector switch, 34
Position control loop, 292
Measurement sequence, 326
Measuring procedure, 325
Reference frequency response, 327
Setpoint ramp, 327
Setpoint step, 327
Position controller strategy, 299
Process data (PZD), 221
PROFIBUS connection, 218
PROFIBUS telegram type, 133
PROFINET
Configuration, 72
Connection, 74
IO system, 75
PROFINET IO, 70
PROFIsafe, 81

R
Reinstallation of the CNC software, 355
Replacing a motor component, 200
Replacing a Motor Module, 201

S
SIMATIC Manager, 51
SIMATIC S7 project, 52
SINUMERIK 840D sl Toolbox, 32
Software product, 43
Speed adjustment, 213
Speed control loop, 292
Measuring procedure, 320
Speed controller strategy, 297
Spindle optimization
Controller data overview, 314
Procedure, 313
Strategy, 314
System utilization, 267

T
Technology
Milling, 234
Turning, 234
Telegram
Manufacturer-specific, 220
Number of encoders, 223
Standard, 220
Terminal assignment, 110
Inputs/outputs, 110
NCU - X122, 107, 108
NCU - X132, 108, 109
NCU - X142, 109
NX1x.3, 110
Third-party motor, 135
Top Speed
Option, 263
Topology
Delete the component, 195
Obligatory rules, 207
Optional rules, 207
Target/actual comparison, 188
Topology display (graphic), 183
Trace
Cursor, 172
New session, 163
Scale, 171
Servo variables, 167
Session type, 163
Zoom, 167
Tuning
1 axis, 238
2 axes, 238
Tuning functions, 292
Tuning objective
Conservative/robust responsiveness, 300
Maximum responsiveness, 300
Moderate responsiveness, 300
Tuning sequence, 291
Tuning strategy, 296

U
Upgrade
Create MyConfig, 376
Service system, 355
User views, 234
W
Web License Manager, 45